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Using Criterium DecisionPlus 
Congratulations on making a wise decision to purchase Criterium 
DecisionPlus. DecisionPlus is  a decision management tool that can 
help you organize, complete and communicate complex decision-
making tasks. Many decisions are tough and involve many different 
criteria against which various options or alternatives are compared. 
Tracking and rating the importance of that criteria and maintaining 
control of the decision problem are major challenges. DecisionPlus is 
specifically designed to help you make tough decisions easier:  easier 
to formulate, easier to understand, and easier to communicate. 

Assisting You in Making Decisions  

DecisionPlus runs as a Windows application to assist you in making 
and presenting decisions. With DecisionPlus you list your criteria and 
alternatives directly onto the computer screen conveniently with the 
mouse and keyboard. Once you weight each of your decision criteria, 
DecisionPlus does the rest. In rationally choosing between 
alternatives, DecisionPlus synthesizes your inputs and presents the 
results in order of preference. You are still in control to accept the 
results and make the final decision.  
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What Benefits Do You Get from Using DecisionPlus? 

Your experience with DecisionPlus builds power into your decisions 
by providing the following benefits: 

 

• Speedier construction and elucidation of the decision. 

• Deeper insight into factors affecting the decision. 

• Confidence that all factors have been considered within the 
decision framework. 

• Understanding of how sensitive the decision results are to 
judgments employed. 

• Identification of criteria that are key in breaking an impasse 
(assuming no clear preference in alternatives occurs). 

• Identification of the preferred altenative and how likely that 
alternative will remain the preferred one given uncertainty. 

• Identification of information that would be most effective in 
producing an unambigously superior choice if its uncertainty 
were reduced. 

• A greater consensus and commitment from group members to a 
chosen course of action. 

• Real-time presentations to persuade others of your 
recommendations 
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In This Chapter 
  Road Map to the User’s Guide 
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Part I Introduction 

 

Chapter 1 Road Map to the User’s Guide  
Our user’s guide is divided into four parts. Each part is associated with 
a logo that will help you find your way easily throughout the guide. 
Under each part, we briefly describe chapter contents and identify the 
audience for each chapter.  

Chapter 2 Requirements and Installation 
This chapter describes the hardware and software requirements and the 
installation instructions you need to successfully run DecisionPlus. 
Everyone should read this chapter. 

Chapter 3 Model Specifications 
If you've used decision analysis before, you might find the 
specifications within DecisionPlus helpful. Information such as how 
many levels of criteria you can use, how many alternatives you can 
enter, and how many blocks you can have in any one model is found 
in this chapter. 
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Chapter 4 New Features in Version 3.0 
Current users of Criterium DecisionPlus 2.x versions will find a 
comprehensive guide to the new features of version 3.0. 

Part II Overview of Decision-Making with 
DecisionPlus 

 

Chapter 5 Decision Analysis Techniques  
This chapter introduces the Analytical Hierarchy Process (AHP) and 
the Multiattribute Utility Theory using the Simple Multiattribute 
Rating Technique (SMART). These decision-making techniques are 
incorporated into DecisionPlus. If you are familiar with these 
techniques, you may want to skip this chapter and go to Chapter 6. 

Chapter 6 The Decision-Making Process 
In this chapter we discuss how most people make decisions when 
working through complex decision problems. This Information reflects 
recent research on the decision process and is the basis for developing 
DecisionPlus. 

Chapter 7 Using Criterium DecisionPlus 
This chapter describes the functions discussed in Chapter 6 that are 
used in DecisionPlus. If you are unfamiliar with making structured 
decisions, or if you have used decision analysis before and want 
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background on how DecisionPlus synthesizes your inputs into 
preferences, this chapter provides help. 

Part III Designing Your Own Decision Model 

 

Chapter 8 Brainstorm the Problem 
Here we show you how to get your thoughts about your decision down 
on canvas. You’ll learn how to enter and save your own information 
and easily move your information around on the Brainstorm canvas. 
Your information does not have to be organized to use this program, 
but you will begin forming a light structure in this window. 

Chapter 9 Build the Hierarchy 
In this chapter we provide details for using all the techniques, features, 
and controls to build a decision hierarchy. You can generate a 
hierarchy automatically from your entries in Brainstorm or you can 
create it directly in the Hierarchy program. It’s best to have your 
information at least lightly structured and have experience in using the 
Analytical Hierarchy Process (AHP) before creating the hierarchy. 
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Chapter 10 Weight the Criteria 
You’ll learn how to enter weights for each criterion you entered in 
your hierarchy. We discuss the different weighting methods and scales 
you can use and show you how you can create your own weighting 
scale.  

Chapter 11 Select Uncertainty 
We present more advanced techniques in assessing risk in this chapter. 
Once your criteria are weighted, the uncertainty in the risks may be 
characterized as probability distributions that are included in the 
results. We also present the Simple Multiattribute Rating Technique 
(SMART) in this chapter. 

Chapter 12 Review the Results 
Once you’ve weighted your criteria, you’ll want to view the results of 
your work. This chapter covers several ways in which to look at 
results. 

Chapter 13 Analyze the Results 
Is your decision a reasonable one? This chapter helps you find the 
answer to this question by providing methods by which you can 
analyze your results. The advanced function of checking the 
contribution by uncertainty is also described in this chapter. 

Chapter 14 Document the Results 
To print your results, follow the steps in this chapter. We cover 
various ways you can print your results and create report formats. 
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Part IV Tutorial for Creating a Decision Model 

 

Chapter 15 Selecting a Vacation Book 
In this chapter, we provide a tutorial using a simple model to make a 
decision using many of the features available in DecisionPlus. We 
assume you have no prior knowledge with decision making tools, and 
guide you through this process, providing you the information to enter. 

Glossary, References, and Index 

 

The glossary contains common Decision Analysis definitions, along 
with other terms used throughout this book.  Also included are 
References and the Index. 
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In This Chapter 
  System Requirements 
  Installing to Windows 95, Windows98 and NT 4.0 
  Trouble with Installation 
  Uninstalling Criterium DecisionPlus 
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Getting started: What is in the box? 

You should find 

• A User’s Guide (what you are reading) The Criterium DecisionPlus CD is in 
a jacket on the back inside cover of the User’s Guide. 

• A Registration card (with your Serial Number on it)  You can also register 
online, once the program is installed, by connecting to the internet, run CDP, 
select the Web Register item from the Help menu. Fill in and submit the 
registration form.  You must register to obtain long term technical support. 

System Requirements 

The system requirements for this 32-bit Version of Criterium 
DecisionPlus are as follows: 

• MS-Windows 95, Windows98 or NT 4.0 (SP3 or higher), 
Windows2000 , WindowsXP(See website for issues). 

• Personal computer using an 80486 or higher CPU 

• 16 MB of RAM (32 recommended). 

• 14 MB of available disk space on the hard drive. 

• One CD-ROM drive (31/2" diskettes available by request). 

• VGA, Super VGA, or compatible video graphics adapter and 
monitor supported by the Windows operating system (color 
SuperVGA or higher resolution recommended). 

• Mouse. 
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Installing to Windows 95™, Windows 98™ or Windows 
NT™ 4.0 

To install DecisionPlus  

1. Turn on your computer.  Close any unnecessary applications 
(especially Microsoft Office applications). 

2. Locate your CDP 3.0 CD-ROM on the inside back cover of the 
User’s Guide. 

3. Put the CDP 3.0 into your CD-ROM, give your CD drive a 
moment to power up.  The CDP 3.0 install will start automatically.  
(If you have turned off auto start for CDs, use Explorer to locate 
and execute the setup.exe file on the CD.) 

4. Follow the instructions on your screen until DecisionPlus is 
installed. 

5. You must agree to the End User’s License Agreement when asked 
by the software if you wish to complete the setup. 

6. Finally, if the Setup program asks to reboot your machine, please 
do so.  If the setup program indicated you needed to reboot your 
system, you will not be able to run CDP until you do. 

 

To Start a Session with DecisionPlus 
• Double-click the DecisionPlus Icon (the Green Tree), located in 

the Criterium DecisionPlus folder, which is open after the 
installation. 

or, if you have closed that folder,  

• Choose Programs from the Start menu, then choose the 
DecisionPlus submenu (assuming you did not change the default 
during setup) and then click the cdplus30.exe menu item.  CDP 
will start. 
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Trouble with Installation  

If you have any trouble with installing DecisionPlus, then 

1. Access our technical support web pages at 
http://www.infoharvest.com. 

2. Call technical support at (206) 686-2729.  There is, of course, no 
charge for setup related problems.  You must provide your Serial 
Number (which you can find on the CD cover in the back of the 
manual and on the registration card) to the technical support 
person.  If you are asked to leave a voice message, give your 
name, Serial Number (on the CD cover in the back of the manual), 
telephone number and an account of your problem. 

Uninstalling Criterium DecisionPlus  

 

To uninstall CDP 3.0  

1. Open control panel (from Start Menu, settings) and launch the 
Add/Remove program. 

2. Select the Criterium DecisionPlus entry and click Add/Remove.  
In the ensuing dialog, choose to remove all shared components.  
All the application files and directories should be removed, unless 
the directories contain user created files, in which case those 
directories will be left. 
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  DecisionPlus Model Specifications 
  Windows Conventions Used in DecisionPlus 
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DecisionPlus Model Specifications 

Entering information into DecisionPlus is easy, but somewhat different 
from entering information into other decision analysis tools. Below, 
we describe the specifications and conventions we use in creating our 
models. 

If you have used decision analysis software before, you may want to 
know what model capabilities have been designed into DecisionPlus. 
We model decisions as hierarchies of criteria, and the specifications 
are as follows: 

• 7 levels (including the goal level and the alternatives). 

• Maximum of 500 blocks in the model (a block is a goal statement, 
a criterion, or an alternative). 

• Maximum of 200 blocks on any level (not including the 
alternative level). 

• Maximum of 50 subcriteria per criterion. 

• Maximum of 200 alternatives (alternatives count against the 500 
total blocks). 
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Windows Conventions Used in DecisionPlus 

DecisionPlus runs in Microsoft Windows and we use standard 
Windows conventions. Because those conventions are already 
described in the Windows User’s Guide, we refer you there for any 
needed brush-up or any new learning. We know that few people enjoy 
reading an entire manual, and fewer enjoy reading two, so we have 
provided a list of minimum conventions below that you should know. 
These terms are located in the Windows User’s Guide glossary and 
index. 

 

Active/Inactive Window 

Arranging Multiple 
Windows 

Buttons 

Click 

Close Command 

Dialog Box 

Double-click 

Drag and Drop 

Exit Command 

File 

Highlight 

Maximize 

Menu 

Menu Bar 

Minimize 

Mouse Action 

Open Command 

Point and Click 

Pull Down Menus 

Print Command/Print 
Preview 

Print Setup 

Save 

Save As 

Scroll Bars 

Select 

Sizing Windows 

Text Entering/Editing 

Window 
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1 General Features 

 

1.1 Operating Systems 

CDP 3.0 is a 32-bit software application.  It runs on all the Windows 
PC 32  it Operating Systems - Win95, Win98, NT 4.0, NT 5.0 (Beta).   

CDP 3.0 will not run on Windows 3.0. 3.1 or Workgroup for 
Windows. 

1.2 CDP 3.0 Model Specifications 

Max Number of Alternatives :  200 (50 in CDP Version 2.0) 

Max Number Goal + Criteria :  300 (160) 

Max Total :  500 (160) 

Max Number per Level :  200 (100) 

Max Subcriteria per Criteria :   50 (20) 

Max Super Criteria per Criteria :   10 (5) 

1.3 Model Options 

With CDP 3.0, you now have the ability to set default options (under 
the View menu in Hierarchy) that govern the behavior of many of the 
models, dialogs and the application itself.  This is done through the 
Model Options. 

The Model Options are for customizing CDP settings to your preferred 
defaults.  Model Options are broken down into two categories. 
Environment options and New Model options.  Once options are set to 
your liking, they are generally not changed too often.  If the default 
settings, when applied to particular model are not suitable, you can 
change the settings for just that model.  

Environmental options are generally loaded with CDP, and are not 
usually saved with the model. (An exception would be the Best (High) 
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/ Worst (Low) labels used for scale extrema throughout CDP. But 
these labels too may be changed from the Assign Scales screen to 
affect just the current model.) 

Examples of Environmental Options are whether Toolbars are visible 
or not, and whether lines connecting the Lowest Criteria in the 
Hierarchy to Alternatives are visible or not. 

When an environmental option is set it is immediately (where 
appropriate) applied to the loaded model.  However if that model is 
subsequently saved, and reopened in a session with a different 
configuration of Environmental Settings, these new settings will 
determine how the model appears.  

Note:  If you are in the Hierarchy window and wish to change the 
current block spacing, you can do so via the Options dialog.  Be aware 
that when you click either of the Apply or OK buttons, all option 
settings in the Hierarchy View area will be applied to your current 
hierarchy model (not just the Spacing option you changed).  

New Model options on the other hand, determine default values for 
options that are saved as changed for every model.  Some examples 
would be the Page set up settings such as Header/Footer selections  

A big addition to the Options is the ability to set fonts individually for 
Brainstorm, Hierarchy and Hierarchy in Situ Notes.  The spacing of 
blocks in the Hierarchy may also be adjusted, allowing large models to 
be visually compressed.  Some experimentation is required to find 
settings that work well on each computer system.   

For more information on Options refer to individual chapters. 
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1.4 User Interface Look and Feel 

Toolbars and Status Bars 

Toolbars and a status bar have been added to the interface.  The 
toolbar provides one click access to frequently used functionality, 
while the status bar provides key information such as whether the 
model is fully rated and fully connected.  The Toolbar can be turned 
on and off through the Environment Options (see the section on 
Options, below). 

Spell Checking 

A spell checker has been added to the Hierarchy Notes Dialog.  It 
allows you the spell check names and notes, and to build your own 
custom dictionary. 

1.5 Updated Help Files 

The Help files are being updated to take advantage of Windows 95 
help system, including  Microsoft’s natural language query 
technology. 

 

1.6 Exporting Graphs to Other Windows Programs 

 

Hierarchy, Brainstorm, Contributions By Criteria, Scatter Plot - Export 
to Windows MetaFile 

Use the Copy Graph to MetaFile from the Edit menu to copy an image 
of the hierarchy (regardless of size) to a file.  This MetaFile will 
import well into Microsoft Word and other applications, and can be 
resized in situ.  
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1.7 Uninstalling CDP 3.0  
 

You uninstall CDP 3.0 by going to control panel and choosing the 
Add/Remove program.  Select Criterium DecisionPlus and click 
Add/Remove.  In the ensuing dialog, choose to remove all shared 
components.  The Application may or may not be removed depending 
on whether it contains user created files. 

2.  Brainstorm Window 

2.1 Increased Size  

Brainstorm can handle models of increased size (see Model 
Specifications and limitations above). 

2.2 Options 

A number of Options directly affect the appearance of the Brainstorm 
Screen.  You can now set as environmental default values options such 
as Alternatives Visible, Confirm Drops and Font Size. 

3.  Hierarchy Window 

3.1 Right Clicks 

The Right Click event provides access to a broad range of 
functionality for the Hierarchy.   By clicking your Right mouse button 
when over a block, you have direct access to all the menu items that 
are relevant to that Block type. 

3.2 Connect All Alternatives, Show Missing Connections, Hide 
Connections to Alternatives 

A number of new capabilities have been added to the Hierarchy View 
menu.  See Hierarchy News section in chapter 9.   
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These three new items allow you to Fully Connect all Alternatives to 
all Criteria in the Lowest Level; to show, in lurid green, missing 
connections; and finally, to hide all connecting lines between the 
Lowest Criteria and the Alternatives.  The latter, for large models, will 
greatly increase the speed at which the Hierarchy redraws itself. 

3.3 Navigator  

The Navigator no longer floats above the Hierarchy screen, but now 
arranges itself (docks) within the CDP application container.  It will 
stay visible even if the Hierarchy window is minimized, so as to be a 
thumbnail guide for the other windows.  For instance, if you open the 
Ratings Window in Hierarchy Weights mode, then choose different 
criteria to weight, the Navigator will show where in the model the 
current criterion lies.  

The Navigator also shows a red rectangle corresponding to the present 
visible area of the Hierarchy.  This helps orient you when traversing 
large models. 

3.4 Alternatives Ratings Window  

A new dialog has been added that shows all the Ratings of an 
Alternative against the various Lowest Criteria.  You can now enter 
data through this Window.  To access the Alternatives Ratings 
window, simply double click any Alternative in the Hierarchy 
Window. 

3.5 In-situ Notes  

Goals, Criteria and Alternatives with notes have a small red triangle in 
the upper right hand corner of the Block that represents them on the 
Hierarchy canvas.  If you let you mouse hover over the triangle, you 
will be able to read the first 500 characters of the note.  This allows 
you to browse notes very efficiently.  To see the full note, simply right 
click the block and choose Edit Names/Notes. 
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3.6 Toolbars 

Toolbars can be hidden or made visible by checking the Toolbar item 

in the View menu of the Hierarchy Window.  You can have them 
appear with a text caption or not by checking the Show Toolbar Detail 
item in the same View menu. 

3.7 Options 

A number of Options directly affect the appearance of the Hierarchy 
Screen.  You can now set as Environmental Default values such 
options as Suppress Lines to Alternatives, Block Spacing and Font 
type and size. 

 

4.  Rating the Hierarchy Model 

Direct Tradeoffs – a major new approach to defining the weights 
of your criteria hierarchy 

4.1 Tradeoffs 

In previous versions of CDP, your choice of weights and scales 
uniquely determined a set of tradeoffs, and CDP represented these 
tradeoffs to you.  The philosophy was that Tradeoff values gave values 
you could compare against industry standards, historical norms, etc. 
and validate (or otherwise) your preference weights.   

In CDP 3.0 you can directly set the values for tradeoffs, and based on 
these values and the scales you have defined, CDP calculates the 
equivalent weights.  It does this whether the model is a single layer 
model or a more complex multi-layer model.  See chapter 10 for a 
complete discussion of weights and tradeoffs. 
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You select your technique for rating the criteria by clicking Weights or 
Tradeoffs menu item under Hierarchy Technique under the Model 
menu in the Hierarchy window.  You select your technique for rating 
the alternatives SMART/AHP by clicking the SMART or AHP option 
under the model menu. 

Now when you Double Click the Goal or a non-lowest level criterion, 
the Ratings screen opens up with the active tradeoffs listed.  You can 
either directly rate all tradeoffs, or choose a minimal set of tradeoff 
pairs.  A minimal set is the smallest set of tradeoffs whose values are 
sufficient to determine all other tradeoff’s values.  CDP helps you 
effortlessly select Minimal Sets and provides you with a measure of 
how inconsistent a tradeoff set is, the Tradeoffs Inconsistency Index. 

4.2 Conversion From Weights to Tradeoffs 

Models whose Hierarchy Method was set to Weights (e.g., all 2.0 
Models), and which were completely rated, will have the weight 
values converted to equivalent tradeoffs if the user changes the 
Hierarchy (rating) Method to Tradeoffs.  A suitable reference Lowest 
Criterion will be chosen by CDP and all tradeoffs set with respect to 
that criterion’s scale unit. 

4.3 Conversion of Tradeoffs to Weights 

Conversely, setting the Hierarchy Method to Weights will convert a 
Tradeoff model’s tradeoffs back to weights.  However, this conversion 
will normalize the weights for each criterion to the scale width.  CDP 
will attempt to normalize the weights in each rating set so as to 
preserve the value of the highest weight.  So going from Weights to 
Tradeoffs, and back again, will generally preserve familiar (highest) 
weights.  

4.4 Tradeoffs Analysis Window  

The Tradeoff of Lowest Criteria Analysis window (which has existed 
since Version 1.0), allows you to recalculate Tradeoffs against 
different Reference Criterion for the highest scoring alternative.  In a 
consistent model with linear value functions for all lowest criteria, 
tradeoff values shown should be consistent no matter which Reference 
Criterion is chosen.  
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Note: the Tradeoff of Lowest Criteria Analysis only updates itself 
when clicked.  So if you change the tradeoffs in the Ratings screen 
with the Real-time Update option on, the decision score screen and 
Contribution by Criteria window will update with every change, but 
not the Tradeoff of Lowest Criteria Analysis screen. 

4.5 Alternatives Ratings Window 

A new dialog has been added that shows all the Ratings of an 
Alternative against the various Lowest Criteria.  You can now enter 
data through this Window.  To access the Alternatives Ratings 
window, simply double click any Alternative in the Hierarchy 
Window. 

4.6 Equalize All Weights (Tradeoffs) 

You can, in a single menu selection, unrate or equalize the Hierarchy 
weightings (tradeoffs) depending on whether you are using the 
Weights (Direct Tradeoffs) Hierarchy Rating Technique. 

4.7 Decimal Places to Display in Ratings window (Weights 
Hierarchy Technique Only) 

When entering numbers in the Numeric View in the Ratings Window, 
the number of decimal places displayed can be controlled from the 
Decimal Places item in the View menu.  Numbers can be entered with 
up to 6 decimal places, this option setting only affects how they are 
displayed.  This option can also be set as an Environmental Option. 

5.  Decision Scores (Results) Window  

5.1 Hide Options button 

Clicking this button will hide the various controls that set options for 
the Decision Scores window.  This will significantly increase the 
available space for graphics, particularly useful when you have large 
numbers of Alternatives. 
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6.  Analysis windows 

6.1 Alternatives Scatter Plot Analysis Window 

A new Analysis screen Called Alternatives Scatter Plot has been added 
and is accessible via the Analysis menu on the Hierarchy Form.  It 
shows 2-D scatter plots and bubble graphs of the alternatives data.  It 
also offers a contour map of decision lines.  These graphs help you see 
correlations between criteria across alternatives, and between the 
ratings of alternatives and accumulated values such as the decision 
scores. 

For a complete description, see the section on Alternatives Scatter Plot 
Analysis window in chapter 13. 

6.2 Contributions by Criteria Analysis Window 

The contributions by criteria analysis window now utilizes a new 
graphics engine.  You now have a choice of 4 graph types: the original 
stacked bar chart, pie charts, radar charts and trend charts.  Each chart 
type reveals different aspects of what is driving the decision scores of 
the alternatives.  Use both the View and Options settings to tune the 
graphs to your needs. 

7.  Reports Printing 

7.1 Printing for new and enhanced windows 

In CDP 3.0 you can print Alternatives Ratings, the new Alternatives 
Scatter Plot, Tradeoffs Ratings and the enhanced Contributions screen.  
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7.2 Headers and Footers 

Headers and footers added to a report can be saved with the individual 
model. You can now add auto dates and Section Headings to headers 
and footers.  You can use the New Model options settings to apply 
your specified Headers and Footers to each new model. 

7.3 Cancel Button 

A cancel button appears after clicking Print for reports, and can be 
used to stop long print sessions. 
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The Making of A Powerful Tool 
Incorporating decision analysis techniques, the decision-making 
process, and a specially designed graphical user interface makes 
DecisionPlus a powerful decision analysis tool. The next three 
chapters describe the development design and how you can put this 
power to work for you. 
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Decision Analysis Background 

We are all faced with decisions that affect our personal life, or with 
professional decisions that affect our job performance and financial 
well being. These decisions can be trivial or very complex depending 
on the problem or situation facing us at the time. 

When faced with a decision, most of us rely on our experience or our 
intuition. We often seek advice from others in making our decision. 
Even the most mundane decision can be challenging if the outcome is 
very important in our lives. 

Individual Decisions 
Decisions are not often made in isolation even when they are made by 
individuals. For example, once a decision is made, one spouse must 
convince the other that buying the car was a good decision. Likewise, 
a manager must convince a boss or peers that their decision was a 
good one and explain the reasoning behind it.  

Group Decisions 
Many decisions involve a group of decision-makers that must reach a 
consensus on what should be considered in the decision and in the 
final results. So, the decision-making process is further complicated 
because working through the decision is a challenge, and because 
communicating it to others is equally challenging. 

Research Findings 
For a number of years, the academic community has researched 
theories and techniques that assist us in making good decisions. From 
this work, a number of approaches were developed that are 
implemented with the power we now have available in our personal 
computers. 

DecisionPlus implements two primary decision-making methodologies 
currently being used by people, by companies, and by the government. 
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The two methodologies are the Analytical Hierarchy Process (AHP) 
and Multiattribute Utility Theory as implemented in the Simple 
Multiattribute Rating Technique (SMART). While there are deep 
similarities and differences between these two methodologies, the key 
difference between the two at the software level lies in the different 
rating techniques they use. In DecisionPlus, the choice of 
methodology is referred to as a choice between rating techniques. See 
our Reference section for a list of literature that discusses these 
techniques. 

Analytical Hierarchy Process (AHP) 

Making a decision involves considering a number of options or 
alternatives that can best satisfy an objective or a goal. One way to 
achieve this is to select from these alternatives when they are 
compared against one another with respect to a set of factors or 
criteria. The alternative that rates the highest becomes the preferred 
alternative when this comparison is made.  

The Analytical Hierarchy Process (AHP), developed by Dr. Thomas L. 
Saaty at the Wharton School of Business in the 1970s, is a method of 
organizing information and judgments in selecting a preferred 
alternative. In making any decision, you must prioritize and group 
your decision criteria. In AHP, the most important criteria are grouped 
at the highest level with subcriteria grouped below which further 
define each parent criterion. Structuring the important elements to 
your decision is essential in the decision-making process. 

Graphically, the decision problem can be constructed as a layered 
diagram starting with the goal, then showing the first level of criteria 
to be considered, followed by layers of subcriteria, and finally the 
alternatives. Such a diagram represents a hierarchy of elements 
(criteria and alternatives) that are to be considered in selecting the 
preferred solution. 
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A Decision Model Using AHP 
The following diagram represents the decision to buy a car, applying 
AHP. You can see that the criteria to be considered in making this 
decision are cost, performance, and style. However, there are 
important subcriteria that should not be overlooked in this decision. 
The subcriteria, acceleration and braking, further define the factors to 
be considered under performance, as do the subcriteria, initial and 
maintenance, under cost. The alternatives that are available in making 
this decision are shown at the lowest level. 

Buy a Car

StylePerformance Costs

AccelerationBraking InitialMaintenance

Ford Chevy BMW Mazda

Goal

Criteria

Subcriteria

Alternatives

 
You should note that the subcriteria reflect a more detailed knowledge 
of the decision problem. In the diagram above, the performance 
criterion reflects our desire to consider this factor in our decision, 
whereas acceleration and braking further define exactly how we want 
to consider performance. Generally, the greater the subcriteria 
structure, the more knowledge or understanding of the problem we 
show. Assigning weights to the various criteria and subcriteria 
completes the decision model. At this point, mathematical calculation 
can be performed to determine the preference of the alternatives.  

AHP has many advantages in assisting the decision-making process. 
Because it is graphical, it is easily understood by all involved in the 
decision. It forces discipline in structuring the problem and provides a 
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process that allows a complex decision to be broken into manageable 
parts. It allows integration of various criteria such as cost, technical 
performance, and style in the decision process and helps identify the 
most important element of the decision. When the decision results are 
printed, you have a record of how and why the decision was made. 
DecisionPlus allows you to use AHP to assist in selecting the preferred 
alternative. The next two chapters provide more detail in using our 
software in support of the AHP methodology. For more details about 
AHP, refer to Thomas L. Saaty’s book, Multicriteria Decision-making, 
The Analytical Hierarchy Process. (See References). 

Simple Multiattribute Rating Technique (SMART) 

In decision-making there are methods other than AHP you can use to 
assist in making a decision. The Simple Multiattribute Rating 
Technique (SMART) is one such technique. It originates from the 
work done in Multiattribute Utility Theory (MAUT) by Ward Edwards 
in 1977. 

When using SMART in decision-making, the decision problem is 
broken down into attributes, and single-attribute evaluations are 
constructed by means of value measurements. Somewhat like AHP, a 
value tree structure is created to assist in defining the problem. Values 
are determined for each attribute. Finally, aggregation of the model 
provides results facilitating comparison of the alternatives. 

SMART provides a straightforward way of employing MAUT 
techniques. You can select elements that are simple and easy to apply, 
use the direct rating procedure for assessing single attribute values, 
and use additive aggregation in calculating the preferred alternative. 
You can use nonlinear functions in assigning values to the attributes.  
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Where to Find these Capabilities in DecisionPlus 

DecisionPlus provides both capabilities to enhance your decision-
making. For more details on using SMART, see section Choosing the 
Model Technique: SMART or AHP? in Chapter 10, Rate the 
Hierarchy. For more information about SMART, refer to Detlof von 
Winterfeldt and Ward Edwards’s book, Decision Analysis and 
Behavioral Research (see References). 

 

 

 

 

 
 





  

Criterium DecisionPlus 47 

Chapter 6   
 
 
 

The Decision-Making Process 



  

48 Criterium DecisionPlus 

In This Chapter 
  Our Basic Approach to Making Decisions 
  Define the Problem 
  Select the Decision Group 
  Identify Issues 
  Develop the Decision Structure 
  Judge the Importance of the Criteria 
  Evaluate Alternatives 
  Check Reasonableness 
  Finalize the Decision 
  Documentation 
  Where to Find these Steps in DecisionPlus 



Chapter 6  The Decision Making Process 

Criterium DecisionPlus 49 

Our Basic Approach to Making Decisions 

When faced with a complex decision, we are often somewhat uneasy 
about working through the problem logically and making the best 
decision based on the available information and understanding of the 
issues. This section presents a process for working through the 
problem and shows how DecisionPlus uses this process to make this 
task easier. 

Our general approach to making decisions can be described as a 
process of logical activities. Kenneth H. Mitchell and Edward A. 
Wasil identified these activities in their book, “The Analytical 
Hierarchy Process, Applications and Studies,” published by Springer-
Verlag in 1989. The activities are described below. 

Define the Problem 

A clear statement of your decision problem must be formulated. The 
statement must imply choosing the best alternative to meet the 
objective (such as allocating resources, determining the best course of 
action). Not only must you identify the goal or objective, but you must 
also define the factors that are important or that can affect the decision. 

Select the Decision Group 

If you are making the decision alone, then selecting a group is 
unnecessary. However, even in this situation, you should be aware of 
the person or group that will be or wants to be invited to review the 
decision. An understanding of the reviewer’s knowledge and 
experience helps to communicate the decision results successfully. 
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In most organizations the decision-makers include management, 
technical staff, and consultants with expertise in the problem area. A 
key element in successful decision-making is selecting a group that 
collectively has the necessary expertise to apply to the decision. Your 
group should include all clients and stakeholders affected by the 
outcome. A consensus in the decision group should be achieved in the 
decision process in order for the final decision to have a better chance 
of being accepted. 

Identify Issues 

Once you assemble your decision group, your first task is to identify 
all the factors to be considered in the decision. Brainstorming at this 
stage often helps. This important task solidifies the group with a 
specific decision-making focus. 

Develop the Decision Structure 

In cases where you are using the AHP approach, creating a hierarchy 
of the problem is an essential step in the process. Building the 
hierarchy assists in organizing the problem and forces discipline in the 
decision-making process. Completing this step results in a clear 
understanding of the decision problem.  

Steps in the logical generation of the hierarchy are: 

1. Identify the goal. 

2. Identify factors or criteria important in satisfying the goal. 

3. Where appropriate, identify subcriteria under each criterion. 

4. As the hierarchy expands down in subcriteria, the level of detail or 
understanding should increase. The lowest level is just above the 
alternatives level. This lowest level of criteria/subcriteria should 
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represent an attribute of the alternative that can be objectively 
evaluated. 

Judge the Importance of the Criteria 

After you generate the hierarchy, you can assign weights to the 
criteria. There are a number of ways you can do this. If quantitative 
data on the criteria are available, you can assign direct numeric values 
against an established range for each level in the hierarchy. Without 
data, you might have to compare criteria at a given level by what is 
known as pairwise comparison. Each criterion is subjectively 
compared with each other on the same level. At this time, you can 
determine that certain criteria have little importance in the decision 
and can be dropped from further consideration. 

Evaluate Alternatives 

Each alternative is now evaluated against the lowest criteria. You can 
decide at this time to drop or add alternatives. 

Check Reasonableness 

Once you determine the initial results, your decision group should 
review the outcome and analyze the results. This can be as simple as 
stepping back from the problem and thinking about it, to performing 
what is known as sensitivity analysis. The concern at this point is how 
robust are the decision results? What happens if you make small 
changes in the weights? If needed, your group can return to any point 
in the process, make modifications, and recalculate the results. By 
proceeding in this manner, your group can be confident that their 
decision is sound and stands up to audits by interested parties. 
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Finalize the Decision 

Once you check the reasonableness for the results carefully, the 
decision-making group convenes to resolve any outstanding issues and 
to finalize their decision. 

Documentation 

Documenting the results is a very important step in the process. The 
results should be available for review by all clients and stakeholders. 
In addition, the decision is documented in case it becomes necessary to 
revisit the decision due to unexpected changes. 

Where to Find these Steps in DecisionPlus 

The next chapter describes how we incorporated these steps into 
DecisionPlus and how you will use the program. 
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The Decision Process 

DecisionPlus supports the basic approach described in Chapter 6. The 
functional capability included in DecisionPlus makes your decision-
making much easier. It does the hard work and lets you do the part 
people do best—apply brain power to the problem. 

Below is our process diagram showing the process that DecisionPlus 
supports. It is essentially the general process to decision-making 
discussed in Chapter 6, minus purely people-intensive activities (such 
as selecting the decision group, or reflecting on the decision). 

Brainstorm
 the Problem

Select Uncertainty

Analyze the Results

Review the Results

Rate the Hierarchy

Build the 
Hierarchy

Document 
the Results

Process Diagram
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On-line Help with the Decision Process 

DecisionPlus offers unique, on-line Help with the decision process. 
From any major window, the decision Process Diagram can be 
accessed by holding down the Shift key and pressing the F1 function 
key (Shft+F1). The decision activity supported by the window you are 
in is highlighted within the process diagram; a brief description of the 
purpose of the activity is presented, as well as notes on what to do 
next, and on what you have just done.  Each section is hypertext 
enabled, to bring you directly to the next or previous activities, or to 
detailed information in the regular Help files. 

We hope this parallel Help system for the decision process will help 
direct users who are new to such a structured decision methodology 
through the entire process, and explain to those who have experience 
with decision methodologies how DecisionPlus structures the decision 
process. 

Brainstorm the Problem 

The first three steps in the decision process are to define the problem, 
select the decision group, and identify the issues. DecisionPlus’s 
brainstorming capability (shown as the first circle in the Process 
Diagram) assists you in defining the problem and identifying the 
issues. This allows you to concentrate on the task at hand and to 
maintain status on completed work. It also enhances your thinking 
process by freely facilitating reflection and association of thoughts. 
During the Brainstorm session, you start with a clean canvas and 
conclude with the goal, important criteria, and alternatives identified. 
After working with Brainstorm, you will probably discover that you 
can apply this capability in any situation where a topic is being 
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discussed or “brainstormed” by a group. You don't have to use 
Brainstorm only when working on a decision problem. 

Build the Hierarchy 

The next step, of course, is to build the structure or hierarchy. If you 
use Brainstorm to initiate your decision-making process, you can have 
DecisionPlus automatically build the hierarchy for you. If you already 
have the problem well defined, you may choose to build the structure 
directly in the Hierarchy session. In either case, DecisionPlus’s mouse-
driven interface makes it easy for you to work the problem. You can 
add, delete, or move items easily in the hierarchy. 

Rate the Hierarchy 

Judging the importance of your criteria and scoring your alternatives is 
next.  

We term judging the importance of your criteria as weighting the 
criteria. To determine the weights, you are actually still in 
DecisionPlus’s Hierarchy session even though the process of 
weighting is a separate task. Now you must decide what weighting 
method you will use. This will depend on the problem, the information 
available, and the preferences of the decision-maker. In any case, we 
allow you to select either the direct comparison or pairwise 
comparison method.  

DecisionPlus allows you to enter and view each weight in three ways. 
They are the numeric view, the verbal view, and graphic view.  Each 
view has a corresponding scale.  You can create new verbal and 
numeric scales. You can make full pairwise comparisons by rating 
criteria one against another within its rating set or by using an 
abbreviated pairwise comparison that rates only subsets of all such 
pairs. 
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You then rate the alternatives against those criteria, again by assigning 
values with respect to numeric, verbal or graphic scales.  If you use the 
SMART methodology, you can define a function to determine the 
effective value of such ratings. The next chapter provides all the 
details needed to use any of the above capabilities. 

Select Uncertainty 

This step may be considered a refinement of the basic decision 
process, and you may wish to return to it later when you are more 
familiar with how DecisionPlus structures decisions.   

In many decisions, there are unknowns in the values available to 
decision-makers. This becomes more obvious at the lower levels of the 
hierarchy where there is a greater understanding of the problem. In the 
real world part of the problem, this uncertainty manifests itself as risks 
in the decision-making process.  

To determine the risk, you must ask the question, “How does this 
uncertainty affect the robustness of my decision?” You can answer this 
by analyzing the uncertainty in your information and including it in 
the decision-making process.  DecisionPlus provides a capability to 
characterize this uncertainty in your data as “probability distributions.” 
The results of the process are then expressed as distributions of the 
preferences amongst alternatives instead of as discrete values of 
preference. 

We offer the following diagram to clarify how we apply sensitivity 
analysis (see the next section) and uncertainty in DecisionPlus. As you 
can see from the diagram, sensitivity analysis considers the sensitivity 
of the results to the weightings of all subcriteria with respect to their 
parent criteria. Uncertainty, on the other hand, is applied only to the 
lowest criteria, the criteria with respect to which the alternatives are 
directly rated. This is because when you have many levels of detail, 
the criteria decompose and those at the lowest level reflect a more 
quantitative understanding of the problem. Criteria at higher levels are 
more abstract and subjective.  
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Refer to Part III for details on how to include uncertainty in your 
decision.  

Review the Results 

The next step is to review the results. DecisionPlus calculates in real 
time. That is to say, it continually calculates the results as you enter 
the weights so that if you change a value you can immediately see the 
results. You can view the results as discrete values, “decision scores”, 
representing the preferences of the alternatives, or you can request a 
“contributions screen.” This screen shows the contribution to each 
alternative preference based on the criteria at a given level in the 
hierarchy. DecisionPlus shows this as a stacked bar histogram with 
bars representing the contribution from each criterion. 
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Analyze the Results 

Checking for reasonableness and robustness of the decision is a very 
important part of the process. DecisionPlus investigates the 
reasonableness of the decision through a Tradeoff Analysis and the 
robustness of the decision through a Sensitivity Analysis.  

A key feature of difficult decisions is that they involve conflicting 
criteria - you want solutions that are cheap but of high quality.  The 
tradeoff analysis shows you quantitatively how you are trading off one 
lowest criterion against another.  The values of these tradeoffs will 
help you understand if the preferences you entered are leading to a 
reasonable decision. 

The sensitivity analysis determines how sensitive the decision is to 
changes in the relative importance assigned to criteria. When you 
initiate Sensitivity Analysis, DecisionPlus shows you a list of weights 
of subcriteria with respect to their parent criteria with a metric that 
measures the sensitivity of the result when you change the value of 
that weight. DecisionPlus prioritizes the list in order of “most critical” 
to “least critical.” This way, you can focus on the criteria that can 
influence the decision the most. After this session you should know if 
the preferred alternative is robust and if you can be confident of your 
final decision. 

Document the Decision 

The last, but equally important part of the process is to document the 
decision. DecisionPlus provides complete report generation for your 
work. You can be confident that the why and how of your decision is 
available for peer, boss, client, or stakeholder review. And, most 
importantly, you can return to the decision if events dictate that the 
process be revisited. 



Chapter 7  Using DecisionPlus 

Criterium DecisionPlus 61 

Where to Go from Here 

You now have a choice as to where to go in the documentation. You 
can go to Part IV, Tutorial for Creating a Decision Model, for a 
tutorial on a making a decision with DecisionPlus, or you can go to 
Part III, Designing Your Own Decision Model for the details on using 
DecisionPlus. If you are new to decision-making using software tools, 
you might prefer to go through the tutorial first. The tutorial leads you 
step by step through the process of creating a sample decision model 
and selecting the preferred alternative. 
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Building Your Own Decision 
Model 

Are you in the right place and are you prepared to begin Part III? To 
determine your needs, go through the checklist below. 

 

  Prepared to design your own model? 

 Part III instructs you in entering your own information to 
design your decision model. You should have a goal in mind 
(for example, select a college), at least two alternatives from 
which to choose (Harvard or Yale), and some ideas about what 
considerations you think should be included in satisfying that 
goal (curriculum, location, cost). 

  New to decision analysis?   

 If you are new to decision analysis methods or software, you 
may want a quick overview before you begin this section. 
Turn to Chapter 5, Decision Analysis Techniques and Chapter 
6, Decision-making Process and Chapter 7, Using 
DecisionPlus. 

  New to decision analysis terminology? 

 With any new method or new software you’ll find new terms. 
Refer to the Glossary at the back of this manual. 

  New to Microsoft Windows? 

 We refer to many screen and mouse functions that are standard 
in Microsoft Windows and are already well documented in 
their user’s guide. If you are unfamiliar with Microsoft 
Windows conventions, review your Windows manual or have 
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it close by. See Chapter 3, Model Specifications, for a list of 
Windows conventions we use. 

How Much Detail is in Part III? 
We cover all options on all windows. That means we’ll cover some 
options you won’t want or need to use. We’ve added plenty of 
subheadings to aid you in scanning for functions you need. 

 

If you don’t have enough information about your own decision 
problem to proceed, you might try the tutorial in Part IV where we 
provide you the information to create a small decision model. 
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Chapter 8   
 
 
 

Brainstorm the Problem 
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Brainstorming as Part of the Decision Process 

Where are you? You are in the shaded part of the Process Diagram 
below: 

   

Brainstorm
 the Problem

Select Uncertainty

Analyze the Results

Review the Results

Rate the Hierarchy

Build the 
Hierarchy

Document 
the Results

Process Diagram
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Brainstorming on Canvas 

Often, when organizing your thoughts about a critical decision you 
wonder where to start. You take out a pencil and a sheet of paper, a 
new Pink Pearl eraser, and begin scribbling and erasing your thoughts 
about what you really want. After several attempts, you find you 
didn’t start your draft far enough down the paper and have run out of 
room in the top left corner. “Well,” you think, “I guess I should have 
thought this through a little more before I started my draft.”  You 
crumple up the paper, shoot for the wastebasket hoop, and take out a 
new sheet of paper.  

The beauty of DecisionPlus’ Brainstorming is that your thoughts don’t 
need to be organized before you start, outside of knowing what your 
goal is and what your choices are. You don’t need paper, pencil, 
eraser, or an empty wastebasket. You don’t even have to know how 
much room you’ll need to draft your ideas. The Brainstorm window 
allows you to get your thoughts on canvas and aids you in organizing 
them.  

Note:  Brainstorming is optional. If you are familiar with decision 
analysis software and have a decision framework or hierarchy 
already in mind, you may prefer to enter your decision model 
directly in the Hierarchy window. However, in the Brainstorm 
window you have the advantage of moving your criteria around 
freely until you’ve created the best representation of your ideas 
before using the system to create a hierarchy for you. 

Displaying the Brainstorm Window 

1. To open a new Brainstorm file, double-click your DecisionPlus 
icon. DecisionPlus automatically starts a new brainstorming 
session for you.  
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2. Or, if you already have DecisionPlus running, and have neither a 
Hierarchy nor Brainstorm file open, select New Brainstorm from 
the File menu.  

 The Brainstorm window, as shown below, automatically opens a 
new file temporarily named “New” and displays a template 
showing you where your goal and choices (alternatives) go.  

 

 

3. To open an existing brainstorm file, select Open from the File 
menu to display a list of .bst files. Select the one you want. The 
Brainstorm window displays your file. 
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Brainstorm Window Description 
The Brainstorm window has two parts, side by side. The left part looks 
like a canvas that you’d sketch on. On the right is a long gray 
rectangle with many horizontal empty rectangles. In the middle of the 
canvas is a circle with the word “Goal” inside, and in the lower right 
corner, a recycle bin. You can adjust the size of or scroll the 
Brainstorm window as instructed in your Windows User’s Guide (see 
Chapter 1, Road Map, for a list of Windows terms). 

 The goal circle appears in the center of the Brainstorm 
canvas. Your decision goal name goes here. The goal circle, and 
anything entered on the canvas, turns gray when you put your cursor 
on it. As you’ll see later, this indicates that you are working with or 
doing something to that block. You can move the goal circle anywhere 
on the canvas by using the Windows drag and drop feature. 

 The recycle bin in the lower right corner of the canvas 
temporarily stores ideas you prefer to work with at a later time. You 
cannot recycle the goal or alternatives. However, you can store groups 
of ideas in the recycle bin. Storing items is easy. You just drag them to 
the bin in the lower right corner of the canvas. When you’re ready to 
retrieve items from the recycle bin during the same session, open the 
recycle bin window, drag the items out of the recycle bin onto the 
canvas, and close the recycle bin. (See “Storing Criteria in the Recycle 
Bin” later in this chapter.) 

 To the right of the canvas is a gray column named 
Alternatives. This is where you enter the choices you have available in 
attaining your goal. You can enter up to 50 alternatives. You can turn 
off the Alternatives column to give yourself more canvas space to 
work on. 

To Close the Brainstorm Window 
1. From the File menu, select Close. 
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2. Or, from the Document Control menu (the hyphen to the left of 
File), select Close. 

To Close DecisionPlus 
1. From the Control menu (the hyphen in the extreme upper left 

corner), select Close. 

2. Or, from the File menu, select Exit. 

Entering Your Decision Goal 

Your decision goal is what you expect to accomplish after entering, 
weighting, and analyzing your decision criteria.  

Note:  Use the Microsoft Windows conventions for typing text. 

To Edit the Goal 
1. Click once inside the goal circle to select it. A selection box with 

“handles” appears around it. 

2. Click once on the word “Goal” to enter the edit mode. 

3. Type the name of your goal (such as Buy a Car). 

4. Click outside the goal circle, or press ENTER.  

   
If your goal name is particularly long, it may extend beyond the 
canvas display. If this is the case, you can either turn off the 
Alternatives display by selecting Alternatives from the View menu, or 
you can adjust the size of the view from the Zoom command on the 
View menu. Alternatively, you can move the goal anywhere on the 
canvas. 

To Enter Notes about Your Goal 
You can enter notes for the goal during the Brainstorm process. 
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Note:  Notes are especially handy if you have a lot of criteria that 
might make you forget why a criterion was important or how it 
relates to other criteria. You can enter notes about your goal, 
criteria, or alternatives by using the menus or by using the mouse 
as described below.  

1. Select the goal.  

2. Press CTRL+N, or select Block Notes from the Edit menu. The 
Notes dialog box displays. Your goal name is highlighted in case 
you want to make a change. 

2. TAB to or click in the Notes area.  

3. Type in your text. 

4. Select OK or press ENTER. 

   
 Three dots now appear following your criterion name to indicate 

notes are attached. In the following illustration, dots appear after 
the goal, a criterion, and an alternative. 
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Entering Your Alternatives 

Your alternatives are the choices you have in satisfying your goal 
(such as selecting a BMW, Ford, or Toyota). You want to select the 
best alternative, of course. You’ll most likely be thinking of your 
alternatives as you enter your criteria since most of your alternatives 
have many of these features. You can enter up to 50 alternatives. 

To Enter Your Alternatives 
1. Click any gray rectangle in the list of alternatives. 

2. Type your first alternative. 

3. Press ENTER. 

 You are set up automatically in the next gray rectangle to enter 
your second alternative. Repeat steps 2 and 3 until you have 
entered all your alternatives. 

 To correct any mistakes, click on the alternative you want to 
correct and use the standard Windows text editing techniques to 
edit. 

    

To Enter Notes about Your Alternatives 
1. Double-click an Alternative to display the Notes dialog box. (See 

“Enter Notes about Your Goal” for an illustration.)   

 If you are currently editing an alternative, double-clicking does 
not work. In this case, click any other alternative, then double-
click the alternative you want again. You can also press CTRL+N, 
or select Block Notes from the Edit menu. 

2. TAB to or click in the Notes area. 

3. Type your notes. 
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4. Select OK or press ENTER. 

To Edit or Delete an Alternative 
1. Single-click on the alternative you want to change.  

2. To change the name, use the Windows text editing techniques. 

3. To delete the name, select the text and press the DELETE or the 
BACKSPACE key. 

4. Select OK or press ENTER. 

To Change the title "Alternatives" 
You can change the title of the Alternatives list box (e.g., to "projects" 

or "Tasks"). 

1. Choose Alternatives Name from the Options menu.  The standard 
Notes dialog appears and you can enter the new name and any 
pertinent notes.  (If you later generate a Hierarchy, this 
information will become the name and notes for the Alternatives 
Level.) 

To Save Your File 
Following common Windows practice, we suggest saving your file at 
this point. 

1. Select Save or Save As from your File menu. 

2. Select a directory and enter a filename. 

3. Select OK. 

Your file is saved with an extension of .bst. 

Entering Your Criteria 

Criteria are what you think is important to consider in making your 
decision. You’ll have main criteria (such as, Performance, Cost, 
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Maintenance) and subcriteria (such as service, fees, restrictions for 
Maintenance). In fact, you can add up to seven levels of criteria, 
including the goal. The Brainstorm canvas provides you a free-form 
method of entering these criteria. You can enter criteria one at a time 
as they pop into your head and rearrange them on the canvas later, or 
you can enter a group of related ideas, group them and connect them to 
your goal before entering another group. 

To Enter Criteria 
1. Double-click anywhere on the canvas outside the decision goal 

circle. A block appears with the cursor blinking inside.  

2. Enter a criterion that you believe is important to consider about 
your decision.  

3. Press ENTER to accept your criterion and to display another empty 
block. 

4. Repeat steps 2 and 3 listing ideas as you think of them, until you 
have listed all your criteria. They do not have to be ordered. 

5. When you have finished, click outside the rectangle. Using this 
method, your Brainstorm window should look similar to the one 
below. 
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You can double-click anywhere on the empty canvas to create an 
empty block for new criteria. 

Sizing Your Criteria 
Sometimes the names of your criteria are larger than the default block 
size. You can adjust the size of any criterion block, or the goal block. 

1. Click on any block to select it. 

2. Position the mouse cursor over any of the handles of the selection 
box. 

3. Click and drag the handle to size the block. 
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4. Release the mouse button to finish the size adjustment. 

Note:  If at any time you decide you do not want to work with 
some of the criteria you’ve entered, you can delete them or 
store them in the Recycle Bin and retrieve them later. (See 
“Storing Criteria in the Recycle Bin” in this chapter.) 

Enter Notes about Your Criteria 
1. Click the criterion block you want to select. The Notes dialog 

box displays. (See “Enter Notes about Your Goal” for 
illustration.) 

2. Press CTRL+N, or select Block Notes from the Edit menu. 

3. TAB to or click in the Notes area. 

4. Type your notes. 

5. Select OK or press ENTER. 

 Reminder:  Save your file often 

To Edit Criteria 
1. Click once on the block. A selection box appears around the block. 

2. Click once on the name to highlight it. 

3. Type a new name, or use the standard Windows text editing 
techniques to edit the text. 

4. Click anywhere outside the block, or press ENTER. 

To Delete Criteria 
1. Click once on the block you want to delete. 

2. When the box appears around the block, press the DELETE key. Or, 
select Delete Selection from the Edit menu. 
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Pasting Tables of Data to Brainstorm 

Pasting Tables of Data to Brainstorm 
A Paste Special menu item has been introduced to the Brainstorm 
window's Edit menu. This menu command permits the pasting of a 
table of data, consisting of criteria names, alternative names, and 
ratings, into a brainstorm. This is helpful if you have to incorporate 
spreadsheet data into your Brainstorm file. The pasted data is used to 
create Brainstorm blocks and alternatives.  The rating values are 
retained and when the brainstorm is converted into a hierarchy, the 
rating data is transferred and may be viewed from the rating screen. 

Restrictions on Data Format 

The spreadsheet data must be organized in a tabular format with either 
alternative names as column headings and criteria names as row 
headings or vice versa.  (Column headings to appear at the top of the 
columns as opposed to the bottom - likewise for row headings which 
must appear on the left, not the right.)  The rest of the matrix contains 
rating data, which must be numeric.  e.g. 

 

To import tabular data to Brainstorm 

1. Open any spreadsheet that, usually by a simple Copy command,  
places Tab Delimited String (See Glossary) tables onto the Clipboard, 
and create or locate a table of data that fits the above description.   

2. Select the table (Including criteria and alternative names) and copy 
it to the clipboard.   

criteria/alts alt 1 alt 2 alt 3 

cri 1 2.0 3.1 1.3 

cri 2 106 190 155 
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3. Open Criterium and select the Paste Special menu option from 
Brainstorm's Edit menu.  The Paste Special dialog box displays.   

4. Indicate whether the rows represent criteria and the columns 
alternatives or vice versa by selecting the appropriate option button 
and pressing OK.  The alternatives and criteria from your spreadsheet 
now appear in the Brainstorm window.   

5. Delete, add notes, connect, add additional criteria as you would in 
any brainstorming session. 

6. Select the Generate Hierarchy menu item.  In the Hierarchy, 
double click one of the pasted criteria to display the Criterion Rating 
screen - you should see the ratings you copied from your spreadsheet 
program. 

Missing or Unavailable Data  

If some of the information in your spreadsheet is unknown, make sure 
you leave those cells blank - when you get to the hierarchy, they will 
read as "UnRated". 

Saving and Printing Pasted Data 

If you Save a Brainstorm file with such pasted data, the data is stored 
with the file and is available when next you open the file.  To print the 
data, check the Print Pasted Data option on the Brainstorm Notes print 
item. 

Note: The data imported into Brainstorm this way can not be 
"hot linked" to a source application. 

Selecting Multiple Blocks of Criteria 

There are two ways you can select multiple blocks: 

• To select many blocks at random, hold down the CTRL key while 
clicking on the blocks you want. Each selected block appears with 
a box around it. To unselect a block from the multiple selection, 
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hold down the CTRL key and click again on the block you don’t 
want. 

• To select a block and all of its children hold down the shift key 
while clicking on a block. All children are selected immediately 
(see “Connecting Subcriteria to Criteria” later in this chapter). 

You can now apply menu options and mouse options to all blocks 
selected at once. Actions you can make to the selected blocks are 
deleting, moving them around the canvas, or moving them to the 
Recycle Bin (See “Storing Criteria in the Recycle Bin” later in this 
chapter.) 

Grouping Your Criteria Blocks 

Once you have enough criteria blocks on the canvas, you can group 
similar criteria by dragging them to different areas of the window. 
This process is done solely by dragging blocks around the canvas with 
your mouse. No menu selection is necessary. 

1. Point to the block you want to move and drag the block to the area 
you want. You can select multiple blocks to move (see preceding 
steps in Selecting Multiple Blocks of Criteria). 
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2. Repeat until you feel the grouping is finished. 

 

Connecting Subcriteria to Criteria 

With similar criteria grouped, you can start connecting related ideas to 
create subcriterion-criterion relationships. In Brainstorm, a parent can 
have up to 50 children. However, if you are going to generate a 
Hierarchy file from your Brainstorm file, you should limit the number 
of children to 20, because this is the limit in Hierarchy. 

1. Determine which criteria are subcriteria of a criterion. For 
instance, Miles Per Gallon, Acceleration, and Braking are all 
subcriteria of Performance. Therefore, Performance is a parent of 
the other three blocks. 
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2. In order to link subcriteria to their parent criterion, drag each 
subcriterion block to a criterion block. When the block you are 
dragging to turns gray, the connection has been made. You cannot 
connect multiple blocks in Brainstorm. 

3. Release the mouse button and a line connects the two blocks. If no 
lines appear, select Connecting Lines from the View menu. 

To Create Parents for Ungrouped Criteria (Orphans) 
For any group of blocks without parent criteria, you can use the Group 
command to create a parent. Some criteria may not have children in 
Brainstorm. 

1. Click the first block. 

2. Hold down the CTRL key. 

3. Click the next related blocks one at a time (CTRL key still down). 
Boxes appear around the selected blocks. 

4. Release the CTRL key. Boxes should remain around the selected 
blocks. 

5. From the Edit menu, select Group. 

6. In the Notes dialog box that appears, type a parent name (in our 
example, we grouped Miles Per Gallon, Acceleration, and Braking 
under Performance). 

7. Enter notes if needed. (See “Enter Notes about Your Goal” earlier 
in this chapter.) 
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8. Select OK or press ENTER. 

   

Connecting to Off-screen blocks 
For large models, the block to which you wish to connect or 
disconnect another block may be off screen.  To make such a 
connection 

1. Select and drag the block you wish to connect to the edge of the 
Brainstorm canvas (where the white background meets the gray 
border) in the direction of the off-screen block to which you wish 
to connect. 

2. Keeping the mouse key depressed, position it over the narrow, 
gray, three dimensional border edge.  The canvas will start to 
scroll and the drag shadow of your block will flash on and off.   

3. When your target block comes in view, release the mouse. A line 
connects the blocks. 

Connecting Criteria to Your Goal 

At any point after you’ve entered criteria, you can connect criteria to 
your goal. You can always disconnect items you want to change. 
Below are steps to connect groups to the goal. 
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To Connect Groups to the Goal 
1. Drag the highest level criterion, the group parent, to the goal (in 

our example above, we drag Performance)  The entire family 
remains intact. When creating any connection, always drag the 
intended child on top of its intended parent. 

2. When the goal turns gray, the connection has been made. Release 
the mouse button.  

 Your group returns to its original position, but now has a line 
connecting it to the goal. If no connecting lines appear, select 
Connecting Lines from the View menu. The parent appears in 
large gray letters and its children appear in slightly smaller green 
letters.  

 For each level below the goal, a different color and size are used to 
aid you in differentiating relationships between blocks. 

To Disconnect Groups 
Now that you’ve connected your groups, you can disconnect them in 
the following way. 

1. With any two connected blocks, drag one onto the other. 

2. When the second block turns gray, release the mouse button. The 
connecting line disappears and your disconnected block name is in 
small black letters. 

Note:  Any blocks that are not connected to the goal, directly 
or indirectly, appear in small black letters. These blocks are 
not part of your decision model until they are connected to 
your goal block. 
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Collapsing and Expanding Families 

Collapsing families is a good way to free up canvas space to enter 
more criteria. When a family is collapsed, a plus (+) sign precedes the 
parent name and the descendants are hidden. 

To Collapse Families 
• Double-click the block you want to collapse. Or, click once on 

the block and select Collapse from the Edit menu. 

Note:  If the block you double-click on has no children, the 
Notes dialog box appears. 

To Uncollapse (or Expand) Families 
• Double-click any block that has a plus (+) sign preceding its 

name. Or click once on the block and select Expand Family from 
the Edit menu. 

Note:  If you delete a block that has collapsed children, its 
children are also deleted. Similarly, if you drag a block with 
the collapsed children to the Recycle Bin, its children are also 
moved. 
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Cleaning Up Your Canvas 

Your connections may not have come out as neatly as ours. That’s 
because we rearranged ours before we took the picture. Although you 
don’t need to have a neat arrangement of blocks before creating your 
hierarchy, you may want to view or print your work.  

 

To Rearrange Your Criteria  
• Drag the blocks to arrange them in the window. 

Note:  If you drag a block with children, its children move 
with it. 
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Storing Criteria in the Recycle Bin 

If you entered criteria on the Brainstorm canvas that you decide you 
want out of the way for now, you can store them temporarily in the 
Recycle Bin located in the lower right corner of the window. You 
cannot store the Goal or Alternatives in the Recycle Bin.  

Recycle Bin Window Description 
The Recycle Bin is another canvas, but has limited menus to perform 
some manipulation of criteria you place there. You can retrieve items 
from the bin during the same session by dragging them back onto the 
Brainstorm canvas.  

To Move Criteria to the Recycle Bin 
1. Drag a block or an entire connected group of blocks to the recycle 

bin. 

2. When the Recycle Bin is highlighted, release the mouse button. If 
the bin contains information, it appears with paper in the top. 

 
• When you drag connected criteria to the Recycle Bin they 

become disconnected. But, because they are not connected to 
your goal in the Recycle Bin, they display in small black 
letters.  
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• Any items remaining in the Recycle Bin are deleted when you 
end the current session. However, you can use the Recycle Bin 
to move blocks from one Brainstorm file to another (see 
below).  

  

Retrieving Criteria from the Recycle Bin 

There are two ways to retrieve criteria from the Recycle Bin. You can 
move criteria blocks back onto the current Brainstorm canvas, or you 
can move them from the current Brainstorm file to another. The 
Recycle Bin works similarly to the Clipboard in Windows because it 
stays open as long as Brainstorm is running. When you open a 
Hierarchy file or close DecisionPlus, the Recycle Bin closes. 

To Display the Recycle Bin 
• Double-click on the Recycle Bin icon at the bottom right corner of 

the Brainstorm window, or select Recycle Bin from the View 
menu. 
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To Move Criteria to Current Brainstorm Canvas 
1. Click and drag the items back onto the Brainstorm canvas. 

2. To close the Recycle Bin, select Close from the Control Menu 

To Move Criteria to Another Brainstorm File 
1. After placing criteria in the Recycle Bin, select the Brainstorm file 

you want from the Open command on the File menu. 

2. If you made any entries since the last time you saved your current 
Brainstorm file, a message prompting you to save your file 
displays. Select Yes or No. Your Brainstorm file closes and the 
one you selected opens. 

3. When your other Brainstorm file displays, click on the Recycle 
Bin to open it. 

4. Click and drag the items onto the Brainstorm canvas. 

To Close the Recycle Bin 
• Select Close from the Control Menu. 

Finding Blocks on the Canvas 

If your Brainstorming grows to a size that doesn’t all fit in the window 
at one time, you may not recall where some of your criteria was 
entered. You can have DecisionPlus find the block for you. 

1. Select Find Block from the Edit menu. The Find Block dialog box 
appears. 

2. In the Text to Search For box, type any string of characters you 
want searched.  

3. Select Find. In the Blocks Found area, a list displays all blocks 
with names containing the string. 

4. Select the item you want from the list. 
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5. Select OK. 

The selected block is centered on your canvas and flashes three times. 

Printing the Brainstorm Window Contents 

See Chapter 14, Document the Results, for instructions on how to print 
your Brainstorm results. 

Viewing the Brainstorm Profile Dialog 

The Brainstorm Profile provides a statistical view of your Brainstorm 
Model, as well as some information regarding its disk file. 

To view the Brainstorm Profile 
1. In the Brainstorm window, choose Profile from the View menu. A 

message dialog appears containing the information described 
below.   

Model Profile information 

• Number of Alternatives  

• Number of Blocks -  Total Number of Blocks in Brainstorm - 
including both Goal and Criteria 

• Number of Orphaned Branches - Branches not connected to 
the Goal 

• Deepest Level in Brainstorm - Number of Levels in the 
deepest Branch 

• Number of Criteria with Pasted Data - see the section Pasting 
Tables of Data to Brainstorm earlier in this chapter 
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• Number of Alternatives with Pasted Data 

Save Profile information 

The Date Model Last Saved is useful in determining whether you have 
the latest draft of a model. The Version information may be useful 
given InfoHarvest's frequent updates of DecisionPlus. 

• File Name - Name of disk file 

• Date Model Last Saved - Date file last saved 

• Version in which Model Last Saved - Version of DecisionPlus 
under which the model was last saved. 

To Close the Brainstorm Profile 
1. In the Profile dialog, click the OK button. This is the only action 

available to you. 

Brainstorm Menu Commands 

Many of the functions described earlier can be performed using the 
menu options. Below is a list of all the menus and options on the 
Brainstorm window. 

File  (See Microsoft Windows User’s Guide for details.) 

New  creates a new Brainstorm file. 

Open  opens an existing Brainstorm file. 

Close  closes the active (current) Brainstorm file. 

Save  saves the active (current) file. 

Save As  saves the active file under another name. 

Print Preview  shows how your document will look when it is 
printed. 
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Print  sends your document or selected pages to the printer. The 
Print option displays a dialog box so you can select options for 
the way you want your document to print and allows you to 
select a printer and select printer-specific options. (See 
Chapter 14, Document the Results.)  

Exit  closes DecisionPlus. 

Edit   

Undo  undoes your last action. 

Paste Special  this menu command permits the pasting of 
spreadsheet data, consisting of criteria names, alternative 
names, and ratings, into a brainstorm. The pasted data is used 
to create Brainstorm blocks and alternatives. In addition, 
rating information is retained and when the brainstorm is 
converted into a hierarchy, the rating data may be viewed from 
the rating screen. See Pasting Tables of Data to Brainstorm in 
this Chapter. 

New Block  creates a new block by first displaying a block 
information box. You can name the block and enter notes 
about the block. (See “Enter Notes About Your Criteria” 
earlier in this chapter.) 

Delete Selection  deletes selected items from the canvas. 

Clear Canvas  deletes all blocks on the canvas. Acts the same as 
creating a New file if you have not saved this file yet. Asks 
you if you want to save any previous changes. 

Select Family  selects entire family below the selected parent. 

Select All  selects all blocks on the canvas. 

Group  associates two or more selected criteria with a common 
parent, making them children and siblings. (See “Grouping 
Your Criteria Blocks” earlier in this chapter.) 

Ungroup (orphan children)  breaks the connection between the 
selected parent and its immediate children. Although those 
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children remain connected to their own children, they are no 
longer descendants of that parent. 

Orphan  breaks the connection between the selected block and its 
parent. 

Expand Family  uncollapses descendants of the selected block (see 
Collapse). 

Collapse  hides descendants of selected parent. Collapsed families 
are identified by the plus sign (+) preceding the parent name. 
Collapsing families frees up canvas space.  

Tip:  To collapse families, you can also press CTRL+SHIFT+F8 
or double-click a block that has descendants. 

Find Block  allows you to go directly to an identified block. See 
“Finding Blocks on the Canvas” earlier in this chapter. 

Block Notes  provides an information box to change the block name 
or notes for the selected block.  

Tip:  You can press CTRL+N to get the Notes. You can also 
double-click on a block if it has no descendants. 

Move to Front  moves crowded or partially hidden block from 
behind another block. 

Move to Back  moves a block that it is partially blocking another 
block to the back. 

View 

Alternatives  displays or hides the Alternatives column. 

Recycle Bin  displays the Recycle Bin window where you can 
retrieve stored criteria or perform limited functions on stored 
criteria. 

Confirm Drops  a toggle display confirming your connection of 
subcriteria to criteria.  

Alternatives' Name  allows you to change the title "Alternatives" to a 
more specific title for your alternatives, such as “Projects”, 
“Books” or “Hires.” Also lets you add notes describing the 
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type of Alternatives (see To Change the Title "Alternatives" in 
this Chapter).  

Zoom  resizes the display of your document to 25%, 50%, 75%, 
normal, or to fit to screen. 

Connecting Lines  a toggle to show or hide lines connecting the 
family trees. 

Profile  displays statistics on the model, and version and date 
information on the file. 

Show Toolbar  displays toolbar with select commands at top of 
screen. Uncheck to hide the toolbar. 

Show Toolbar Detail.  Adds brief written descriptions of toolbar 
items to the toolbar display.  

Model  

Options  

Environment  brings up the Options Dialog letting you set the 
display defaults for the program.  

New Model  brings up the Options Dialog letting you sets defaults 
for a new Brainstorm model when it is first created. These 
settings can then be modified to suit the particular model, 
and are then saved with that model.  

Generate Hierarchy  converts your Brainstorm to a more structured 
decision Hierarchy model, where criteria and alternatives can 
be rated. 
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Help 

Contents  brings up the Help Topics window which gives you a table 
of contents for program commands, menu options, using 
Criterium DecisionPlus for decision making, and decision 
theory concepts.  

Search  allows you to search the help file for specific terms.  

Decision Making  provides you with an overview of where you are 
in the structured decision making process.  

Web Home Page  connects you to the InfoHarvest, Inc. homepage on 
the web.  

Web Technical Support  connects you to the InfoHarvest, Inc. 
technical support page on the web.   

Web Updates  connects you to the InfoHarvest, Inc. CDP update 
page on the web.  

Web Register  connects you to the InfoHarvest, Inc. CDP on-line 
registration page on the web. It is important to take the time to 
register your software with your unique serial number so that 
InfoHarvest, Inc. can alert you to future upgrades and other 
Criterium DecisionPlus news.   

About CDP  displays CDP version, the registered user’s name and 
serial number.  
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The Brainstorm Window Toolbar 

The Brainstorm window has its own specialized toolbar. 

. 

The basic icons, left to right, are: 

1. New Brainstorm icon. Asks if you wish to save current brainstorm, 
then creates (empty) new one. 

2. Open Brainstorm icon. Asks if you wish to save current 
brainstorm, then opens the file browse dialog. 

3. Save Brainstorm icon. Saves the current brainstorm model. If new, 
unsaved, opens Save As file dialog. 

4. Print Icon. Brings up the Print Dialog window. 

5. The Print Preview icon. Brings up the Print Preview of your 
current window. 

 

6. Hierarchy Icon. Creates the Decision Hierarchy from the current 
Brainstorm file. If  the Brainstorm file is unsaved, you will be 
prompted to save it. Then the Hierarchy window is created and 
opened. 

7. Group icon. Creates a new parent block for any and all selected 
blocks. It presents the Notes dialog to you so you can enter the 
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name of the group, then creates that block and joins the selected 
blocks to it as child blocks. 

8. UnGroup icon. Breaks all links in a connected group. 

9. Undo icon. Restores decision model to previous state after a major 
editing action. 

10. Options icon. Opens the default Options dialog. 

11. Help icon. Brings up context sensitive online Help. 

Hiding Toolbar icons and/or text 
Checking the menu item Show Toolbar on the View menu determines whether the 
toolbar is visible or not.  If the toolbar is visible, checking the Show Toolbar Detail 
determines whether text labels appear under each toolbar icon. 

What’s Next? 

Once you’ve created your model in Brainstorm, you can generate a 
hierarchy. The next chapter, Chapter 9, Build the Hierarchy, describes 
how to generate and fine tune your hierarchy. You will always have 
this brainstorm file from which you can create as many hierarchies as 
you want. You can update any brainstorm file, or save it as a new file 
and update the new file. Chapter 14, Document the Results, describes 
how to print specific results from your decision model. 
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Building the Hierarchy as Part of the Decision Process 

Where are you?  You are in the shaded part of the Process Diagram 
below: 

   

Brainstorm
 the Problem

Select Uncertainty

Analyze the Results

Review the Results

Rate the Hierarchy

Build the 
Hierarchy

Document 
the Results

Process Diagram
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Structuring Your Decision Model 

The Hierarchy window helps you build and maintain the hierarchy of 
your decision model and rate the criteria. You can use your model 
from the Brainstorm window, or if you are familiar with decision 
analysis and with building decision models, you can create a new 
Hierarchy file and enter data directly into this window. 

AHP or SMART 
Before you begin in Hierarchy, you should think about whether to use 
the Analytical Hierarchy Process (AHP) or the Simple Multiattribute 
Utility Technique (SMART) in structuring your decision model. 
Certainly once you have entered your goal, criteria, and alternatives, 
and before you begin rating, you should choose which technique 
would be best for your decision. The section “Choosing the underlying 
model Technique: AHP or SMART” towards the end of this chapter 
will help you understand these techniques and to decide which to use. 
DecisionPlus uses SMART as its default technique, whether the 
hierarchy is created from a Brainstorm model or directly in the 
hierarchy window, unless you load a file previously saved using AHP.  

Since the default technique in the Hierarchy program is SMART, it is 
the one presented first in this chapter.  

Levels of Criteria 
In Hierarchy, you begin working with levels of your decision model. 
The hierarchy window builds your decision model beginning with 
your decision goal. It continues with up to six levels of criteria, the 
middle blocks of a decision hierarchy (the first is your highest level 
criteria, and the last is your lowest level criteria). It finishes with your 
alternatives, the choices from which you are trying to select. You have 
the flexibility of adding and deleting levels of criteria as needed. 
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In this part of the decision process, branches of criteria, subcriteria, 
and connected alternatives are created automatically when you 
generate a hierarchy from a Brainstorm file. But you can also create 
these relationships directly in the Hierarchy window. 

Displaying the Hierarchy Window 

The first step in building your hierarchy is to display the Hierarchy 
window. 

Generating A New Hierarchy File from Brainstorm 
1. From the Brainstorm window, after you’ve entered your goal, 

criteria, and alternatives, select Generate Hierarchy from the View 
menu.  

2. If the Brainstorm file is not yet saved, you will be asked do you 
wish to do so. Choose OK to do so, No to continue without saving, 
and Cancel to return to Brainstorm. Either of the first two choices 
will result in the closing (and saving, if requested) of your 
Brainstorm file. 

3. The Notes dialog window appears, and you will be asked to enter 
a name for the Hierarchy model, and any notes you care to add. 
You can enter, for example, the name or purpose of the model or 
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choose Cancel to make this dialog disappear (and add the name 
and notes later - see Model Notes). 

Refer to the section on “Hierarchy Window Description” for a general 
description of the window. Then turn to the section on “Modifying 
a Hierarchy Structure” later in this chapter for steps in editing your 
hierarchy. 

Creating New Hierarchy File Directly in Hierarchy  
1. Close the Hierarchy or Brainstorm window that is open, by 

choosing Close from the File menu. 

2. From the DecisionPlus window, select New Hierarchy from the 
File menu. The Hierarchy window, containing a simple hierarchy 
with a Goal, a single Criterion and an Alternative, all connected, 
will appear. 

Refer to the section on “Hierarchy Window Description” for a general 
description of the window. Then turn to the section on “Modifying 
a Hierarchy Structure” for instructions on creating a hierarchy. 

Opening Existing Hierarchy Files 
1. From the DecisionPlus window, or the Brainstorm window (be 

sure any open Brainstorm file is saved), select Open from the File 
menu and select a hierarchy file with the extension .cdp.  

To Close the Hierarchy Window 
• From the File menu, select Close. 

Hierarchy Window Description 
The Hierarchy window has a column or level format that holds up to 
seven columns and headings for the levels in your model. The model 
name appears at the top on the window Name Bar. You can insert 
blocks of criteria by double-clicking anywhere on the window, but 
they are confined to level. To size a block in Hierarchy, size the entire 
level (see below). 
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Working With Levels   You can select an entire level by clicking 
once on its heading. When the heading is selected, it and all blocks in 
that column are highlighted. You can also select blocks under headings 
individually. Highlighted items are ready for action by mouse, by 
shortcut keystrokes, or by drop-down menus. For example, you can 
adjust the column widths by dragging either edge of a column heading 
left or right.  (You are in drag-mode when your cursor becomes a two-
headed arrow.)  

 
Attaching Notes   You can attach hidden notes about the model, a 
level, or a block. If you already entered notes about criteria in 
Brainstorm, those notes are transferred into Hierarchy, but the criteria 
names are no longer marked with three dots as they were in 
Brainstorm. 

Entry Limitations   CDP limits you to one goal and 50 alternatives. 
In addition, you are limited to 160 blocks per decision model. Within 
these limits, you can have up to 100 blocks of criteria under any 
heading to the right of the goal. For example, if you have 50 
alternatives and one goal, you can have only 109 blocks distributed 
under levels 2-6.  See Chapter 3. 

Hierarchy Window at First Glance   When you create your decision 
model in the Hierarchy window rather than in the Brainstorm window, 
the window first appears nearly blank. Initially, only three level types 
appear on the Name Bar: Goal Level, Level 2, and Alternatives. If you 
like, you can replace these headings with something more appropriate 
to your decision goal. 

When you generate your hierarchy from a Brainstorm file, your 
window first displays the data provided from the Brainstorm file and 
the parent and child levels are already connected for you. Usually, 
there are two or more levels between the Goal and the Alternatives.  

Goal Level   In DecisionPlus, this is the first level of your decision 
hierarchy. This is what your decision model is all about (such as Buy a 
Car). Your decision model is set up to satisfy this goal. 
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Level 2   Under this heading is your first level of criteria, the children 
of your Goal. At this level, you consider these criteria major 
considerations toward your decision (such as Performance, Cost, and 
Style). The Goal can have only twenty immediate children.  

Additional Levels   Your major considerations (in Level 2) toward 
your decision can be broken down into lower levels of criteria, called 
subcriteria (i.e. Performance can be broken down to Acceleration and 
Braking ). You can add four more levels, Levels 3-6, for a total of 
seven levels. Higher level criteria that are connected to subcriteria are 
known as parents of the subcriteria. The subcriteria connected to a 
criterion are known as children of the criterion. A parent can have only 
twenty immediate children, and a child may have up to twenty parents. 

Alternatives   In order to satisfy your goal, you must choose from two 
or more alternatives (such as BMW, Ford, or Toyota). You list those 
alternatives in this column. You can enter as many as 50 alternatives. 
Each alternative can be connected with as many as 100 criteria. A 
criterion can be connected with as many as 50 alternatives. 

Modifying a Hierarchy Structure 

When you generate a Hierarchy file from the Brainstorm window, the 
hierarchy is built automatically based on the brainstorm model, 
including attached notes. You can modify the Hierarchy file by adding 
levels, blocks, notes, and alternatives. However, changes here do not 
update your original brainstorm file. They are two separate files. You 
can use the original brainstorm file to create other hierarchy files. 

If you have generated a hierarchy from the Brainstorm model in 
Chapter 3, your new Hierarchy decision model looks similar to that 
illustrated below. 
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Saving Your New Hierarchy File 
The first thing to do is save your hierarchy file before you begin 
working with it. 

1. From the File menu, select Save.  

2. In the directory of your choice, name your file. Your file is saved 
with the extension .cdp.  

 Note:  You can access your old Brainstorm file at any time. The 
changes you make in Hierarchy do not affect the Brainstorm file. 

Editing Your Decision Goal  

Sometimes when you see your hierarchy you decide you want to make 
some changes. That’s easy to do in Hierarchy. You can add levels, 
delete levels, add blocks, move blocks, delete blocks, add alternatives, 
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add notes, and edit anything that was entered in Brainstorm. There is 
no particular order to the levels in which you should make changes; 
however, we begin from left to right, from goal to alternatives. 

Note:  Any criteria that you left disconnected in Brainstorm do not 
show up in Hierarchy. If you reopen that Brainstorm file, the 
orphaned criteria are still on the canvas where you left them. If 
you want to include them in your Hierarchy, you need to do so 
manually - see “To Edit Your Criteria” in the following pages. 

To Edit Your Goal 
You can change the name or notes for your goal by using the Block 
Notes option on the Block menu or by following the steps below. 

1. Click once on the goal block to highlight it. 

2. Click once again on the goal block to highlight the goal name. 

3. Type your new goal name. 

4. Press ENTER or click outside the block. 

To Enter or Edit Notes about Your Goal 
If you want to enter or edit notes at the time you change your goal 
name, you can do both in the Notes dialog box. 

1. Click once on the goal block to highlight it. 

2. Press CTRL+N, or from the Block menu, select Block Notes. The 
Notes dialog box displays with the goal name highlighted.  

3. If the goal name is correct, TAB to or click in the Notes area. 

4. Type or change your notes. 

5. Select OK or press ENTER. 
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Editing Your Criteria 

To Edit Your Criteria  
1. Click inside the block. 

2. Click inside again to highlight the block name 

3. Type a new criterion name. 

4. Click outside the block or press ENTER. 

To Enter or Edit Notes about Your Criteria  
You can edit your criteria names and notes at the same time in the 
following way. 

1. Click once on the block to highlight it. 

2. Press CTRL+N, or from the Block menu, select Block Notes to 
display the Notes dialog box. 

3. Type a new criterion name if needed. 

4. TAB to or click in the Notes area. 

5. Type or edit your notes. 

6. Select OK or press ENTER. 

To Delete Your Criteria  
1. Highlight the block 

2. Press the DELETE key, or from the Block menu, select Delete 
Block, or from the Edit menu, select Delete Selection. 
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Inserting, Adjusting and Deleting Levels  

To Insert a Level  
1. On the Name Bar, click once to highlight the level where you want 

another level inserted. The entire column under that level is 
highlighted. 

2. From the Level menu, select Insert Level. A column of yellow 
empty blocks is inserted to the left of the level you initially 
highlighted. 

3. You can name your new level and begin entering criteria names in 
the empty blocks.  

 Inserted levels copy the structure of the highlighted column. When 
Alternatives is the highlighted column, the inserted level copies 
the structure of the column to the left of the alternatives. 

To Edit Level Name or Enter Notes  
1. Click once on the level name to highlight it. 

2. From the Level menu, select Level Notes. 

3. Type a new level name if needed. 

4. TAB to or click in the Notes area. 

5. Type your notes. 

6. Select OK or press ENTER. 

 

To Change Level Widths 
1. Place the mouse cursor at the edge of the level whose width you 
want to change and the cursor will change to the shape of a two-
headed arrow. 

2. Drag the level edge to the desired width. 
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Usually you will want to adjust the level widths so that the blocks 
within the level snugly accommodate their own name's text.  
DecisionPlus allows you to do so. 

1. From the View menu, choose Resize Level Widths.  The widths of 
all levels are set to the width of the longest block name in that level.  

To Delete a Level  
1. On the Name Bar, click once to highlight the level you want to 

delete. The entire column under that level is highlighted. 

2. Press the DELETE key, or from the Level menu, select Delete 
Level, or from the Edit menu, select Delete Selection. 

Entering New Criteria   

The first thing to do before you can enter new criteria is to provide a 
space for them. You can do that by adding blocks in any column. 

To Add New Blocks  
1. Double-click in an empty space above or below a block to add a 

block. This method produces a new block with “Name #” 
highlighted.  

2. Type your criterion’s name. 

3. Click outside the block or press ENTER. 

To Edit Your Criteria  
1. Click inside the block to highlight it. 

2. Click inside again to highlight the current criterion name. 

3. Type your new criterion name. 

4. Click outside the block or press ENTER. 
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If you need new blocks in which to type more criteria, see “To Add 
New Blocks” above. 

To Enter Notes about Your Criteria  
You can enter your criteria names and notes at the same time in the 
following way. 

1. Click once on the block to highlight it. 

2. Press CTRL+N, or from the Block menu, select Block Notes to 
display the Notes dialog box. 

3. Type a new criterion name if needed. 

4. TAB to or click in the Notes area. 

5. Type your notes. 

6. Select OK or press ENTER. 

To Delete Your Criteria  
1. Highlight the block 

2. Press the DELETE key. 

Connecting Your New Criteria  

Connecting and disconnecting blocks is easily performed using your 
mouse. To connect two blocks, do the following. 

1. Drag the block you want to the block you want to connect it to. 

2. Release the mouse. The blocks are connected by a line. 

As you see, the steps involved are the same as for Brainstorm, but with 
the difference that there is no directionality in hierarchy connections.  
When making a connection, there is no difference between dragging a 
criterion onto a subcriterion and dragging a subcriterion onto a 
criterion.   
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Furthermore, in the hierarchy, a criterion can be a subcriterion to more 
than one criterion. For example, if you have a model that lists 
Minimizing Cost as one criterion and Maximizing Sales as another 
criterion, Quality Control can be a subcriterion of both. 

To Connect Lowest Criteria to Alternatives  
Before you begin connecting your lowest criteria to your alternatives, 
it is important to remember that each lowest criterion that you want 
included in the decision scores must be connected to each alternative. 
Rather than connecting one at a time and trying to keep track of your 
connections, follow the steps below. 

1. Click once on the column heading Alternatives to highlight all 
alternatives in the column.  

2. Point to one highlighted alternative and drag it to the block you 
want connected. Although it appears only one block is being 
dragged, they all are being dragged. 

3. Release the mouse button when the mouse pointer is in the block 
you want connected.  All the Alternatives will be connected 

To Disconnect Goal, Criteria, and Alternatives  
• Repeat the processes above: drag a connected block onto one of 

the blocks to which it is connected. The connecting line between 
the two will be removed. 

Connecting to Off-screen blocks 
For large models, the block to which you wish to connect or 
disconnect a block may be off screen.  You make such a connection as 
follows. 

1. Select and drag the block you wish to connect to the edge of the 
Hierarchy canvas (where the white background meets the gray 
border) in the direction of the off-screen block to which you wish 
to connect. 
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2. Keeping the mouse key depressed, position it over the narrow, 
gray, three dimensional border edge. The canvas will start to scroll 
and the drag shadow of your block will flash on and off.   

Note:  The scroll edge is narrow. If you move the mouse icon 
too far over the edge, the mouse icon will change to a “No 
Go” ring, and no scrolling will occur (see image below).  

 
3. When your target block comes in view, release the mouse. The 

blocks are connected by a line. 

Saving Your New Hierarchy File  

1. From the File menu, select Save.  

2. In the directory of your choice, name your file. Your file is saved 
with the extension .cdp.  
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Entering Your Alternatives  

To Enter an Alternative  
1. Click inside the block “Alternative 1” to highlight the block. 

2. Click inside the block again to highlight the block name. 

3. Type your own alternative name. 

4. Click outside the block or press ENTER. 

To create more blocks in which to type more alternatives: 

1. Double-click in an empty space above or below a block to add an 
empty block. New blocks display initially with the “Name #” 
highlighted. 

2. Type your alternative. 

3. Click outside the block or press ENTER. 

To Enter Notes about Your Alternatives 
If you have notes about all your alternatives before you begin entering 
alternatives, you can enter your alternative names and notes at the 
same time in the following way. 

1. Click once on the alternative to highlight it. 

2. Press CTRL+N, or from the Block menu, select Block Notes to 
display the Notes dialog box. 

3. Type a new alternative name if needed. 

4. TAB to or click in the Notes area. 

5. Type your notes. 

6. Select OK or press ENTER. 

To Edit an Alternative  
1. Click once on the Alternative. 
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2. Click again on the alternative name to highlight it. 

3. Type your new alternative name. 

4. Click outside the block, or press ENTER. 

To Delete an Alternative  
1. Highlight the block 

2. Press the DELETE key, or select Delete Selection from the Edit 
menu, or select Delete Block from the Block menu. 

Working with Blocks 

The following topics apply to your Hierarchy model whether you 
generated it from Brainstorm or created it directly in Hierarchy. 

Moving a Block 
You can move criteria blocks anywhere within the criteria block 
levels. You cannot move them to the Alternative or Goal level, and 
you cannot move Alternative blocks to a criterion or to the Goal level. 
You cannot move the Goal. 

1. If the block you want to move is connected to other blocks, 
disconnect them using the same steps you used to connect them. 

2. Click and drag the block to the position you want. 

Selecting Multiple Blocks 
When you have several blocks to which you want to apply a similar 
function, you can select all of them and apply that function at one 
time. 

1. Click on one block to highlight it. 

2. Press the CTRL key and click on the next block. 

3. Repeat step 2 until all the blocks you want are selected. 
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When all the blocks you want are selected, you can use a block 
function from the Hierarchy menu, or use a mouse or keystroke 
function. 

Finding Blocks 
1. Select Find Block from the Edit menu. The Find Block dialog box 

appears. 

  
2. If you wish to search by name, make sure the Name option is 

clicked.  In the Name text box, type any string of characters you 
wish to search for in the names of the Blocks (for example, you 
can type Main for Maintenance). 

 If you wish to search for all unconnected blocks, click the 
Unconnected Blocks option. 

 If you wish to search for all unrated blocks, click the Unrated 
Blocks option. 

3. Click Search. In the Blocks Found area, a list displays all blocks 
that satisfy the search condition set in step 2 above. 

4. Select the block you want from the list. 

5. Select Go To. 
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DecisionPlus locates and centers the block on your window. It is 
highlighted and flashes three times. 

Duplicating Blocks 
You can add new blocks that take on the same connections as another 
block in the Hierarchy. 

1. Select the block you want to duplicate. 

2. Select Duplicate Block from the Block menu. 

A block appears above or below the highlighted block with the same 
connections as the highlighted block. You see the word “Name” and a 
number after it, highlighted. The numbers start at 0 and increase by 1 
for each new block you add to this hierarchy. This numbering process 
is meant to give the block a unique identification, but for your own 
clarification, you should enter a name as soon as possible, or at least 
before closing the file. The numbering process for new blocks starts 
again at 0 in your next session. 

Arranging Blocks 
After adjusting and fine tuning your model, it may be suffering from 
post-moving blues, with connecting lines crossing unnecessarily and 
blocks just a little off center. DecisionPlus rearranges your model 
neatly for you. You can select this option any time and several times. 

1. From the Model menu, select Arrange Blocks.  

The model will display with each criterion centered before its 
subcriteria and some spacing between blocks. 
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Working with Branches in Hierarchy 

The ability to copy, move or delete entire branches of the decision 
hierarchy is a powerful editing capability of DecisionPlus. For 
instance, if a group can agree on the structure of the model, but two 
factions can not agree on the weights, you can duplicate the main body 
of the model, tag each duplicate with the name of a faction, and have 
each faction independently weight their own submodel. Differences 
between the two can then be seen directly using the existing analysis 
windows and the new tagging feature. 

Selecting a Branch in Hierarchy 
You can select an entire branch or submodel of the decision hierarchy 
in the following way. 

1. Holding down the Shift key, click the block at the head of the 
branch (nearest to the Goal) to select it. 

All the subcriteria of the head criterion will be selected, and their 
subcriteria, all the way to the alternatives, will be selected (indicated 
by a yellow highlight). The alternatives themselves are not 
highlighted, as they are not considered part of the branch. 
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Duplicating Branches in Hierarchy 
You can create entire new submodels that take on the same 
connections as the original submodel. Any connections between 
blocks belonging to the branch (be they to criteria in other branches or 
alternatives) will be faithfully duplicated. Each duplicated criterion 
will have the same scales, weights, connections, value functions and 
uncertainty distributions (if it is a lowest criterion) as the original.   

1. In the Hierarchy Window, select the branch you want to duplicate 
(see Selecting a Branch in Hierarchy, above). 

2. Select the Duplicate Branch window from the Block menu. 

The head block of the duplicate branch is left in an edit state after 
duplication, with the same name as the original highlighted. You 
should immediately type in a new name to distinguish it from the 
original branch. If, however, that new head block is drawn off-screen, 
it will not be highlighted when you scroll to it. It is advisable to edit 
the name, as there may be no other way to tell the original and 
duplicate branches apart. 

Note 1: DecisionPlus will attempt to give the duplicated 
branch the same shape as the original, but if the original 
branch was entangled with other criteria and their connections, 
the results may not be beautiful. 

Note 2: You can not duplicate the entire decision model.  If 
you selected the Goal as the head of the Branch, a warning 
message will appear when you attempt to duplicate it. 

Deleting a  Branch in Hierarchy 
You can delete entire submodels (branches) from the Decision 
Hierarchy. 

1. In the Hierarchy Window, select the branch you want to delete 
(See selecting a Branch in Hierarchy above). 

2. Choose Delete Branch from the Block menu or press the Delete 
key. 
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Viewing the Hierarchy Model 

Even for models of moderate complexity, the Hierarchy structure 
becomes large and intimidating. In order to keep you firmly in control 
of the decision model you are creating, DecisionPlus provides you 
with many different ways to view the model. The Navigator allows 
you to move rapidly about a large hierarchy. Enhanced Decision 
Hierarchy Views allow you to understand the state of the model - are 
all criteria rated and connected and how important are they in the over 
all model?  The Hierarchy Profile provides statistics on the model, the 
Information window gives an overview of the identity of criteria and 
alternatives, and the Spreadsheet Format allows you to view the 
underlying values in the model. 

Using Navigator to View Large Models 

Your decision model could become large enough that you can’t see all 
of it on the screen. Displaying Navigator shows you the big picture of 
your decision model in a small version. You can also use the 
Navigator to locate your model if it has scrolled off the window.  

To Display the Navigator 
1. Select Navigator from the View menu. A small window entitled 

Navigator appears at the lower left corner of your window.  

2. To close Navigator, select Close from the Navigator’s control 
menu, or reselect Navigator from the View menu. 
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The Navigator window displays block images with no block names. 
You’ll see a highlighted block that corresponds to the block you have 
highlighted in your Hierarchy window. You can size Navigator to fit 
the entire screen, or to fit in any corner of your Hierarchy window. In 
Navigator, you can click on a block or an area and your hierarchy 
model shifts to center that block or area in your Hierarchy window. 

To move to a different block of your model, or shift the center of the 
Hierarchy window to a different part of your model, 

• Click on the block or area you want in the Navigator window. The 
Hierarchy window centers around the block or area you clicked. 

 

Enhanced Decision Hierarchy Views 

The basic hierarchical representation of the decision model may be 
enhanced by the addition of  Accumulated Weights, Unrated Blocks 
and Disconnected Blocks.  Each of these effects, which are 
implemented as overlays of the basic graphical structure, gives insight 
on the state of the model.   
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Accumulated weights 

Checking the Show Accumulated Weights item in the View menu 
shows the accumulated weight of each block (criterion and alternative) 
in the block, preceding the name. (For more information on weighting 
criteria, see chapter 10). Level widths are automatically adjusted to 
allow for these accumulated weight values.  The accumulated weights 
are dynamically maintained as the Hierarchy is edited.  If the hierarchy 
becomes disconnected in the course of editing, the accumulated 
weights will be incalculable, and will show as "####" in the Block 
Name. 

Unrated Blocks 

By clicking on Show Unrated Blocks in the View menu, blocks whose 
subcriteria or alternatives have not been completely rated are colored  
Green. 

Disconnected Blocks 

By clicking on Show Disconnected Blocks in the View menu, criteria 
which are not connected to the Goal and to at least one alternative are 
colored Red.  In either case, if the only such Blocks are off-screen, 
CDP asks if you wish the canvas to scroll so you can see such a block. 

Viewing the Hierarchy Profile 

The Hierarchy Profile provides a statistical view of your Hierarchy 
Model, as well as some information regarding its disk file. 

To view the Hierarchy Profile 
1. In the Hierarchy window, choose Profile from the Model 

menu.  A message dialog appears containing the information 
described below.   
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Model Profile information 

• Name of the Model - The Name of the Hierarchy Model.  
The symbols "" appear if no name has been given. 

• Decision Analysis Technique - AHP or SMART 

• Number of Lowest Criteria - Number of Lowest Criteria 
(Attributes) in the model. 

• Number of Blocks - Total Number of Blocks in the 
Hierarchy.  Can not exceed 160 in all - see Model 
Specifications and limitations in Chapter 3. 

• Number of Uncertainty distributions - How many 
individual uncertainty distributions have been assigned. 

• Number of Levels in the Hierarchy - Number of levels can 
not exceed 7. 

• Number of user defined Numeric Scales  

• Number of user-defined Verbal Scales 

• Number of user-defined Pairwise Comparison Scales 

• Number of Rules 

• Number of Links to Subordinate Models - How many 
other hierarchy models are linked to this one. 

Save Profile information 

This information is useful in determining whether you have the latest 
version of a decision model. The Version information may be useful 
given InfoHarvest's frequent updates. 

• File Name - Name of disk file 
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• Date Model Last Saved - Date file last saved 

• Model Last Saved in Version - Version of DecisionPlus 
under which the model was last saved. 

To Close the Hierarchy Profile 
1. In the Profile dialog, click the OK button. This is the only 

action available to you. 

Viewing the Information Window 

The Information window allows you to view, edit and export all the 
names and notes of Goal, Criteria and Alternatives. Many times during 
the creation and analysis of your decision, your understanding of the 
meaning of the goal, criteria and alternatives will grow and change. If 
returning to a model at a later time, it is important that you, as well as 
others, can fully apprehend the decision model and its outcome.  
Therefore,  it is a very good practice to maintain the name and notes 
associated with those entities at all times. 

The Information window, accessible from most windows in 
DecisionPlus, provides support in doing just that. 
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To View the Information window from Hierarchy 
1. In the Hierarchy window, from the Model menu, select 
Information. 

 
Most of the Information window is taken up by a list box with two 
columns, the first showing the name of each block, the second 
showing the start of the corresponding notes (if any). The blocks are 
sorted alphabetically by name, with no regard as to whether they are 
criteria or alternatives.  

To Edit Names and Notes  

1. In the List box, click and line to select it. 

2. Click Edit to bring up the Notes dialog, and edit your name and or 
note directly. 

Tip:  You can open the Notes dialog directly by Double Clicking 
any line in the List box. 
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To Copy all Names and Notes to the Windows Clipboard 

1. Click the Copy All button. A Tab delimited table of Names and 
Notes is copies to the Windows Clipboard from where it can be pasted 
to your spreadsheet or wordprocessor. 

To Close the Information window 

1. Click the Close Button 

Viewing Your Model in Spreadsheet Format 

You can put your model information in spreadsheet format and print a 
copy of it. 

Viewing Your Model in Spreadsheet Format 
In addition to the usual graphical representation of the hierarchy 
model, you can also put your model information into a spreadsheet 
format.  You can review and edit the values of (direct) weights and 
ratings directly, see the associated priorities, print, cut and paste data 
to and from the spreadsheet, and Link to external spreadsheets. 

At this point, we have not weighted your criteria, so there are no 
numerical values to see. The cells that are reserved for weights say 
“unrated” until you enter ratings. You may want to revisit this section 
after you have rated your model (see Chapter 10). 

To View Your Model in Spreadsheet Format 
There are two different spreadsheet views available to you. 

Hierarchy Data 

1. In the Hierarchy window, from the View menu, select Hierarchy 
Data. 

The Goal criterion appears in the upper left of the spreadsheet, and the 
subcriteria and its rating set are stacked in the column once removed to 
its right. Before the name of each subcriterion appears the present 
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weight of that subcriterion with respect to its parent criterion.  
Immediately to the right, the name of the first subcriterion is repeated, 
and the weights and names of its subcriteria are recorded. Scrolling to 
the extreme right, you will see columns of ratings for each Alternative 
against the lowest criteria (attributes). 

Hierarchy Priorities 

1. In the Hierarchy window, from the View menu, select Hierarchy 
Priorities 

The spreadsheet appears as before, but with an additional column of 
numbers to the right of each column of weights and ratings. The values 
in these new columns give the relative importance or priority of your 
judgments in terms of DecisionPlus's internal scale, which runs from 0 
to 1 and is independent of the scale you assigned to the parent 
criterion.  Studying these numbers will help you understand how 
DecisionPlus consistently compares values defined on diverse scales 
against each other. 

Editing Data 

Whether in Data or Priorities view, the values of weights and ratings 
may be changed, but the names and relationships of criteria may not be 
altered. If a rating set has been weighed using Direct Comparison, the 
cells in which the weights and ratings appear are white, indicating they 
can be edited, while all other cells are gray and can not be edited. If 
you click on a cell that you are not able to modify, you'll get a message 
that this cell cannot be changed directly. Note that if you enter a cell 
by clicking inside it, scale information for the relevant criterion is 
displayed at the top of the data sheet.   

If a rating set has been weighed using Pairwise Comparison or 
Abbreviated Pairwise Comparison, the word "Pairwise" appears 
instead of a numerical value, and is grayed. Whether the Direct 
Comparison method was used or not, Double Clicking the weight cell 
will open the standard Ratings window. Cells that are reserved for 
weights that you have not yet evaluated say "unrated " until you enter 
ratings. 
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Printing the Spreadsheet 

To print the spreadsheet simply choose Print from the File menu. The 
options "Weights and Ratings only" and "Weights, Ratings and 
Priorities" correspond to choosing Hierarchy Data or Hierarchy 
Priorities in the data sheet. 

Return to Graphical View 

You can return to the usual graphical view of the Hierarchy as follows. 

1 From the View menu, choose Hierarchy Graph.   

To Copy from the Hierarchy Spreadsheet   
Using the Windows clipboard, data may be copied and pasted between 
the Hierarchy spreadsheet and any other spreadsheet. In particular, the 
Ratings of all alternatives with respect to all lowest criteria or 
attributes may be copied from another application to DecisionPlus in a 
single action. You can copy information from the Hierarchy 
spreadsheet as follows:  

1. In the Hierarchy window, from the View menu, select Hierarchy 
Data (or Hierarchy Priorities). 

2. Using the mouse, select any block of cells by clicking the mouse 
in a cell lying at one corner of the desired block, then holding down 
the mouse drag till you are inside the cell at the opposite diagonal of 
the block, then release. 

3. Choose Copy from the Edit menu. 

4. Change to the target application (spreadsheet or word processor) 
and use that application's Paste facility to paste a Tab Delimited (see 
Glossary) table of data. 

To Paste to the Hierarchy Spreadsheet 
You can paste information from another spreadsheet or word processor 
table to the Hierarchy spreadsheet as follows. 

1. In the source application, select the relevant cells, which must 
contain only numerical data. 
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2. In the source application, Copy the relevant cells. This places the 
information in the Windows Clipboard. 

3. In the Hierarchy window, from the View menu, select Hierarchy 
Data. 

4. Using the mouse as described above, select the block of cells to 
which you wish to paste the data. 

5. From the Edit menu choose Paste. This copies the information 
from the Windows Clipboard to DecisionPlus. 

Not all pastes are equal 

The paste command will only succeed if 

• There is suitable numerical data in the Windows 
Clipboard 

• The shape and number of cells selected in the source 
application exactly matches that of the block you selected 
in DecisionPlus. 

• The selected cells in the Hierarchy Spreadsheet do not 
contain any grayed cells (you can not edit any cell that is 
grayed.)  

If any of these conditions is not met, a message to that effect will be 
displayed. 

In addition, if numerical values in a cell exceed the upper and lower 
bounds of the scale defined for that criterion, you will be asked is it 
OK to "clip" the value to that of the closest bound, or would you 
prefer to Cancel the entire Paste operation.   

Note:  DecisionPlus does not check that you are pasting data 
related to a criterion in the source application to corresponding 
cells for the same criterion in the spreadsheet.  A good way to 
ensure that the ordering of alternatives and lowest criteria in 
the source application matches that in DecisionPlus's 
Hierarchy Data view is to first copy the Hierarchy spreadsheet 
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to the other application (use Select All from the Edit menu), 
fill the data in that application, then paste back to 
DecisionPlus. 

To Create a DDE Link to the Hierarchy Spreadsheet 
You can create a "hot" DDE link (see Glossary) from another 
spreadsheet or word processor table to the Hierarchy spreadsheet. This 
means that if data in the source application changes, the changes will 
be automatically forwarded to DecisionPlus, and all calculations 
updated.  A block of cells containing ratings information of 
alternatives, may be imported from a spreadsheet that supports DDE 
links into the Data View of the Hierarchy.   

1. In the source application, (e.g. Excel), select the relevant cells, 
which must contain only numerical data. 

2. In the source application, Copy the relevant cells. This places the 
information in the Windows Clipboard. 

3. In the Hierarchy window, from the View menu, select Hierarchy 
Data. 

4. Using the mouse to select the corresponding block of cells, make 
sure that the dimensions and ordering are exactly the same as for the 
cells in the source application. 

5. From the Edit menu choose Paste Link. This copies the 
information from the Windows Clipboard to DecisionPlus, and creates 
a link between the source application and DecisionPlus. Information 
on that Link (source application, topic, time of update) is 
automatically placed in the Notes of the Goal. A message is posted 
indicating the successful establishment of the link. 

Note: See “To Paste to The Hierarchy Spreadsheet above for 
conditions on acceptable data for pasting. 

Note: Only one "live" link is supported at a time.-Creating a 
new link will destroy the existing link - a message will be 
posted to that effect.   
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Note: If a model is closed, the link must be recreated by hand 
when the model is next loaded - information on the last link 
(time and date, name of file) may be found in the Notes of the 
Goal block. 

Printing the Hierarchy Window Contents 

At any time, you can print the graphical contents or notes of your 
Hierarchy model. Some options, although available all the time, won’t 
produce useful information until you enter information later in Ratings 
and Rules, discussed in the following chapters. See Chapter 14, 
Document the Results, for steps on printing your Hierarchy 
information. 

Group Decision-Making 

DecisionPlus supports three approaches to Group Decision-making.  
Bear in mind that DecisionPlus is a not a group-ware product, i.e., 
DecisionPlus can not accept simultaneous inputs from multiple 
participants.   

Facilitated, Consensus Group Decisions 

The basic approach is to run DecisionPlus on a large overhead screen 
in a group meeting room. A facilitator keys in all information to the 
system while leading the meeting. The facilitator needs considerable 
knowledge of  DecisionPlus and the decision process it supports. 
Other participants need no knowledge of DecisionPlus or decision 
analysis.  

The facilitator walks the group through brainstorming, rating the 
model, analyzing the outcome, and refining the model. Because 
brainstorming is an inclusive process, it rarely poses difficulties as 
long as the facilitator can type quickly. Scoring the alternatives and 
analyzing the results are also, in general, straightforward.   
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Bringing a heterogeneous group to consensus regarding the relative 
importance (weight) of the various criteria is usually the greater 
challenge. However, bringing  the group through the brainstorming, 
scale creation and hierarchy structuring steps often allows people to 
better understand the fears and concerns of others. In addition, the 
structured nature of the model tends to focus discussions on the 
relevant issues, enabling consensus weighting more often than might 
be expected. 

Facilitated Multi-Voiced Group Decisions.   

At times consensus in weighting can not be achieved or there might be 
reasons why the various groups or individuals should have their inputs 
directly recorded. In this case a multi-voice decision model can be very 
effective. The structure and scales of the model are first agreed upon 
by all. Then the entire model is duplicated within itself (see below), 
with each distinct voice given its own copy to rate as it sees fit. The 
voices are combined usually with equal weight, so that they essentially 
vote on the outcome. 

Distributed Group Meetings 

In some cases the difficulty in achieving consensus in the decision 
group arises not from contention so much as from differing areas of 
expertise. In that case you may want to create completely separate 
models that individual groups, e.g.,  engineering, financial, etc., would 
rate. The individual models may then be linked as described in the 
section “Linking Models” below. 

Creating a multi-voiced decision model 



Chapter 9 Build the Hierarchy 

136 Criterium DecisionPlus 

 

When analyzing multi-voiced models, the Tag Level Functionality 
(see the section “Viewing Contributions by Criteria” in Chapter 13) 
will allow you tag each criterion name with name of the appropriate 
voice (e.g., Engineering, Admin., etc.).  The Contributions by Criteria 
analysis will help you understand differences between the voices and 
how they affect the over all decision scores. 

To create a multi-voice decision model, proceed as follows: 

1. Brainstorm and generate a hierarchy in the usual manner (no 
consideration to voices). 
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2. Score all alternatives and assign scales to all criteria. (See 
chapter 10 for more information on scoring and scaling 
alternatives). 

3. Select the Level immediately to the right of the Goal level, in 
this example it is labeled “main criteria”, by clicking the Level 
Bar where it says “main criteria.” From the Level menu, 
choose Insert Level. A new level appears between the “main 
criteria” level and the Goal level. Click the Level bar of the 
new level twice and type “Voices”. 

4. Each criterion in the “main criteria” level has a corresponding 
criterion in the Voices level. Select all but one of the criteria in 
the Voices level, and delete them by pressing your Delete key. 
Click the remaining Block twice and enter a name of one of 
the Voices, e.g., James. 

5. Connect all criteria in the “main criteria” level that are not 
connected to the remaining block in the “Voices” level (in this 
case, “James” is the remaining block), and connect them. 

6. Branch Select the single Voices Block, “James”, by holding 
down the Shift key when selecting the block. Choose 
Duplicate Branch from the Block menu. Repeat as many times 
as there are voices less two. Name each block in the Voice 
level, e.g., Mary, Sharon etc. 

7. Have the various voices independently weight their branches. 

8. When you open any results or analysis window, immediately 
select Tag Level from the Analysis menu, and choose the 
Voices level. It will then be clear with which submodel a 
given criterion or weight  is associated. 
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Linking Models 

When the decision problem involves the expertise of other group 
members, you can partition the problem and assign them to the groups. 
For example, when the decision problem involves financial, 
engineering, and management issues, instead of working the entire 
problem with the whole group, you can have each department work 
their respective issues. Once their part of the model is constructed and 
rated, you can integrate it into the master model.  

DecisionPlus provides a linking capability. You can link other models 
and aggregate the results into one decision score. The results of your 
master model are aggregated by including the results of the linked 
model into the master model at the criterion level where you locate the 
link block. 

Note: Uncertainty results are not transmitted through links. 

To Link Other Models 
1. First create a new block in the model on which you are working, 

to create a linking point. In the Hierarchy window, double-click on 
a blank space in the hierarchy to create a “Link to Blocks” block.  

 The block can be at any level in the master model, but you should 
decide where the appropriate place is before you create it. A new 
block appears with the word “Name” and a number highlighted. 
You can type in any name you want. 

2. Select Link Block from the Block menu. A message appears “No 
links on file. To establish a link, select New.” 
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3.  Select OK. The Maintain Model Links window appears. 

 

4. Select New to display the Add File Link window. Select your 
“Link to Blocks” block from the Link to Block list box. 
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5. On the Add File Link window, click the Select File button to 
display a list of files. 

 

6. From the Link From File window, select the filename of the file 
you want to link. 

7. On the Add File Link window, click the Add Link button. 

After you select the Add Link button, two messages may appear. 
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If you are linking models that are dissimilar, where at least one 
alternative in the new model does not already exist in the master 
model, you see the message below. 

 
If you choose OK, all un-matched Alternatives in the linked model 
will be added to the current (Master) model.   

When the link is complete, the new “Link to Blocks” block you added 
is no longer available and you see the message below. You would need 
to create a new “Link to Blocks” block in the Hierarchy window to 
link another model. 

 
On the Maintain Model Links window, select OK to link the file, or 
select Cancel to cancel the link. Assuming you choose OK, you will 
see that your Link Block is now connected to all the Alternatives, and 
it has a new name: “Link - Link Goal Name”, where Link Goal Name 
is the name of the Goal of the linked model. You may change that 
name if you wish.  
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To Connect Your Linked Model 
• To complete the link, click and drag your linked block to the 

appropriate criterion level. 

To Update Linked Models 
If models that are linked to the master model have been updated, you 
can bring those updates into your master model in one of two ways. 
You can update a single linked file, or update all files linked to the 
master model. 

Updating a single linked file 

1. Select Link Block from the Block menu to display the Maintain 
Model Links window. 

2. From the Link to Block list box, select the linked block whose 
updates you want included. 

Note: In addition to listing links by Goal name of the linked 
Model,  you can choose to list them both by Goal name and 
the name of the Link block in the Master Model. This is useful 
if you have edited the names of the Link criteria in the Master 
model to make them more identifiable.  

To have the Model Link List in the Maintain Model Links 
dialog show linked Criterion names also: 

1. Click Link Name - Criterion Name option 

3. Select the Update button. The Update File Link dialog appears. 
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4. If the Last Update to Link File is later than the Last Update to 

Link, date (as it is above), the information in your current (master) 
file is out of date and you should Click the Update Link button. 

Unable to Access “Link from” File 

In step 3 above, clicking the Update button on the Maintain Model 
Links dialog, you may encounter the message titled Unable to Access 
"Link from File." A common cause for this error is that  the linked file 
has been moved or is otherwise unavailable. A file browse button is 
added in the Update File Link dialog above to allow you to manually 
locate a valid copy of the linked file. 

4. Click OK to close message. You will find yourself in the Update 
File Link dialog. 

5. Click the Find File button. A standard Browse dialog appears.  

6. Locate the file and press OK. The link will immediately update. 

Updating all linked files 

1. Select Link Block from the Block menu to display the Maintain 
Model Links window. 

2. Select the Global Update button. 
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To Delete Linked Models 
• In the Hierarchy window, select the blocks one at a time and press 

the DELETE key, or select Delete Selection from the Edit menu, or 
select Delete Block from the Block menu. 

To Edit Linked Models 
You can change the ratings of the linked files, or delete and add 
alternatives. Follow the editing steps for the appropriate topic in this 
chapter. 

Hierarchy Menu Commands 

Many of the Hierarchy window functions described earlier using the 
mouse can also be performed using the menu options. Below is a list 
of all these menus and options. 

File  (See Microsoft Windows User’s Guide for details.) 

New Hierarchy  Creates a new Hierarchy model. Asks you to save 
current model, if unsaved.  

Open  Opens an existing hierarchy file. Hierarchy files have a .cdp 
default extension.  

Close  Closes the active (current) file. Asks to Save, if unsaved. 

Save  Saves the active (current) file. 

Save As  Saves the active file under another name. 

Print Preview  Shows how the hierarchy model will look when it is 
printed. 

Print  Sends your document or selected pages to the printer. The 
Print option displays a dialog box so you can select options for 
the way you want your document to print. (See Chapter 14, 
Document the Results.) The print option allows you to select a 
printer and select printer-specific options.  
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Export to Excel  Exports the structure and ratings data of the current 
Hierarchy active file to Excel. CDP attempts to locate the 
Excel program file on your computer. If unable, it will open a 
file Browse dialog and enlist your help. 

Export to Text File  Exports the structure and ratings data of the 
current Hierarchy active file to a text file. CDP opens the save 
file dialog. 

Exit  Exits DecisionPlus. Asks to save current file, if there is 
unsaved data. 

Edit   

Undo  Undoes your last edit action. 

Copy Visible Hierarchy to Clipboard Screen  Captures the visible 
portion of the hierarchy diagram to the clipboard for export to 
other applications. Usually the Paste Special menu item in 
those application will let you paste a bitmap to that 
application. 

Copy All of Hierarchy to Metafile  Allows complete graphics 
transfer to other applications. CDP saves all the hierarchy 
structure to a Windows Metafile. CDP opens the Save File As 
dialog so you can save the windows metafile it generates. 
Usually an Insert Picture menu item in other applications will 
let you import the high quality graphic. 

Delete Selection  Deletes selected block. 

Find Block  Goes to the identified block. 

Note: The following two menu items are available when the Hierarchy 
is in Graph view only. 

Delete Selection Deletes selected block. 

Find Block  Goes to the identified block. 

Note: The following menu items are only available when the 
Hierarchy is in Data or Priorities view. 
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Copy  Copies data in selected spreadsheet cells to Windows 
Clipboard. 

Copy All of Hierarchy to Metafile  Copies all data in file for use in 
other applications. See above. 

Paste  Pastes data in Windows Clipboard to selected spreadsheet 
cells. 

Paste Link  A block of cells containing ratings information of 
alternatives, may be imported from a spreadsheet that supports 
DDE links into the Data View of the Hierarchy. See the 
section, “To Create a DDE Link to the Hierarchy 
Spreadsheet,” in this chapter. 

Select All  Selects all spreadsheet cells. 

View   

Hierarchy Data  Puts Hierarchy model into spreadsheet format 
where you can also edit the information. 

Hierarchy Priorities  Same as Data View but also includes the 
priority values for each connection. Very useful for 
understanding how the model calculates decision scores. 

Hierarchy Graph  Puts Hierarchy model in graphical form. This is 
the default view.   

Note: The following menu items are available when the Hierarchy is 
in Graph view only (default view).  

Hide Connections to Alternatives  If you check this item, CDP 
displays the hierarchy model without the lines connecting the 
lowest level to the alternatives. Uncheck to reverse. 

Show Missing Connections  In general, all alternatives should be 
connected to all lowest criteria. If you check this item, CDP 
displays the hierarchy model with only missing connections 
from lowest criteria to the alternatives in a lurid color. Uncheck 
to reverse. 
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Connect All Alternatives  A useful item that will fully connect all 
criteria in the lowest level to all alternatives. 

Show Accumulated Weights  Displays the accumulated weight of 
each block (criterion and alternative) in the block, preceding the 
name. Level widths are automatically adjusted to allow for these 
accumulated weight values. The accumulated weights are 
dynamically maintained as the Hierarchy is edited. See the 
subsection, “Enhanced Decision Hierarchy Views,” in this 
chapter. The default state is off. 

Show Unrated Blocks Highlights, in Green, any block where all of 
its children have not been rated. The default state is off.  

Show Disconnected Blocks  Highlights, in Red, any criterion not 
connected (however remotely) to the Goal and at least one 
alternative. The default state is off.  

Arrange Blocks  Arranges blocks so that the main display shows the 
first level parents centered in front of its family. This means 
some parents are then spaced so far apart that they are out of 
view in your window. (See Glossary, Family Centered Views, 
for illustration.)  

Resize Level Widths  Adjusts the widths of all the levels to 
accommodate the longest block name in each level.  

Navigator  Displays the Navigator window on the left side. Shows a 
small version of your entire Hierarchy model. (See the “Use 
Navigator to View Large Models” section in this Chapter)  

Note: The following two menu items are available in each of the three 
views.  

Show Toolbar  Displays graphical toolbar of select menu commands. 

Show Toolbar Detail  Displays brief written description of menu 
commands in addition to graphical toolbar format. 
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Block 

Edit Name/Notes  Displays the Notes dialog box to change the name 
and notes of the highlighted block. (Or, highlight block and 
press CTRL+N)  

Delete Notes  Deletes notes associated with the highlighted block.  

Insert Block Above  Creates a new, disconnected block above the 
highlighted block. Moves all blocks down beginning with the 
highlighted block. 

Insert Block Below  Creates a new disconnected block below the 
highlighted block. Moves all blocks up beginning with the 
highlighted block. 

Duplicate Block  Makes a new block with the same connections 
(parents and descendants) above or below the highlighted 
block. 

Delete Block  Deletes the highlighted block, but maintains any 
connection between its parent and descendants. 

Rate Subcriteria  Displays the ratings window to rate the subcriteria 
or alternatives of the highlighted block. (See “Weight the 
Criteria” in the next chapter.) 

Link Block  Allows you to select and link other models to the new 
block you created. Various restrictions apply. 

Duplicate Branch  Allows you to copy a selected branch of the 
model. 

Delete Branch  Allows you to delete a selected branch of the model. 

Level 

Level Notes  Displays the level Notes dialog box where you can 
change the name or notes of the highlighted level. 

Insert Level  Puts a new level heading and column to the left of the 
highlighted level. 
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Delete Level  Deletes the highlighted level heading and all blocks in 
that column. 

Model 

Options 

Environment (submenu): sets the display defaults for the program.  

New Model (submenu): sets defaults for a new hierarchy model 
when it is first created. These settings can then be modified to 
suit the particular model, and are then saved with that model.  

Model Notes  Displays the model Notes dialog box where you can 
change the name or notes describing the model. 

Information  Displays the Information window, allowing you to 
view all notes in the model at a glance (and copy for export). 

Profile  Lists model statistics.  

Unrate  Allows you to reset to “unrated” the values of the Weights - 
If using  Weights Hierarchy Technique, clicking this item 
reverts all weights of subcriteria to unrated. If using Direct 
Tradeoffs Hierarchy Technique, sets all tradeoffs’ values as 
unrated. USE WITH CARE! 

 Scores - The ratings of all Alternatives against all lowest 
criteria. USE WITH CARE! 

Equalize all Weights (Tradeoffs) If using Weights Hierarchy 
Technique, sets all weights of subcriteria to the scale average. 
If using Direct Tradeoffs Hierarchy Technique, sets all 
tradeoffs’ values to 1. 

Technique - Alternatives  Selects one of the following decision 
methodologies. 

 AHP  Selects the Analytical Hierarchy Process. 

 SMART  Selects the Simple Multiattribute Rating Technique. 
This is now the default option.  

Technique – Hierarchy  Selects one of the following methodologies.  
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 Weights  Selects weights. This is the default option.   

 Tradeoff   Selects tradeoff . 

Note: Choosing an option in the following two menus opens a Results 
or Analysis window. If the model is not fully connected (see 
Glossary), results can not be calculated and a dialog will appear 
inviting you to move directly to connect the offending block(s). 

Results   

Decision Scores  Shows how the weights are distributed in your 
decision model. This option is discussed in the “Review 
Results,” chapter. 

Uncertainty in Decision Scores  Shows the uncertainties in the 
decision scores of the alternatives due to the uncertainties in 
their ratings. 

Analysis 

Sensitivity by Weights  Shows how sensitive the decision is to 
changes in the criteria weights. This window is discussed in 
the chapter, “Check Reasonableness and Analyze.” 

Contributions by Criteria  Shows how the breakdown of the 
decision scores in terms of contributions from criteria. This 
window is discussed in the chapter “Check Reasonableness 
and Analyze.” 

Alternatives Scatter  Opens the Alternatives’ Scatter Plot analysis 
window. This window is discussed in the chapter “Check 
Reasonableness and Analyze.” 

Tradeoffs of Lowest Criteria  Shows how the various lowest criteria 
are being traded off against each other. This window is 
discussed in the chapter, “Check Reasonableness and 
Analyze.” 

Contributions to Uncertainty  Shows how the uncertainties in the 
individual rating of an alternative contribute to the uncertainty 
in that alternative’s decision score. This window is discussed 
in the chapter “Select Uncertainty.” 
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Group Tag Level  This area allows you to select a level (or none), 
the names of whose criteria will prefix the names of all criteria 
in levels below that tag level. The First Letter Only checkbox 
allows you to choose to use only the first letter of the criteria 
names in the tag level as prefixes for lower criteria names.  

Tag by First Letter Only  The First Letter Only checkbox allows you 
to specify that only the first letter of the criteria names in the 
tag level are used as prefixes for lower level criteria names. 

The Hierarchy Windows Toolbar 

The Hierarchy window has its own specialized toolbar. 

The basic icons, left to right, are: 

12. New Hierarchy icon. Asks if you wish to save current hierarchy, 
then creates (empty) new one. 

13. Open Hierarchy icon. Asks if you wish to save current hierarchy, 
then opens the file browse dialog. 

14. Save Hierarchy icon. Saves the current hierarchy model. If the 
model is new and has not been saved, opens Save As file dialog. 

15. Print Icon. Brings up the Print Dialog window. 

16. The Print Preview icon. Brings up the Print Preview of whatever 
window you are in. 

17. Snap Picture Icon. Builds a graphic of entire Hierarchy, then 
opens Save As file dialog so you can name and save as Windows 
Metafile (*.wmf). 

18. Undo icon. Active when user has undertaken major editing action 
in Hierarchy. If clicked, will restore decision model to state before 
edit. 
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19. Navigator icon. Opens it. 

20. Options icon. Opens the default Options dialog. 

21. Rate Criterion icon. If valid criterion is selected, opens Rating 
window. 

22. Decision Scores window. Opens it. 

23. Help icon.  Brings up context sensitive online Help. 

Hiding Toolbar icons and/or text 
As usual, checking the menu item Show Toolbar on the View menu determines 
whether the toolbar is visible or not.  If the toolbar is visible, checking the Show 
Toolbar Detail determines whether the text label appears under each toolbar icon. 

 

What’s Next? 

When you’re comfortable with your model, and you feel you have 
included all or at least most of the elements you need in your model, 
you can begin rating your criteria and alternatives. The next chapter, 
Chapter 10, Weight the Criteria, describes how to rate each criterion 
using several rating methods. Chapter 14, Document the Results, 
describes how to print individual items and full customized reports 
from your decision model. 
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Rate the Model as Part of the Decision Process 

Where are you?  You are in the shaded part of the Process Diagram 
below: 

   

 

Process Diagram

Brainstorm 
the Problem

Build the 
Hierarchy

Rate the Hierarchy

Review the Results

Analyze the Results

Document 
the Results

Select Uncertainty
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Now that you’ve built your Hierarchy, you need to assign relative 
weights to the criteria and score the alternatives. In DecisionPlus, this 
is called rating the model. You perform this rating in sets, by selecting 
a parent block and rating all its subcriteria or alternatives with respect 
to each other. These sets are called rating sets. 

The steps involved in rating a rating set are as follows: 

1. Choose a Rating Set 

2. Decide on a Rating Method 

3. Establish a Rating Scale  

4. Enter the Ratings 

The following sections will walk you through each step. First, you 
need to decide which rating techniques to use for your decision 
hierarchy and alternatives. 
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Overview of Rating Techniques  

The criteria against which the alternatives are rated are called lowest 
criteria. No matter how complex the hierarchy, the basic algorithm in 
multicriteria decision analysis is to multiply how each alternative 
scores against each lowest criterion by the relative importance of that 
lowest criterion. If those products are then summed over all lowest 
criteria to provide an overall decision score, the score serves as a 
measure of how well that alternative fits your decision model.   

 

CDP provides you with two decision analysis techniques each to 
establish the relative importance of the lowest criteria and to rate 
alternatives against those lowest criteria. 

 
         Alternatives Rating Technique: AHP or SMART 
 

 
Hierarchy Rating Technique: Weights or Direct Tradeoffs 

 

Hierarchy Technique - Establish the relative importance of 
criteria. 
You have two techniques at your disposal to establish the relative 
importance of criteria: weights and direct tradeoffs.   
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Hierarchy Rating Technique - Weights 

Using the Weights technique you assign the relative importance of 
each subcriterion with respect to the other subcriteria of a given Goal 
or parent criterion. You might start at the Goal, relatively weight each 
of the criteria directly beneath the Goal, then repeat this for every 
criterion with subcriterion in the model. Once this is done, CDP takes 
care of multiplying these preferences down the structure of the 
hierarchy, so that all the criteria against which the alternatives will be 
rated, the lowest criteria, will have acquired a relative importance 
respect to all other lowest criteria.     

Hierarchy Rating Technique – Direct Tradeoffs 

We’ve just seen how you can establish the relative importance of the 
lowest criteria by establishing preference weights at all nodes in your 
decision hierarchy of criteria. Another way to establish the relative 
importance of the lowest criteria is by directly setting their relative 
tradeoffs. 

In any difficult decision, many of the decision objectives conflict – 
consider the common desire to have the highest quality at the lowest 
price. The essence of the multicriteria decision is the tradeoff between 
those objectives, and this is most easily measured by the numerical 
tradeoffs between the lowest criteria, which provide metrics for those 
objectives. For instance you may feel that a reasonable tradeoff 
between cost and schedule for a construction proposal might be 
$100,000 for one month. Here you may be expressing your preference 
by saying that you would be willing to pay $100,000 to avoid a 1 
month delay in a particular project. If you proceed to make such 
tradeoff judgements pair by pair until all lowest criteria have been 
traded against each other, you will have succeeded in establishing the 
relative importance of all lowest criteria in your model. 



Chapter 10  Weight the Criteria 

Criterium DecisionPlus 161 

 

Interchangeability between Hierarchy Techniques  

Mathematically, if you know both the scales and the relative 
importance of the lowest criteria, you can calculate the tradeoffs. 
Conversely, if you know the scales and the tradeoffs, you can, with a 
few reasonable restrictions, calculate the relative importance of the 
lowest criteria (by uniquely determining the weights at every level of 
the hierarchy). CDP takes care of all the details, so providing the 
scales are unchanged, you can back and forward between weights and 
tradeoffs. You can calculate the tradeoffs as determined by the 
Weights technique, or, based on direct tradeoffs you assign, calculate 
the corresponding weights.  Changing from one method the other, 
providing some simple conditions are met, will not change the relative 
importance of the lowest criteria in your model.  (See the next section, 
Selecting the Hierarchy Ratings Technique for details of those 
conditions.) 

 

Note:  Those of you who have used the 
Analytical Hierarchy Process may never 
directly have developed scales.  That is 
because the pairwise comparison approach 
creates relative scales based on the 
alternatives you are rating. 

Scales

TradeoffsWeights
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Choosing the Hierarchy Rating Technique:  Weights or 
Direct Tradeoffs? 

Comparison of the two Hierarchy techniques 

So what is the difference between the two approaches? Numerical 
tradeoffs have the great advantage in that you can compare their values 
to company and industry norms, and they can be compared (with care) 
to published research. Saying that schedule is more important to you 
than costs leaves many questions unanswered and provides little 
opportunity for quantification or validation.   

On the other hand, asking stakeholders to provide a direct tradeoff 
value can be intimidating. They may not understand what you mean by 
a tradeoff, or they may not be familiar enough with the decision space 
to hazard a good estimate, or both. The first you can tackle through 
training, the second through research. Both require time and resources.  
Furthermore, if many of your lowest criteria are qualitative in nature, a 
tradeoff such as 1 unit of Reputation for 3 units of Quality may be 
meaningless and hard to assess. 

But for hundreds of years, people have made decisions that involve 
directly weighing the importance of one criterion against another, and 
deciding on that alternative that does best against the most important 
criteria. The Hierarchy Weight technique may thus provide a more 
intuitive approach when many of the lowest criteria are qualitative in 
nature, or your decision-makers are uncomfortable providing tradeoff 
judgements. 

Making the Choice of Hierarchy Rating Technique 

To summarize, our view is that if meaningful, quantitative scales are 
available for the lowest criteria and your decision makers are able to 
provide tradeoffs, then using a direct tradeoffs approach will likely 
provide a more accurate and persuasive decision analysis.  
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Starting with Weights, moving to Direct Tradeoffs 

If you or your fellow decision makers are unfamiliar with tradeoffs or 
are starting on a totally new decision opportunity whose criteria are 
only being developed, you may want to start using the Weights 
technique, then use the Tradeoffs Analysis window to familiarize all 
with tradeoffs.   

Once you have got to the point of developing a reasonable percentage 
of scales as quantitative, and you decision-making group is ready, 
convert your model to the Direct Tradeoff Rating technique. 

%Quantitative LC Scales

Decision
Makers’
ability to
generate
Direct
Tradeoffs

Direct
Tradeoffs

Weights
(Derive

Tradeoffs)
Weights

Weights

%Quantitative LC Scales
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Selecting the Direct Tradeoffs Technique 
The following steps describe how to select your underlying Hierarchy 
Rating Technique (Weights or Direct Tradeoffs). 

1. In the Hierarchy window, from the Model menu, select Technique 
- Hierarchy. Two submenu items appear, one labeled Weights, the 
other Tradeoff.  There is a check mark to the left of the menu item 
corresponding to the technique that is currently in effect. The default 
Technique in Version 3.0 is set to Weights. 

2. Select Weights or Tradeoffs menu item.  

When changing from Weights to Tradeoffs, the system uses the first 
available reference lowest criterion (unless you had been using 
tradeoffs earlier, in which case CDP will use whatever tradeoffs set 
you last employed, provided that tradeoff set is still valid). CDP will 
message you as to which reference criterion it is using.   

 
Note: CDP will not let you convert from Weights to Direct Tradeoffs 
if your model contains any criteria that: 

• Are subcriteria of more than one other criterion. 

• Are rated with respect to their parent block at the minimum scale value (e.g., 0 
on the Default numerical scale). See the section in this chapter entitled Rules 
Only Criteria for how to preserve criteria you only included in the model to 
support a rule.  

When changing from Tradeoffs to Weights, there will be no visible 
changes in the Hierarchy window, but the Technique tray in the status 
bar will (within a few seconds) now show the word “Weights.” 
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Choosing Alternatives Rating Technique:  SMART or 
AHP? 

Before you begin rating your Alternatives, you should select the 
Analytical Hierarchy Process (AHP) or the Simple Multiattribute 
Utility Technique (SMART) to use as the alternative’s rating 
technique in your decision model. The default technique in Criterium 
DecisionPlus is SMART. DecisionPlus uses SMART unless you select 
AHP or unless you load a file previously saved using AHP. For 
instructions on selecting and using SMART or AHP, see “Selecting 
the Alternatives Rating Technique: AHP or SMART,” below. 

Normalization 

Before you can synthesize the contributions of criteria with differing 
scales, the decision model must provide a method that allows you to 
handle your differing model scales on an equal footing. For example, 
if a decision in the health care field were measuring in dollars and 
human lives in the same model, you would need to know at what 
dollar value a human life is being evaluated. In both AHP and 
SMART, the alternatives rating technique itself handles this problem 
for you. This is achieved by a process called normalization (see 
Glossary), where all scales are converted to a common internal scale 
that takes a value between 0 and 1. 

Normalization in AHP 

In AHP, using a Direct Rating method, to get the effective importance, 
or priority, of a subcriterion, you take its user-given score divided by 
the sum of the scores of all the other subcriteria of the common 
criterion. This guarantees that no matter what the original score, all 
weights will fall between 0 and 1. 

This is a very simple and effective method that allows you to 
synthesize units that are completely different. However, it's clearly a 
relative judgment method. How a particular alternative scores in the 
model depends on what other alternatives are being considered. For 
instance, in AHP, if you created a model for one set of alternatives, 
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adding a new alternative later will change the scores of the original 
alternatives, sometimes in surprising ways (see Rank Reversal 
Phenomena when Using the AHP in Chapter 10). 

Normalization in SMART 

SMART doesn't use a relative method for scaling your units to a 
standard scale (from 0 to 1). Instead, you can define your own method 
for doing this using a value function. A value function allows you to 
explicitly define how each value on your scale is transformed to the 
common model scale. DecisionPlus provides three value functions in 
determining the ratings for the attributes: a linear function, an 
exponential function, and a piecewise linear function (see Using 
SMART in Chapter 10). A great amount of research has been done in 
determining the most appropriate value functions for a given decision 
problem (see References). The value functions in DecisionPlus 
provide sufficiently broad choices for you to make a quality decision. 

Suggested Guidelines for use 

We hope that the ability to apply both techniques within the same 
package will promote much research on the relative merits of the two 
approaches.  (Most real-world models we have tested give the same 
ranking of Alternatives whether SMART or AHP is used.)  In the 
interim, our tentative guide as to which technique to use is as follows: 

AHP: The simplicity of model building in AHP suggests its use 
where possible. If it is unlikely that no new alternatives will 
need to be introduced beyond the set under consideration then 
rank reversal will not be such a problem. However, even in 
that case, if the majority of data available is quantitative, and 
particularly if there is known uncertainty in that data, SMART 
may provide an easier to understand and more powerful 
decision model. 

SMART: If new alternatives are likely to be added to the model 
later, and most of the lowest criteria are amenable to a 
direct rating approach (not so qualitative as to require 
pairwise comparison), then SMART is a good choice. 



Chapter 10  Weight the Criteria 

Criterium DecisionPlus 167 

Models rated using the AHP technique can exhibit a controversial 
anomaly called Rank Reversal, which you should be aware of.  As a 
description of this effect requires some knowledge of how decision 
scores are calculated, please refer to the section “How Decision Scores 
are Calculated” in Chapter 12. 

Some Differences Between SMART in CDP and AHP 
The terminology used in SMART is different than that used in AHP.  
DecisionPlus adheres to this tradition. In SMART, the lowest criteria 
are called attributes. The numerical values assigned to these attributes 
are derived from value functions and are called ratings. 

The structure used to model the decision problem in SMART is called 
a value tree, or objective hierarchy. The difference between a SMART 
value tree and an AHP hierarchy is that the value tree is a true tree 
structure, allowing one subcriterion to be connected to only one higher 
level criterion. In AHP, you can connect a subcriterion to more than 
one higher level criterion. If you select SMART, DecisionPlus does 
not force you to adhere to a true tree structure and calculates the model 
based on the criteria and weights you assign. DecisionPlus also 
requires you to define the alternatives and to connect them to the 
attributes. 

DecisionPlus treats most of the SMART model the same way it treats 
the AHP model. Weighting the criteria is the same as we described 
earlier in this section. The difference occurs at the attribute level 
where you normalize, or tradeoff, the scoring of alternatives against 
different attributes. The value functions used in this process result in 
the creation of numerical values, or priorities. 

Selecting the SMART Technique 
The following steps describe how to select your underlying 
alternatives rating technique (AHP or SMART). 

1. In the Hierarchy window, from the Model menu, select Technique.  
Two submenu items appear, one labeled AHP, the other SMART.   
There is a check mark to the left of the menu item corresponding to the 
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technique that is currently in effect. The default Technique in Version 
3.0 is set to SMART. 

2. Select AHP or SMART.  

No visible changes occur in the Hierarchy window, but if there are 
Results or Analysis windows open, you may see some change in the 
results data, and you will see that the titles of those Windows will 
display AHP or SMART as appropriate. 

 Choosing A Rating Set 

The actual rating in DecisionPlus is performed through the Criterion 
Rating window. 

Displaying the Criterion Rating Window 
1. On your Hierarchy window, click once on the goal block of your 

decision model.  

Note:  You can select any block: you do not have to begin 
with the Goal. However, because the most important criteria 
of your decision are those connected directly to the Goal, it is 
often a good idea to begin your ratings with those. 

2. From the Block menu, select Rate Subcriteria.  

 Tip:  A quick way to select the Rating window is to double-click 
on the block whose children you want to rate, or Right Click the 
block and select Rate Subcriteria. 
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Criterion Rating Window Description 
Your goal name appears in the Criterion box near the top of the 
window. About one third the way down the window, the children of 
the goal are listed. This area displays the rating set you selected. A 
new menu bar appears at the top of your window with the menus 
Method, View, Rules, Options, Uncertainty (Uncertainty is light gray 
and unavailable until your model is rated or until you select a lowest 
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criterion whose subcriteria are alternatives). When you first display the 
Rating window, the Direct Comparison method is active. By clicking 
on the Method menu or View menu, you are able to see which Options 
are currently in effect. Selected options are preceded by a check mark.  

• SMART If you are using the SMART technique, the Rating 
window displays the title “SMART Criterion Rating - Direct 
Method” (see “Using SMART and AHP” later in this chapter).  

• AHP If you are using the AHP technique, the Rating window 
displays the title “AHP Criterion Rating - Direct Method.” 
(Direct is the default rating method.)   

If you want to use AHP and have not selected AHP, turn to the section 
on “Choosing the Alternatives Rating Technique: AHP or SMART?” 
in Chapter 9, for steps to change the Alternatives Rating Technique to 
AHP. 

Criterion List displays the name of the parent block you highlighted. 
You are rating the subcriteria or alternatives of this block. The List 
may be ordered in a number of ways, but the default is by the 
importance of each criterion to the overall model. See the section, 
Selecting the Next Rating Set, later in this chapter. 

Next Button  You can click this Next button to choose the “next” 
criterion listed in the Criterion List. The exact behavior under Next is 
determined by the Next Button Action submenu setting under the 
Options menu.  The default Action is “First Unrated Criterion,” 
namely clicking the Next button will cause DecisionPlus to jump in 
the Criterion List from the present position to the first unrated criterion 
in the list. See the section, Selecting the Next Rating Set, later in this 
chapter.  

Note:  If you prefer, you can select the next rating set by closing 
the Criterion Rating window, selecting a criterion in the hierarchy 
and returning to the rating window. 

Notes Button Accesses the Notes box where you can enter notes about 
the criterion whose rating set you are considering. 
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Descriptive Sentence This box describes the rating logic as it relates 
to your goal. It uses the wording of the verbal scale you select to 
describe how one subcriterion rates against another subcriterion. When 
you select a different verbal scale, or change ratings, the wording in 
your descriptive sentence also changes. This is a verbal display, so if 
you turn off the Verbal scale view, the descriptive sentence 
automatically turns off. 

  
Scale Information The units of measurement and the range of those 
measurements you select are displayed in this box. In our illustration, 
we are using the units in the Default scale, which has a range of 
0.00/Worst to 100.00/Best. Individual criterion ratings must be 
between those numbers. You can choose a different scale from a list of 
existing sales or design and assign a customized scale of your own. 

  
Subcriterion/Weight Box The children of the parent block you 
highlighted are listed here. When you first display the Rating window, 
all the viewing options appear on the window, but they are either 
blank or “UNRATED” until you rate the children. 
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When you reach any lowest criteria to rate, the headings in this box, 
Subcriterion/Weight, change to Alternative/Score as illustrated 
below. 

  
Restore Ratings When you edit ratings, you can use this button to 
restore your rating set back to its original ratings. It only restores the 
ratings of the particular rating set you are editing.   

Value Function If you are using SMART and are weighting a lowest 
criterion, a button will be visible to the left of the Restore Ratings 
button. This button allows you to define a Value Function for the 
parent criterion - see the section Assigning a Value Function in this 
chapter.  

OK When you are finished entering new ratings, or updating old 
ratings, entering or updating rules, or assigning new or creating new 
scales, select this button to accept your current rating entries. 

Cancel Select this button to cancel rating entries, scale changes, rules 
entries, or uncertainty distributions assigned since you opened the 
Criterion Ratings window. 

Information You can access an alphabetical list of your criteria, and 
any attached notes. You can edit notes from this widow by double-
clicking on the notes or click the Edit button (see description in 
Chapter 10). 

Help Select this button to display information and instructions for the 
Rating window. 
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Choosing a Rating Method in Weights Technique 

We provide three methods you can use in rating your model. They are 
Direct Comparison, Full Pairwise Comparison, and Abbreviated 
Pairwise Comparison.  

Direct Comparison 
This is a good method to use if you feel confident that you can rate 
each element of the rating set directly against an objective scale. Your 
information may come from a detailed understanding or experience 
with factors in your decision problem. Or, your information may come 
from an analysis that provides data you can assign in a direct rating. 

Full Pairwise Comparison 
Pairwise comparison means comparing in pairs. You may find this 
method useful if you have an intuitive feel for how the elements rate 
with respect to each other, but lack any objective yardstick against 
which you could directly measure them. 

This method rates each element in turn against all the elements within 
its rating set. Your subjective judgment or intuition is all you need to 
determine how one subcriterion compares to another. In our example, 
we would rate the subcriteria of Performance (Acceleration and 
Braking) against each other.  

Note:  Pairwise Comparisons become impractical as the 
number of elements being compared increases. If there are 
more than 20 elements to be rated, neither the Full nor 
Abbreviated (see below) Pairwise Methods will be available to 
you.  

Abbreviated Pairwise Comparison 
This method is an approximation to Full Pairwise Comparison that 
skips some comparisons. This method is based on the assumption that 
if A is x times better than B, and B is y times better than C, then A is 
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x*y times better than C. The comparison of A to C is then not 
necessary. 

Choosing the Rating Views 

We provide three views in which you can enter your ratings: 
Numerical, Verbal, and Graphical. You can enter a number in the 
Numerical view that is within the range of the scale you assign. You 
can select a word or a phrase in a Verbal view to describe how a 
criterion is rated. Or, you can adjust a horizontal bar on the Graphical 
view to show graphically how a criterion rates.  

When you adjust a rating in one view, such as Numerical, the other 
two views immediately adjust to reflect the same value within its own 
scale. You can display one or all three of these views in your Criterion 
Rating window at the same time. 

  
Numerical View: In the Direct Comparison method, you can assign 
one of five different numerical measurements, each with its own 
numeric range. Or, you can create a customized numerical scale of 
your own. In the Pairwise Comparisons, there is only one numerical 
fixed range that shows how one criterion rates against another on a 
scale of eight above or eight below a midpoint 

Verbal View: In the Direct Comparison method, you can assign one 
of six different verbal scales, each with its own verbal range. Or, you 
can create a customized verbal scale of your own. In the Pairwise 
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Comparisons, there is only one verbal fixed range that describes how 
much better or how much worse one criterion is than another. 

Graphical View: You’ll find this view is useful when you are 
conducting a “what if” analysis to see how a different value affects the 
results. Because this view visually illustrates the rating, there are no 
additional measurements from which to select. 

 

Assigning Scales in Direct Comparison 

If you already have rating values to assign, you can use the Direct 
Comparison rating method. The Numerical, Verbal, and Graphical 
scales are available with the Direct Comparison. Once you select the 
verbal or numerical views you want, you can enter the values directly 
in the Subcriterion/Weight box. 

• In the Criterion Rating window, select Direct from the Method 
menu. (Direct is usually the default, indicated by a preceding 
check mark, when you display the Rating window for the first 
time.) 

Assigning a Numerical Scale in Direct Comparison 
The Default scale is a measurement that may be used frequently. 
However, you can select a scale that represents your decision criteria 
more closely. We provide five scales, each with different units of 
measurement, from which you can choose. The scales described below 
are displayed in the list box with a padlock graphic to indicate that 
they cannot be modified or erased. 



Chapter 10 Weight the Criteria 

176 Criterium DecisionPlus 

 

 Scale 

 Default 

 Rank 

 Percent 

 0-10 

 Probability 

 

 
Measurement 
0.00 - 100.00 

Last to First 

0.00 - 100.00 

0 - 10 

0.00 - 1.00 

 

Display the Assign Scales Window 
To assign a numerical scale other than the default scale, access the 
Assign Scales dialog. The Assign Scales Dialog allows you to assign, 
create and maintain your scales. 

1. In the Criterion Rating window, select the Assign Scale button. 
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Choose and assign a numerical scale 
1. In the Assign Scale window, for Scale Type, select Numeric. 

2. In the Scale Information box, click the drop-down menu arrow to 
display a list of scales. 

3. Select the scale you want from the list of scales. 

4. Select the Close button to assign the scale to the current rating set. 

If the current rating set is already rated, you will get a message asking 
if you want to change your current values to correspond to the scale 
you just selected.  

Create a Customized Numerical Scale in Direct Comparison 
You can create a numerical scale of your own that uses a unit of 
measurement better suited to your decision problem. This is again 
accomplished through the Assign Scale window.  

1. In the Criterion Rating window, select the Assign Scale button. 

2. In the Assign Scale window, for Scale Type, select Numeric. 

3. Select the New button at the bottom of the Assign Scales window 
to display the Add Scale box. 

4. In the Units Name block, type the name you want to give this 
scale. (It is usually related to the units of measurement you create.) 

5. For Best Value, type a number representing the best of your scale. 

6. For Worst Value, type a number representing the worst of your 
scale. 

7. Select the OK button. Your new scale is now recorded. You return 
to the Assign Scale dialog. 

8.  In the Assign Scale dialog, choose Close to assign the scale to the 
current rating set. 

If the current rating set is already rated, and you select your new scale, 
you will get a message asking if you want to change your current 
values to the scale you just selected.  
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Assigning a Verbal Scale in Direct Comparison 
The default scale is called Importance. It allows you to determine a 
weight by selecting from a group of words ranging from Trivial to 
Critical. However, you can select a scale that represents your 
judgments more closely. We provide six scales, each with different 
units of measurement, from which you can choose. The scales listed 
below are displayed in your window with a padlock graphic to indicate 
that they cannot be modified or erased. 

 

 Scale 

 Importance 

 Frequency 

 Yes/No 

 Quality 

 Degree 

 Grades 

 

Measurement 
Critical to Trivial 

Always to Never 

Yes to No 

Finest to Unsatisfactory 

Maximum to Minimum 

A to F 

 

Choose and Assign a Verbal Scale Window 
To assign a Verbal scale other than the default scale, access the Assign 
Scales window. 

1. In the Criterion Rating window, select the Assign Scale button. 

2. For Scale Type, select Verbal. 

3. In the Scale Information box, click the drop-down menu arrow to 
display a list of scales. 

4. Select on the scale you want. 

5. Select the Close button to assign the scale to the current rating set. 
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Create a Customized Verbal Scale in Direct Comparison 
You can create a verbal scale of your own that uses verbal graduations 
better suited to your environment or decision problem. This again is 
accomplished through the Assign Scale window.  

1. In the Criterion Rating window, select the Assign Scale button. 

2. In the Assign Scales window, for Scale Type, select Verbal. 

3. Select the New button at the bottom of the Assign Scales window 
to display the Add Scale box. 

4. In the Scale Name block, type the name you want to give this 
scale. 

5. In the Most Desirable list box, begin typing names representing 
the best of your scale to the worst of your scale. 

 Tip:  To create a n effective scale, enter an odd number of 
graduations so one will act as a midpoint, and try to make sure that 
items in your weighting set will take values across the full scale. 

6. To edit a measurement name, select a name from the list, select the 
Edit button (or double-click the name), and make your changes. 

7. To move a measurement name to another position in the list, drag 
and drop the name into the position you want. 

8. To delete any measurement names, highlight the name and select 
the Delete button. 

9. Select the OK button when you are finished creating your new 
scale. 

Assigning a Graphical Scale in Direct Comparison 
DecisionPlus has only one graphical scale. There are no options for 
selecting or creating a different one. The scale’s implicit range is from 
0 to 100. 
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Entering Ratings in Direct Comparison 

Once you assign the rating scales you want, you can begin rating the 
elements (subcriteria or alternatives) in your rating set. You can 
change rating scales at any time. For instructions on changing rating 
scales, see the instructions for assigning various scales in the 
preceding pages for the rating method you are using. 

Enter Ratings in the Subcriterion/Weight Box 
As we illustrated earlier in this chapter, the actual rating takes place in 
the Criterion Rating window. When you close the Assign Scales 
window, the Criterion Weighting window is updated with your 
assigned scales. You can display all three viewing methods, or only 
one or two. 

Rating in the Numerical Scale 
1. In the Criterion Rating window, from the View menu, select 

Numerical if it is not already selected. 

2. Click once in the blank rectangle next to the first criterion to insert 
a blinking cursor. (In our example, this is Performance.) 

3. Type in your rating, including decimals if needed. (In our 
example, we type in 80.00 for Performance.) 

 When you enter a rating in any one of the three scales for that 
criterion, the other two scales adjust their displays to reflect the 
equivalent value within their own scale. (In our case, 80.00 
represents Critical in the Verbal scale, and a red bar just about the 
full length of the bar graph.) 

4. Press ENTER to move to the blank rectangle next to the second 
criterion. 

5. Type in your rating, including decimals if needed. (In our case, we 
type in 60.00 for Cost.) 
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6. Repeat steps 4 and 5 and enter the ratings for the remaining 
unrated criteria. (In our case, we type in 50.00 for Style, 30.00 for 
Resale Value.)   

 You’ll notice that ratings of 50.00 and 60.00 are both represented 
by the same verbal measurement.  

To Turn Off the Numerical Scale Display 
• From the View menu, select Numerical.  

Rating in the Verbal Scale 
Another way to enter your ratings is to select from the Verbal drop-
down menus. 

1. In the Criterion Rating window, from the View menu, select 
Verbal if it is not already selected. 

2. Click once on the drop-down menu for your first criterion to 
display a list of verbal measurements. 

3. Select the word that best represents how you would rate this 
criterion. 

4. Repeat steps 1 and 2 for the remaining criteria. 

To Turn Off the Verbal Scale Display 
• From the View menu, select Verbal.  

Rating in the Graphical Scale 
Of course, if you prefer you can simply adjust the bar on the Graphical 
scale. 

1. In the Criterion Rating window, from the View menu, select 
Graphical if it is not already selected. 

2. Hold your cursor down on the bar next to your first criterion and 
drag to the point you want the red bar to end.  

3. Or, you can just click at the point you want the red bar to end. 
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 Tip:  As a guide, you can watch the values change on the other 
two scales as you adjust the bar. 

To Turn Off the Graphical Scale Display 
• In the Criterion Rating window, from the View menu, select 

Graphical.  

Entering Ratings in Full and Abbreviated Pairwise 
Comparison 

We mentioned earlier in this chapter that pairwise comparison means 
comparing items one against another. Even when no objective scale 
independent of your subcriteria or alternatives exists, your well-
developed intuition allows you to make effective one-to-one 
comparisons. The Pairwise Comparison method facilitates such 
judgments by providing a range of 9 verbal increments and 9 
numerical intervals that you can use to estimate how much better, 
important, etc., one criterion or alternative is over another. 

Both the Full Pairwise Comparison and the Abbreviated Pairwise 
Comparison rating methods use the following numerical and verbal 
measurements: 
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       DOS 
Standard AHP  DecisionPlus   Criterium 

  9  9  Absolutely Better   +9 

  8  8  Critically Better    +8 

  7  7  Very Strongly Better   +7 

  6  6  Strongly Better    +6 

  5  5  Definitely Better   +5 

  4  4  Moderately Better   +4 

  3  3  Weakly Better    +3 

  2  2  Barely Better    +2 

  1  1  Equal     ±1 

1/2  <>Barely Worse    -2 

1/3  <>Weakly Worse    -3 

1/4  <>Moderately Worse   -4 

1/5  <>Definitely Worse   -5 

1/6  <>Strongly Worse   -6 

1/7  <>Very Strongly Worse   -7 

1/8  <>Critically Worse   -8 

1/9  <>Absolutely Worse   -9 

 

The "<>" symbol indicates that you reverse the order for these 
comparisons: B is better than A rather than A is worse than B. 

The Subcriterion/Weight box changes slightly to accommodate the 
comparisons. In the Full Pairwise Comparison, each criterion is 
compared with another criterion in the same rating set.  
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The "switch" button   reverses the order of comparison. 

Consistency Ratio 
One of the strengths of Pairwise Comparison ratings as developed by 
Professor Saaty (see References), is that it helps you remain consistent 
in determining the comparison between criteria. You might decide that 
apples are tastier than pears, while pears are tastier than oranges, but 
that oranges are tastier than apples.  Clearly this is an internally 
inconsistent set of pairwise comparisons. The consistency ratio, 
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appearing in the lower left hand corner of the Criterion Ratings 
window,  was invented by Professor Saaty as a measure of consistency 
and is calculated directly from your individual pairwise comparisons 
over the entire rating set. When the  Consistency Ratio is larger than 
0.10,  the general wisdom is that your comparisons may be 
inconsistent. 

 

Assigning a Pairwise Scale in Pairwise Comparison 

There are six pairwise scales from which to choose. They are all 
measured in the range from 1 to 9 and their verbal equivalents. The 
scales listed below are displayed in the list box with padlock graphics 
to indicate they cannot be modified or erased. 

 

 Scale 

 Preference 

 Likelihood 

 Size 

 Importance 

 Contribution 

 Magnitude 

 

Measurement 
1 to 9 and verbal 

equivalents 

 

Display the Assign Scales Window 
To assign a pairwise scale other than the default scale, access the 
Assign Scales window. 

1. In the Criterion Rating window, select the Assign Scale button. 
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2. In the Assign Scale window, in the Scale Information box, click 
the drop-down menu arrow to display a list of scales. 

3. Select the scale you want. 

4. Select the Close button. 

Create a New Pairwise Scale 
1. In the Criterion Rating window, select the Assign Scale button. 

2. Select the New button to display the Add Scale window. 

3. In the Scale Name block, type the name of measurement you want. 

4. Select OK. 

5. Select the Close button. 

Selecting the Next Rating Set 

When you have finished rating a rating set, you can let DecisionPlus 
select the next rating set from the Criterion Rating window, or you can 
select it yourself from the Hierarchy window.  

Selecting Another Rating Set from the Hierarchy Window 
1. Close the Criterion Rating window. 

2. Save your ratings by selecting Save from the File menu. 

3. Double-click the next parent block whose children you want to 
rate. 

4. Repeat the steps for assigning scales and rating each rating set 
until all your criteria are rated. 
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Selecting Another Rating Set from within the Criterion 
Rating Window 

There are two ways you can select another rating set in the Criterion 
Rating window: by using the Criterion List Box, or by using the Next 
button. 

Setting the Ordering Option for the Criterion List box 
The Criterion List displays the name of the parent block you selected 
in the Hierarchy. You are rating the subcriteria or alternatives of this 
block. A check before the name indicates that the rating set of that 
criterion has already been fully rated. The list is ordered according to 
the options chosen through the Sort Next Criteria List By menu item 
under the Options menu:   

Priority  The default list sorting is by the priority (importance) of 
each criterion to the over all model as calculated by the 
Accumulated Weight of that criterion. The value of each 
criterion’s accumulated weight is shown numerically 
before its name in the list. For information on exactly how 
the accumulated weights are calculated, see Chapter 12. 

Name   Choosing the Name option simply sorts the criteria 
alphabetically by name. 

Hierarchy Order  Choosing this option orders the criteria by the 
structure of the hierarchy - level by level, starting at the 
Goal, and from top to bottom in each level. 

Rating the Next Criteria From the Criterion List Box 
1. Click on the down arrow at the end of the Criterion box to display 

a list of criteria blocks. The blocks will be listed in the order of 
importance. Criteria already rated are indicated by a check mark 
preceding the block. You can select the next item listed or any 
item you are ready to rate. 

2. Click the parent block you want. You will be rating the children of 
this parent block. 



Chapter 10 Weight the Criteria 

188 Criterium DecisionPlus 

  

Setting the Action Option for the Next button    
You can select the NEXT button to choose the “next” criterion listed 
in the Criterion List. The exact behavior under Next is determined by 
the Next Button Action submenu setting under the Options menu  

First Unrated Criterion Under the default Action, “First Unrated 
Criterion”, clicking the Next button will cause DecisionPlus to 
jump in the Criterion List from the present position to the first 
(according to the ordering of the list - see above) unrated criterion 
in the list.  If you are already in the rating set of the highest 
unrated criterion in the model, but have not finished rating it, 
clicking Next will have no effect. 

Next Unrated Criterion Under this Action, clicking the Next 
button will cause DecisionPlus to move down the Criterion List 
from the present position until it encounters an unrated criterion in 
the list. 

Next Criterion in List Simply moves to next item in the List. 

Rating the Next Criteria From the Next Button 
1. On the Criterion Rating window, select the Next button. The 

Criterion Rating window will update itself with the rating set of 
the “next” criterion in the list box. 

Accept or Cancel Your Ratings 

When you finish rating all or part of the criteria, you can close the 
Criterion Rating window and either store your entries or cancel them. 
You can cancel all the ratings you entered since the last time you 
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saved your Hierarchy file. Your file will return to the state it was in 
when you last saved. 

To Accept and Save Your Ratings 

1. On the Criterion Rating window, select the OK button. The 
Criterion Ratings window closes, returning you to the Hierarchy. 

2. To save your ratings in your decision model, use the Save option 
on the File menu on the Hierarchy window. 

To Cancel Your Ratings 

1. On the Criterion Rating window, select the Cancel button. Or, 
select the Close option from the Control-Menu Box. 

The following dialog box displays asking if you want to cancel your 
recent entries, some of which may be updates to existing ratings, some 
may be first time ratings. 

 

 

The message includes activity for several other windows to which you 
can make entries: Rules, Scales, Uncertainty, and Value Function. 
Some of these functions are discussed earlier or later in this manual. 
For now, you are only concerned with Ratings and Scales. 
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• To cancel, select Yes. DecisionPlus cancels all entries since you 
entered the Criterion Rating window and then exits from the 
window. 

• To return to the Criterion Rating window without canceling, select 
No. DecisionPlus retains your entries and redisplays the Criterion 
Rating window.  

If you opened the Criterion Rating window and made no changes, you 
will not get this message. 

Choosing a Rating Method for Direct Tradeoffs 
Technique 

Now that you have seen how to use the Weights Hierarchy Method, 
let’s look at the details of how to establish the relative importance of 
the lowest criterion under the Direct Tradeoffs technique. 

With the model Hierarchy Ratings Technique set to Direct Tradeoffs, 
proceed as follows. 

Displaying the Criterion Rating Window 
1. On your Hierarchy window, click once on the Goal or any non-
lowest criterion to bring up the Tradeoffs Rating window. 

2. From the Block menu, select Rate Subcriteria.  

 Tip:  A quick way to select the Tradeoffs Rating window is to 
double-click on the Goal, or Right Click the Goal and select Rate 
Subcriteria. 
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Criterion Rating Window Description 

The title of the Window says “Tradeoff Rating” and then the name of 
the Rating Method being used. If this is the first time you have opened 
the Tradeoffs Rating screen it will the “Abbreviated Tradeoff Method 
(initial).” More about the Tradeoff Rating Methods below. 
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Tradeoffs Grid A grid displays the Tradeoff Set. A tradeoff set is a 
collection of lowest criteria pairs that are to be assigned tradedoff 
values. Each row in the grid lists one tradeoff pair. The first column 
gives the name of the tradeoff, then next the number of its scale units 
being traded for how many (column 6) units (column 5) of criterion 
2’s (column 4) scale. In the graph shown, the criterion “initial” was a 
reference criterion, and by default, the tradeoffs are expressed as how 
many units of the other criteria would be traded of for one unit of it’s 
scale ($1000). The check marks in the first column indicate that all 
tradeoff pairs have been assigned tradeoff values. 

Below the Tradeoffs Grid, are areas that allow you to access and edit 
the Name, Notes and Value Function (if Alternatives Rating 
Technique is SMART). 

Tradeoff Pair  Below that on the left is a tradeoff pair utility area. 
This provides buttons for moving up (Previous) and down (Next) the 
Tradeoffs Grid, as well as a button (Reverse), that changes the sense 
of the tradeoff from 1 unit of A is equivalent to X units of B, to that of 
1 unit of B is equivalent to 1/X units of A. This reversing of the 
tradeoff sense can often make the tradeoff evaluation much easier. 
Finally, the Unrate button sets the tradeoff value back to unrated, 
which is represented in the grid by the value 0. 

Minimal Set Select  The minimal set Select button is used to launch 
the Select Minimal Tradeoff Set window (see below).  

Inconsistencies – Index  The Inconsistency Index gives an indication 
of how inconsistent the tradeoff set’s values are (see below for an 
explanation of tradeoff set inconsistencies). A value of 0 means that 
the set is consistent.  

Descriptive Tradeoff Sentence 

The heart of the direct tradeoffs Rating window is the descriptive 
Tradeoff Sentence area at the bottom of the window. There you are 
posed the classic tradeoff question. For example, “For every 1 K$ of 
Initial (price), (you would) tradeoff how many miles per hour per 
second units of Acceleration? Enter your response, click the Enter key, 
and the value is entered as a tradeoff. 
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 Full Tradeoff Rating Method 
Click the Full Tradeoff menu item under the Method menu. In the 
Buy A Car example, you would see 28 pairs listed. CDP indicates 
those tradeoff pairs you have directly rated by a check mark in the first 
column, and those values that it calculated indirectly from the values 
you have input, (assuming a consistent tradeoff set), with circles.  
Unrated pairs have nothing in that column. 

You could proceed to consider each question, enter each value, press 
the Return Key, and move on to the next tradeoff pair (row) in the list.   
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Inconsistent Tradeoff Sets 

Just as in the AHP pairwise comparison, tradeoff values should satisfy 
an inconsistency condition. As an example, if is A traded off at 5 units 
of its scale to 1 unit of B’s scale, and B is traded off at 3 units of its 
scale to 1 unit of C’s, then A should be traded off at 3 * 5 = 15 units to 
1 unit of C’s scale. If you directly assign values to the A-B, B-C and 
A-C tradeoff pairs, your given values may or may not satisfy that 
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condition. If they don’t, they are inconsistent, and the whole tradeoff 
set is considered to be inconsistent.  

Minimal Tradeoffs Set 

If there are 10 lowest criterion, and you assume all tradeoffs will be 
consistent, then it only takes 9 = 10-1 tradeoff pairs to uniquely 
determine values for all possible (10 *9)/2 = 45 tradeoff pairs. This is 
because, if you assume the tradeoffs are consistent, and knew the A-B 
and B-C tradeoff pairs’ value you could just calculate the value of the 
A-C tradeoff as 15 = 5 x 3. 

The group of 9 tradeoff pairs has to have the special property that no 
pair could be directly calculated from products of the other 8. If that is 
true, the group of 9 constitutes a minimal set of tradeoffs pairs, and the 
values of all tradeoff pairs not in the minimal set can be calculated 
from products of the 9’s values. There are many possible minimal sets 
for any tradeoffs problem, and CDP will help you construct them. 

Abbreviated Tradeoff Rating Method 
By choosing to use the Abbreviated Tradeoffs Rating Method, you can 
ensure that you are only assigning tradeoff values pairs belonging to a 
minimal set, and remove the possibility of inconsistencies. 

To choose the Abbreviated Tradeoff Rating Method. 

1. In the Tradeoffs Ratings window, click the Method menu item and 
select the Abbreviated Tradeoff item. 

2. The Select a Minimal Set of Tradeoff Pairs window will open.  
Use it, as described in the next section, to choose your minimal 
set. 

Choosing A Minimal Set for Direct Tradeoffs 
Technique 

Selecting a minimal set of tradeoff pairs, rather than trying to tradeoff 
all lowest criteria pairs in your model, will both drastically reduce the 
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number of tradeoffs you need before you have a fully rated model and 
avoid inconsistent tradeoffs (see section above).   

To select a Minimal Tradeoff Set 

In the Tradeoffs Rating window, either  

1. Click the Select button in the Minimal Set area, OR,   

1. Click the Abbreviated Tradeoffs item under the Method menu. 

2. The Select Minimal Set of Tradeoff Pairs window opens. 

CDP provides two ways to select a minimal set.  
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Select a Reference Criterion 

Click the Option (if not already clicked) Use A Lowest Criterion as a 
Tradeoff Reference. The area below the options area shows a 
dropdown listbox showing all candidate reference criteria. To the right 
is a list of the resultant minimal tradeoff set. In the screen capture 
above, “Initial“ (price) is the reference criterion, and all other lowest 
criteria are traded off with respect to “initial”. 

Note: A lowest criterion must be a) 
connected to all alternatives b) have a non-
zero accumulated weight before it is 
considered a viable tradeoff reference 
criteria. 

If there is a criterion against whose scale all other scales can be traded 
off, that leads to very understandable and verifiable models. The initial 
price in $’s for the Buy A Car Model is a reasonable choice. The 
problem is that many decisions have a large number of very different 
criteria, and there is no single criterion against which all others can be 
directly traded off. You could say that this problem is at the core of 
multicriteria decision making. For example, in a large environmental 
model, you may have whole branches of the model, e.g., Health and 
Human Safety and Project costs where subcriteria within each branch 
can be easily traded against each other, but tradeoffs between two 
lowest criteria, one from each branch, are difficult to establish and 
verify.  
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Manually Select Tradeoff Pairs from List 

Instead of using a reference criterion, you can manually create a 
minimal set. Click the Option (if not already clicked) Manually Select 
Tradeoff Pairs from List. 

On the left is a list of all Selectable tradeoff pairs. On the right, a list 
of pairs you have selected as members of your minimal set. (If you 
have some or all tradeoff pairs in the right hand list, click the “<<“ 
button to move them all to the left hand (selectable) list). 

Browsing the Selectable (left hand) list, you can select a pair you feel 
comfortable trading off. Then Click the “>“ button to move that pair to 
the right hand, Selected list. As you continue to do this, you’ll notice 
that the number in the Selectable will start decreasing rapidly.  
Selecting and moving a single pair may make the number in the 
Selectable List decrease by 10 or more. That is because when a new 
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pair is selected, we remove all pairs in the Selectable list that can be 

calculated, based on consistent ratios, from any combination of 
Selected Pairs. As mentioned before, there are N*(N-1)/2 tradeoff 
pairs, but only N-1 independent tradeoffs are required for a complete 
minimal set.  

Auto Completing a Minimal Set 

CDP offers three ways to complete your minimal tradeoff set in an 
ordered fashion by using the Fill List By option. By Branch, by Name 
and by Screen order. In each of these, CDP chooses pairs 
systematically until is has completed a minimal set.  

To complete a minimal set by Branch. 

1. In the Select Minimal Set of Tradeoffs Pairs, click the Branch 
option button. 
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2. Click the “>>“ button to create a minimal set based on pairs of 
tradeoffs ordered by branch. 

This Branch ordering can be critical in helping tradeoff large decision 
hierarchies. It allows you to tradeoff all the criteria of a large sub-
branch amongst themselves, which is generally manageable because 
those criteria should be closely related. The tradeoff pairs that span 
two large branches then are seen to be critical – their tradeoff value 
sets all tradeoffs between the two branches. A single tradeoff could be 
responsible for all the tradeoffs between H & HS criteria and those of 
Project costs. 
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To Accept Your Minimal Set 

1. Click OK to accept your Minimal Set and close the Select 
Minimal Set of Tradeoffs Pairs window 

2. CDP will ask you do you wish to define all existing tradeoff 
values as directly assigned, even if they had been indirectly 
calculated.  Any tradeoff pair whose value had been directly 
assigned, but does not belong to your new Minimal Set, will then 
have its value recalculated indirectly. 

To Restore the Minimal Set 

1. Click the Restore button to restore the minimal set to that which 
was in effect when you opened the window. 

To Cancel  

1. Click the Cancel button. The Minimal Set you choose will be 
discarded and you are returned to the Ratings Window. 

Equalizing all Weights or Tradeoffs in a model 
In can sometimes be very useful when starting to rate a new hierarchy, 
to start with equal weights or tradeoffs. In the Hierarchy Window, you 
can in a single menu selection unrate or equalize the Hierarchy 
weightings (tradeoffs) depending on whether you are using the 
Weights (Tradeoffs) Hierarchy Rating Technique. 

To equalize all weights (using Weights Hierarchy Technique, only) 

1. Make sure you are in the Hierarchy window 

2. Select the item Equalize all Weights from the Model menu. 

All weights of subcriteria in each rating set are set to the scale 
midpoint. Note that this does not mean that all lowest criteria will have 
equal accumulated weights – far from it. 

To equalize all tradeoffs (using Direct Tradeoffs Hierarchy 
Technique, only) 

1. Make sure you are in the Hierarchy window 
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2. Select the item Equalize all Tradeoffs from the Model menu. 

All tradeoffs are set to 1. Note that this does not mean that all lowest 
criteria will have equal accumulated weights. Different scale ranges 
will lead to different accumulated weights. 

Unrate All Weights and Direct Tradeoffs 
Weights or Direct Tradeoffs may be universally reset to their default 
unrated values.   

1. In the Model menu on Hierarchy window, click Unrate,  

2. Then choose All Weights or All Tradeoffs.   

Note:  Exercise this universal Unrate action 
with extreme care! 

Rating Alternatives Against Lowest Criteria 

Having assigned the relative importance of the lowest criteria, now 
let’s rate the alternatives against them. As discussed at the beginning 
of this Chapter, this is achieved using either the Analytical Hierarchy 
Process or Simple Multiattribute Rating techniques. 

Using the AHP to rate Alternatives 
Rating the Alternatives against the lowest criteria using the AHP is 
exactly as described in the earlier sections of this chapter covering 
weighing criteria under the Hierarchy Weights Technique. 

Using SMART to rate Alternatives 
If you have selected SMART, there are some differences from AHP.  
No pairwise comparison rating method is available when rating 
alternatives. And there are Value Functions. The use and purpose of 
value functions is explained in the next sections. 
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Assigning Value Functions under SMART 

If you selected the SMART technique in the Hierarchy window the 
word SMART appears in the title bar of the window instead of AHP. 
To select SMART, turn to section in this chapter “Choosing the 
Alternatives Rating Technique: AHP or SMART.” 

Other than the window caption, choosing SMART or AHP makes no 
difference as to how higher level criteria are weighted. 

Rating Lowest Criteria 
When you reach a lowest criterion (one whose rating set consists of 
Alternatives), the Rating window in SMART changes in several 
places: the Criterion name box changes to Attribute, 
Subcriterion/Weight changes to Alternative/Rating, and the Value 
Function button appears in the lower left corner of the window. These 
changes are to adhere to the terminology commonly used in the 
SMART technique. For both techniques, the Uncertainty menu item 
becomes available when you rate any lowest criteria. See following 
illustration. 
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To Rate Attributes with Value Functions 
The default value function for determining a rating for an attribute is a 
linear function. If you assign a rating using the numerical, graphical, 
or verbal views, the value is determined using a linear value function. 
To select the scale you want, 

1. In the Criterion Rating window, select the Assign Scale button.  
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 Select any of the scales provided in the list box, or create a 
customized scale by selecting New. Follow the steps for “Display 
the Assign Scales Window” in the sections on Assigning Ratings 
earlier in this chapter. 

 DecisionPlus uses this scale and advises you if you previously 
assigned values beyond the upper and lower bounds of the scale. 

2. Click the Value Function button to open the Value Function 
window. The default display is the Linear function (below).  

3. Select the value function you want to work with: Linear (already 
displayed upon first entering the window), Exponential, or 
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Custom.  Detailed instructions on how to work with each type are 
supplied in later sections of this User’s Guide. 

4. Close the Value Function window. You are again in the Criterion 
Rating window. The Value Function you have chosen is shown on 
the Value Function button, e.g., Lin (-) indicates a linear value 
function with a negative slope. 

5. Rate your rating set exactly as before. The impact of your choice 
of value functions will become apparent only when you are 
calculating the results (see Chapter 12). 

Normalization   in SMART and AHP 
Anticipating the comprehensive discussion on how decision scores for 
alternatives are calculated, which appears in Chapter 12, the basic 
difference between AHP and SMART techniques is how they 
implement the normalization of user scales. Normalization is how the 
model takes disparate user scales, such as costs in billions of dollars 
and human life days saved, and puts them on a common, internal 
priority scale. The priority scale always has values between 0 and 1.  

In AHP, the direct method uses a simple relative normalization 
technique, that divides the score of an item under a criterion, by the 
sum of the scores of all the alternatives under the same criterion, to 
produce the priority of that alternative under that criterion.  

In the SMART technique, the scores for the alternatives are 
normalized to priorities differently than when using the AHP 
technique. In SMART, the normalization process uses simple 
mathematical functions, the value functions, to map one end of the 
user scale to 0, and the other to 1 (look at the curve in the Value 
Function window above). All other values are mapped to values within 
this range (0 to 1) according to the value function you choose. 

Using the Linear Value Function 
1. To select the value, click on the appropriate point on the curve. 

2. To change the scale, select Cancel to return to the Criterion Rating 
window, then select Assign Scale and continue as before. 
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Setting the Slope  
In SMART, the user chooses which end of the user scale is mapped to 
0 and which to 1, by selecting a positive or negative slope. By default, 
DecisionPlus assumes that higher numbers correspond to a better 
priority. In some cases, such as when working with costs, the higher 
numerical value corresponds to the less desirable case. In a value 
function, this is expressed by choosing a negatively sloped function. 

To set the slope, select either Positive or Negative in the Slope group 
box. 

   
 Positive Negative 

The interplay between your choice of Best and Worst when you 
defined your numerical scale (its orientation) and your choice of slope 
for your value function is important to understand. Please see the 
section Synchronizing Value Function Slope to Scale Orientation 
below. 

Using the Exponential Value Function 
1. Select on the Exponential (EXP.) button. 
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2. To change the curve, click and drag the blue point on the curve. 
The exponential curve changes so it passes through the blue point. 
The coordinates of the current value are given below the curve 
area in the Values box. 

 Coordinate values may also be entered directly into the value box. 
Note that extremely angular curves are not permitted. If the blue 
reference point is dragged into an off-diagonal corner, the point 
relaxes slightly toward the center. The range of curves permissible 
is adequate for most decision problems. If you need a more 
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angular curve, use the custom value function to create a set of 
points that meet your needs. 

Using the Custom Value Function 
The custom value function allows you to define up to ten points of a 
piecewise linear function. 

1. Select the Custom button.  
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2. To move one of the three points displayed, click and drag one at a 
time. The point you drag turns blue when selected. 

 The value of the selected point shows in the Values box below and 
conversely, the value field may be used to position the point. 

3. To add additional points, double-click the background canvas 
above the curve. A point appears along the curve for each double-
click you make.  

Note:  Value functions in DecisionPlus are always either 
monotonically increasing or decreasing. 

4. To delete a point, use the right mouse button to click on a point. 

When you finish rating your model in SMART, you can continue 
below with Assigning Rules, or save the entries to your model and 
proceed to the next appropriate chapter. 

Synchronizing Value Function Slopes to Scale 
Orientation   

When you create or edit a numerical scale you establish an Orientation 
for that scale by deciding whether high numerical values of the scale 
correspond to Best or Worst values. When using SMART, each lowest 
criterion has its own unique value function, with a user defined Slope. 
These two properties both indicate which end of the scale corresponds 
to a higher decision score. Since they are set independently (as one 
scale may be assigned to several criteria), they may conflict when: 

1)  A numerical scale is assigned to a Lowest Criterion 
(Attribute) under SMART   

2)  An existing scale, which has been assigned to a Lowest 
Criterion (Attribute) under SMART, is radically edited so that 
its orientation is reversed.   
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While DecisionPlus will always use the information from the value 
function slope over the scale orientation, this conflict can cause 
confusion for the decision-maker. 

The default approach in DecisionPlus is to automatically synchronize 
the value function slopes to the orientation of the scale. For scales with 
positive orientation, the source of the conflict may be: 

1)  A numerical scale is assigned to a Lowest Criterion (Attribute) 
under SMART, then the lowest criterion with that scale has the slope 
of its value function made positive.   

2)  An existing scale, which has already been assigned to a Lowest 
Criterion (Attribute) under SMART, is radically edited so that its 
orientation is negative, then all lowest criteria using that scale have the 
slopes of their value functions set to negative. 

Sometimes you may have a good reason to let such a conflict exist. 
This is often the case with $ scales. For example, Costs might use the 
scale with a negative slope, while Revenues might use the same scale 
with a positive slope. In that case, you need to change DecisionPlus's 
way of handling such conflicts from automatically synchronizing to 
one of querying you for your preference. This is done as follows: 

1. In the Assign Scales window, uncheck the Synch Value Function 
Slope checkbox. 

Subsequently when a conflict opportunity arises, DecisionPlus will 
query you as to how you wish to proceed. This can result in a lot of 
messages. To revert to the default behavior, check the Synch Value 
Function Slope checkbox again. 
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Using the Alternatives’ Rating Window 

The Alternatives Rating Window allows you to edit all the attributes 
of a single alternative in one dialog. 

 Only the primary view is represented for each lowest criterion.  You 
can change views, scales or methods from this window. 

You can enter all score values directly, except for those lowest 
criterion using pairwise rating methods.   

Alternative Listbox 

You can use the Alternatives drop-down listbox to choose any other 
alternative, and proceed to rate its attributes. 

To open the Alternatives’ Rating Window 
1. In the Hierarchy window, select an Alternative. 

2. Choose the Rate Subcriteria (!) item from the block menu. 
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OR 

1. In the Hierarchy window, Double Click an alternative. 

OR 

1. In the Hierarchy window, Right Click an alternative, 

2. Choose the Rate Subcriteria menu item. 

To Unrate all Alternatives’ scores 
All scores may be reset to default values.   

1. In the Model menu on Hierarchy window, click Unrate, then 

2. Choose Scores 
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Assigning Rules 

If you have used AHP before, you have probably assigned rules to 
help identify when conditions are not met. Rules are conditional 
statements that apply to the lowest criteria, criteria blocks whose 
children (subcriteria) are Alternatives. (See illustration below.) Rules 
do not affect the decision scores of your model, but any lowest 
criterion that fails a rule is highlighted in the Results window so you 
can easily identify it.  

  
DecisionPlus has two types of Rules: Simple rules and If/Then rules. 
An example of a Simple rule using our Car model above is: Initial 
must not be better than 50.00. If you were using DecisionPlus to hire a 
new employee, you might write a rule that says their experience in 
customer support must be greater than 1 year. 

An example of an If/Then rule using our Car model above is: If Initial 
is better than 50.00, then Maintenance must be no better than 50.00. If 
you were using DecisionPlus to hire a new employee, you might write 
a rule that says IF their degree is no better than a Bachelor’s, THEN 
their grade point average must be better than B to be considered. 
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Display the Add a Rule Window 
1. In the Hierarchy window, from the Block menu, select Rate 

Subcriteria to display the Criterion Rating window. Or, double-
click on the first criterion of the lowest criteria. 

2. In the Criterion Rating window, select Rules from the menu. The 
message, “There are no rules on file. Press ‘New’ to add a rule”, 
displays. This message alerts you that your first task, once you are 
inside the Rules window, is to add rules. 

3. Select OK to display the Maintain Rules window. 

4. Select the New button to display the Add Rules window. 

5. In the Name block, type in a name for the rule you want to add. If 
you do not type in a name, the message “Rule name must be 
entered” displays. 
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6. Select the type of rule you want,  Simple or  If/Then. The 
Rule box below displays a template of the selected rule statement 
and bracketed terms you must fill in. The first item to define (the 
first on the list of your lowest criteria) is already filled in and is 
highlighted red.  

 Below are illustrations of templates for both types of rules. 

 Simple Rule 
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 If/Then Rule 

To Specify Your Rule 
First, select the lowest criterion for which you want to add a rule. The 
first one in the list of lowest criteria is already inserted for you. 

• If the red highlighted criterion listed in the Rule box is the one you 
want, go to the steps below to define the conditions. 

• If the criterion you want is in the list of criteria below, click once 
on the one you want. The red highlighted criterion is replaced with 
the one you selected. 

Now define the conditions between the brackets <  >. 

1. In the Rule box, click on the word <condition> to display a list of 
conditions in the Options box. The bracketed word is replaced 
with the first option in the list and is highlighted red. If this is the 
option you want, move on to the next condition. 

2. To select a different condition, in the Options box, select the 
condition you want. The option then replaces the condition 
highlighted red in your Rule box. 

3. Repeat steps 1 and 2 for each word in <  > until you have 
completed your statement. 

4. When your statement is complete, select OK. The Add Rule 
window closes and the Maintain Rules window redisplays. 

5. To add more rules, begin again at Add a Rule. 

6. To cancel your entries, select Cancel. 
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To Edit Rules 
1. Display the Criterion Rating window. 

2. Select Rules from the menu. 

3. On the Maintain Rules window, click the Name drop box down 
arrow to display a list of rules. 

4. Select the rule you want to edit. 

5. Select the Edit button. The Edit Rule window displays the current 
name and version of that rule. 

6. The Rule Name is highlighted. Type a new name if needed, or edit 
the highlighted name. 
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7. Click the part of the rule you want to change. A list of options 
displays below. 

8. Select the option you want. 

9. Repeat steps 6 and 7 until you have completed your changes to 
this rule. 

10. When you have completed the changes to this rule, select OK. 

11. To cancel the changes, select Cancel. 
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Rules Only Criteria 

Sometimes you may want to add a rule, but no relevant criterion 
exists.  It might be a legal requirement, such as foreign ownership has 
to be less than 70%. So you would add a criterion called “Foreign 
Ownership”, connect it to all alternatives and to the Goal (say).  Then 
set your Rule as described above. But you don’t wish this criterion to 
be part off the tradeoffs in the model. This can be done as follows. 

When using Weights Hierarchy Technique 

Double click the block with respect to which your “Foreign 
Ownership” block is a subcriterion. Set the Weight of “Foreign 
Ownership” to the scale minimum.  (This is usually is the scale end 
marked “Worst.” But if you are using SMART, make sure it is the 
value that maps to 0 in the Value Function 

When using Direct Tradeoffs Hierarchy Technique 

Setting the weight of a criterion to the scale minimum would 
correspond to a tradeoff with a value of 0– an infinite amount of 
change would be required to equal a unit change in any other criterion. 
CDP does not allow tradeoffs of value 0. Instead CDP allows you to 
remove lowest criteria from being traded-off at all. To do this, select 
the “Foreign Ownership” in the Hierarchy view, and select the 
“Exclude Lowest Criterion from Tradeoffs” item in the “Block” menu 
item. If you then double click any non-lowest criterion to see the 
Ratings screen, you’ll see that “Foreign Ownership” is not included in 
the Tradeoffs Set. 

To include a hitherto excluded lowest criterion.  

1. In the Hierarchy window, select the excluded lowest criterion. 

2. From the Block Menu, select Add Lowest Criterion to tradeoffs  
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Criterion Rating Menu Commands 

Many of the Criterion Rating window functions described earlier using 
the mouse can also be performed using the menu options. Below is a 
list of all these menus and options. 

Hierarchy Weights, Alternatives AHP or SMART Rating 
Techniques 

Method 

Direct  Selects the Direct Comparison rating method, making 
available the selection of Numerical and Verbal rating scales. 

Full Pairwise  Selects the Full Pairwise Comparison rating method, 
making available the selection of Pairwise rating scales. 

Abbreviated Pairwise  Selects the Abbreviated Pairwise Comparison 
rating method, making available the selection of Pairwise 
rating scales. 

View 

Numerical  Displays or turns off the numerical view on the Criterion 
Rating window. 

Verbal  Displays or turns off the verbal view on the Criterion Rating 
window. 

Graphical  Displays or turns off the graphical view on the Criterion 
Rating window. 

Descriptive Sentence  Displays or turns off the Descriptive Sentence 
on the Criterion Rating window. Because this is a verbal 
display, it is only active when the verbal view is active. 

Decimal Places  Lets you choose how many decimal places you 
wish to numerical scales to exhibit (from none to 6).  The 
default is Auto, which usually produces 2 decimal places.  
Your choice applies to all numerical scales.  

Options 
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Note: These options, if changed from their defaults, are only 
active while the application is open. If you close DecisionPlus, 
all options will have returned to their defaults when you next 
open it. You can change the defaults using the Options dialog 
on the Hierarchy Window. 

Sort Next Criteria List By 

Name  Sorts the Criteria in the Next Criteria listbox alphabetically. 

Hierarchy Order  Sorts the Criteria in the Criterion listbox by 
Hierarchy Order. 

Priority  Sorts the Criteria in the Next Criteria listbox by their 
Accumulated Weights.  This is the default setting. 

Next Button Action 

First Unrated Criterion  Clicking the Next button takes you to the 
first Unrated block in the list. However the list is sorted (see 
above), and regardless of your starting point, this is the default 
setting. 

Next Criterion in List  Clicking the Next button simply takes you 
to the next block in the list, however the list is sorted (see 
above). 

Next Unrated Criterion  Clicking the Next button takes you to the 
next Unrated block in the list, however the list is sorted (see 
above). 

Group Tag Level  

 Sets the Group Tag level. For an explanation, see Setting the Tag 
Level Options in Chapter 13. The options are the list of levels 
within the hierarchy model. The default is "(None)".   

Tag By First Letter  Sets the Group Tag Level. This is a checked menu 
item. It is disabled if the Group Tag Level is set to "(None)". 

Real Time Update  When this option is checked, all visible results and 
analysis windows are updated as soon as you make any change to 
the ratings. If you are using a Numerical view, and editing the 
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numerical text box directly, these updates occur every time a digit 
is entered. For large models this can slow your work. Clicking the 
option off ensures that the general model results are only updated 
when the Criterion Ratings dialog is closed. The default is real 
time updating on. 

Rules  Accesses the Maintain Rules window where you can add and 
edit rules for your lowest criteria. 

Uncertainty  Available for lowest criteria once you rate them. 
Accesses the Uncertainty function which is described in Chapter 
11, “Select Uncertainty.” 

Direct Tradeoff Hierarchy Rating Technique 
Method 

Full Tradeoff   Display and assign values to all tradeoffs pairs.  

Abbreviated Tradeoffs  Only display and assign values to members 
of the minimal set you have selected.  When you click this 
menu item, the Select a Minimal Set of Tradeoff Pairs  
window appears.  Use that to select a minimal tradeoff set. 

Options 

Note: These options, if changed from their defaults, are only 
remembered while the application is open.  If you close 
DecisionPlus, all options will have returned to their defaults 
when you next open it.  You can change the defaults using the 
Options dialog on the Hierarchy Window. 

Order By 

Name  Sorts the tradeoffs pairs lists alphabetically, first by the 
name of the first criterion, then by the name of the second in 
each tradeoff pair. 

Screen (Hierarchy) Order  Sorts the Criteria in the Criterion 
listbox by Hierarchy Order, first by the name of the first 
criterion, then by the name of the second in each tradeoff pair.  
This is the default setting. 
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Next/Previous Button Action 

First Unrated Tradeoff  Clicking the Next/Previous button takes 
you to the first Unrated tradeoff in the list, however the list is 
sorted (see above), and regardless of  your starting point. 

Next/Previous Tradeoff  in List  Clicking the Next/Previous button 
simply takes you to the next/previous tradeoff pair (row) in the 
list, however the list is sorted (see above). 

Next/Previous Unrated Tradeoff  Clicking the Next button takes 
you to the next/previous Unrated tradeoff pair (row) in the list, 
however the list is sorted (see above). This is the default. 

Return Invokes Next Action 

 If this option is checked, hitting return after entering a tradeoff 
value or digit, will cause not only the model to be updated to 
the new value, but also the action of the Next button will be 
invoked (see above).  This is useful for the fast, systematic 
entry of tradeoffs, but can be confusing.  The default is off.   

Hide Indirectly Rated Tradeoffs  Available only when Full tradeoff 
method is chosen.  Hides all tradeoff pairs who have acquired 
values through consistency assumptions.  These are the pairs 
which are preceded in the tradeoffs pairs list by circles 

Group Tag Level  Sets the Group Tag level.  For an explanation, see 
Setting the Tag Level Options in Chapter 13.  The options are the list 
of levels within the hierarchy model.  The default is "(None)".   

Tag By First Letter   Sets the Group Tag Level. This is a checked 
menu item. It is disabled if the Group Tag Level is set to "(None)". 

Real Time Update  When this option is checked, all visible results and 
analysis windows are updated as soon as you make any change to 
the ratings and press the Return key. Clicking the option off 
ensures that the general model results are only updated when the 
Criterion Ratings dialog is closed. The default is real time 
updating off. 
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Rules   Accesses the Maintain Rules window where you can add and 
edit rules for your lowest criteria. 

Setting Default Options for Ratings 

Many of the Options in the Ratings Windows may have their default 
values set through the Options Dialog, as indeed may the default 
techniques, hierarchy and alternatives.  These defaults are stored on 
your computer, and will be applied any time you use CDP.   

Setting Ratings Options: the Ratings Tab 
In the Hierarchy window select Options, Environmental from the 
Model menu. Click the Ratings tab. Here we briefly describe the 
individual options. 

Order By and Tradeoffs: Order By Simply lets you specify 
separately the default orderings under the two Weights and 
Tradeoffs Hierarchy Rating techniques.  

Next/Previous Button Action   Determines the default Action the 
Next button takes when pressed, both for Weights and Direct 
Tradeoffs. The check box that determines whether the Return 
key invokes the next action is only available under the Direct 
Tradeoffs technique. 
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Scale Defaults   CDP uses Best and Worst to indicate which end of a 
numerical scale correlates with higher and lower decision 
scores, respectively. Those words appear on the Ratings 
window, on the Value Function graph and other graphs’ axes. 
In some decision models, this terminology can be 
inappropriate.  Here you can set your own default 
terminology. (You can edit those values for a particular model 
by using the Edit High/Low Defaults button on the Assign 
Scales dialog (see the section “Create a Customized Numerical 
Scale in Direct Comparison,” earlier in this chapter). 
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Hide Indirectly Calculated Tradeoffs   Turning this on helps control 
large models when performing Direct Tradeoffs using the Full 
Tradeoffs method. But it can be confusing when on. 

Decimal Places   Default number of decimal places to show for values 
entered against numerical scales.  

Setting Ratings Options: the New Block Tab 
The defaults you can set in the New Block tab can significantly speed 
up the creation of new models, particularly in terms or ratings. These 
all apply only to models using the Weights Hierarchy Rating 
Technique. You can choose which Method, View and Scales you wish 
to use for new Blocks. (Default Scales are limited to permanent default 
scales that CDP provides. 
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Inherit unrated block values from previously rated block  This is a 
very useful option to check. It means that your rating methods and 
views carry over from your previous ratings set.  

 

Note:  When you click either the Apply or OK button, all the 
default settings will be applied to your current model (where 
applicable), not just the option you have changed.  The 
Apply button does not close the Options Dialog. 
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What’s Next? 

You now have ratings in your decision model, you know how to edit 
them using the steps in this chapter. You can go on to Chapter 12, 
Review the Results, to look at your decision scores, or go to Chapter 
11, Select Uncertainty, to apply uncertainty to the scores of your 
alternatives. Chapter 14, Document the Results, describes how to print 
both specific items and general reports from your decision model. 
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Chapter 11   
 
 
 

Select Uncertainty 
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In This Chapter 
  Selecting Uncertainty as Part of the Decision Process 
  Modeling Uncertainty 
  Displaying the Uncertainty Input Window 
  Assigning a Distribution Type 
  Specifying Inputs for Distributions 
  What’s Next? 
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Selecting Uncertainty as Part of the Decision Process 

Where are you? You are in the shaded part of the Process Diagram 
below: 

Process Diagram

Brainstorm 
the Problem

Build the 
Hierarchy

Rate the Hierarchy

Review the Results

Analyze the Results

Document 
the Results

Select Uncertainty
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Modeling Uncertainty 

Often, the values you assign to the ratings of your criteria and 
alternatives are not precise but have an uncertainty associated with 
them. This uncertainty itself is often quantifiable for lowest criteria 
(those attached to alternatives) where you have more data on the 
criteria and alternatives you are considering. Uncertainty in the data 
you use in your decision introduces the element of risk to choosing the 
preferred alternative.  

For example, if the values you feed into the model are incorrect, there 
is a possibility that had you used the correct values, a different 
alternative might be preferred. While the initial price of the Toyota is 
$15,000 today, maybe that will be reduced at the year-end inventory 
clearance to $12,000, in which case the Toyota might be the best buy 
(its decision score would be the highest, making it the preferred 
alternative). 

Using Probability Distributions 
DecisionPlus allows you to characterize this uncertainty or risk by 
entering probability distributions for the weights (ratings) of  
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alternatives with respect to lowest criteria. That is, it takes the “What 
if” speculation about the price of the Toyota a step further: it asks you 
to assign a rough probability that the price at year’s end would be 
$12,000 or less. The decision score of each alternative is then 
characterized as a distribution representing the uncertainty in the 
decision process. Because of the uncertainty in price, the decision 
score of the Honda might range from 0.4 to 0.6, enough to overtake 
the score of the preferred alternative based on discrete values. Through 
this decision score distribution, you can review how uncertainty 
influences the decision. 

It is likely that if you are using fixed discrete values, and you then 
choose to include uncertainty in your model, you’ll see that the 
preferred alternative is no longer a clearly preferred choice. If there is 
some possibility that the true values of the weights, or ratings, of the 
preferred alternatives fall short of what you thought, then some of the 
possible decision scores would be less than that calculated using 
discrete values.  
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Conversely there might be a significant probability of competing 
alternatives scoring higher than expected. By comparing the decision 
score distributions of the alternatives, DecisionPlus determines what is 
probabilistically the preferred alternative and by what percentage it is 
so. As an example, the alternative preferred in the discrete calculation 
might be the preferred choice only 55% of the time, which could be 
anticipated by noticing the overlap of its decision score distribution 
with those of other alternatives.  

If this occurs, we recommend that you reconsider the decision and 
study the problem more closely with the objective of reducing the 
uncertainty or introducing new criteria to better discriminate between 
alternatives. 

Throughout this chapter, we will use SMART terminology of 
attributes (instead of lowest criteria) and ratings (instead of 
alternatives’ scores). 

DecisionPlus allows you to assign uncertainty only to the ratings of 
alternatives with respect to relevant attributes.  
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Displaying the Uncertainty Input Window 

1. In the Hierarchy window, highlight the lowest criterion (one 
attached to an alternative) on which you want to work. 

2. From the Block menu, select Rate Subcriteria to display the 
Criterion Rating window. 

3. Select Uncertainty from the menu bar to display the Uncertainty 
Specify Distributions (or input) window. 
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Uncertainty Specify Distributions Window Description 
The Uncertainty input window has three primary areas: The graphical 
display, the Distribution Type, and the Current Value (Rating). 

The graphical display box shows the distribution for the alternative 
and the lowest criterion listed in the Current Value part of the window. 
The default distribution is None and displays your criterion in a 
discrete value. 

Distribution Type box provides selections of the following 
distributions to characterize your uncertainty: None, Uniform, 
Triangle, Normal, Log-normal, and Custom.  

The Current Value box allows you to select the criterion and 
alternative you want for the distribution. 

Editing the Distribution 
You can edit the distribution by specifying the parameters (such as 
mean, lower bound, upper bound) in the graphical display portion of 
the window. The x-axis represents the scale of the rating being used 
and the y-axis represents the probability density function for that value 
of the rating. The area under this function, between two values of the 
weight/rating, is equal to the probability of that rating taking a value 
between those two.  

You should choose the end values of the scales (see Assign Scales in 
Chapter 10, Weight the Criteria) so they are less than and greater than 
the lowest possible and highest possible values that the rating could 
take. As the probability of the rating taking a value between its highest 
and lowest possible values has to equal one, so the area under the 
curve in the graph must always equal one, and the range of values on 
the y-axis adjusts accordingly. 

The red triangle in the area under the curve displays the current 
discrete value that you entered in the Criterion Rating window for the 
attribute. This is the default for the mean value for those distributions 
which includes the value of the mean in their descriptive parameters 
(for example, to describe a Normal curve, you must specify a mean, a 
standard deviation, and the upper and lower cutoffs). As you select 
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different values for the mean, using the bullet-shaped sliders next to 
the red triangle, the red triangle remains fixed on the x-axis (changing 
the uncertainty distributions has no effect on the discrete value at 
which you rated it) and the numerical value associated with the slider 
reflects the new value of the mean. 

You can select the rating you want to work with in the Current Values 
portion of the window. Select both an alternative and the attribute with 
respect to which the rating is defined. 

Assigning a Distribution Type 

1. On the Uncertainty Specify Distributions window, in the 
Distribution Type box, select the distribution you want.  

2. The Values box contains the values of the parameters describing 
the distribution you selected. You can edit these values by typing 
directly into the edit boxes, or by using the up/down arrows next 
to each box. 

3. To delete a distribution and return to a discrete value, select None 
in the Distribution Type box. 

A Rough Guide to Choosing a Distribution Type 
Choose the simplest distribution that fits the knowledge you have of 
the uncertainty in the value of the rating you are considering. The 
more parameters required to specify a distribution, the more time and 
energy you need to expend in estimating their values. 
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The following chart suggests guidelines for choosing a distribution 
type. 

 

Choose When 

Uniform Distribution all you know is that the value must fall between 
a lowest and a highest value. 

Triangular Distribution in addition to an upper and lower bound, you 
know what is the likeliest (mode) value (such 
as a value that would show up most often). It is 
especially useful for modeling distributions 
where the likeliest value is closer to one of the 
bounds than it is to the other. 

Normal Distribution  the values are likely to fall close to an average 
value and are as likely to be above that 
average value as they are to be below it. 

Log Normal Distribution it is important that the distribution starts at a 
particular value at one extreme, but is open at 
the other (human age is a good case). 

Custom Distribution you know the probabilities for some key values 
(as is often the case if you are using the results 
of a specialized forecasting tool). 

Specifying Inputs for Distributions 

You can edit the descriptive parameters for each distribution you 
select to better describe the uncertainty in the value of the rating you 
are considering. 

Specify Inputs for Uniform Distribution 
1. In the Uncertainty : Specify Distributions window, select the 

Uniform (rectangular) distribution by following the instructions in 
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“Select a Distribution Type” above. The Uniform distribution 
displays in the graphical display box. 

2. To set the lower cutoff, click and drag the bullet-shaped sliders to 
the value you want on the x-axis. 

3. To set the upper cutoff, click and drag the slider to the value you 
want on the x-axis. 

Note:  You can also select the values by clicking on the up and 
down arrows next to the corresponding numeric text box for the 
upper or lower cutoff, or entering values directly in those text 
boxes.  

Specify Inputs for Triangle Distribution 
1. In the Uncertainty : Specify Distributions window, select the 

Triangle distribution by following the instructions in “Select a 
Distribution Type” above. The Triangle distribution displays in the 
graphical display box. 

2. To set the upper and lower cutoffs, click and drag the bullet-
shaped sliders to the values you want on the x-axis. 

3. To set the mode (peak of triangle), click and drag the center slider 
to the value you want on the x-axis. The red triangle is fixed at the 
rating you entered in the Criterion Rating screen. 

Note:  You can also select the values by clicking on the up and 
down arrows next to the numeric box for the upper or lower 
cutoff. 

Specify Inputs for Normal and Log-Normal Distributions 
1. In the Uncertainty : Specify Distributions window, select the 

Normal (Gaussian) or Log-normal distribution by following the 
instructions in “Select a Distribution Type” above. The 
distribution displays in the graphical display box. 

2. To set the upper and lower cutoffs, click and drag the bullet-
shaped sliders to the values you want on the x-axis. 
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3. To set the mean (second slider from the left), click and drag the 
slider to the value you want on the x-axis. 

4. To set the standard deviation (third slider from the left), click and 
drag the slider to the value you want on the x-axis. 

Note:  You can also select the values by clicking on the up and 
down arrows next to the numeric box for each parameter. 

Specify Inputs for Custom Distribution 
By selecting the Custom distribution, you can define your own 
distribution. Initially, this distribution displays with four line segments 
that you can customize by adding new points up to a total of ten.  

1. In the Uncertainty : Specify Distributions window, select the 
Custom distribution by following the instructions in “Select a 
Distribution Type” above. The Custom distribution displays in the 
graphical display box. 

2. To change either of the two points that appear on the graph, click 
and drag the points to any value on the graph. Note that the 
selected point turns blue and the x (weight value) and y 
(probability) value for each point displays in the Value box. 

3. To add up to a maximum of 10 points, double-click on the graph 
in the spot or the value you want. 

Note:  Although you can move these points by clicking and 
dragging them, you cannot move a point horizontally beyond its 
two adjacent points. You can select the values by clicking on the 
up and down arrows next to the numeric box for each parameter. 

Selecting Another Rating 
You can repeat the steps above for any rating of an alternative with 
respect to an attribute. First, select the weight in the Uncertainty 
window. 
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1. To select the next attribute in the Uncertainty Specify 
Distributions window, in the Current Value box of the Uncertainty 
window, Click the Next button alongside the Attribute list box. 

2. To select the next alternative, Click the Next button in the 
Alternatives list box. 

What’s Next? 

Now you’re ready to review your results. Turn to Chapter 12, Review 
the Results, for instructions. 
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Reviewing the Results as Part of the Decision Process 

Where are you?  You are in the shaded part of the Process Diagram 
below: 

Brainstorm
 the Problem

Select Uncertainty

Analyze the Results

Review the Results

Rate the Hierarchy

Build the 
Hierarchy

Document 
the Results

Process Diagram
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Reviewing Your Decision Scores 

The basic results of your model are the decision scores. The decision 
score for an alternative is the sum of  the score (rating) of that 
alternative with respect to each of the lowest criteria (attribute) 
weighted by how important each such criterion is in the model. The 
higher the decision score of the alternative, the closer that alternative 
comes to meeting all the criteria in the decision. 

Displaying the Decision Scores Window 

• From the Hierarchy window menu, select Decision Scores from 
the Results menu. 
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Decision Score Window Description 
The Decision Score window has five primary areas: the Graphical 
Display, Show Options, Sort Options, Value Options, and the general 
control areas. 

Graphical Display Box  This box shows the decision score for each 
alternative of your decision model in a horizontal bar chart. Each line 
shows the name of the alternative, the value of the decision score, and 
the horizontal bar reflecting the value of the decision score.  At a 
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glance, the alternative with the longest bar best meets your criteria.  
Sometimes, not all alternatives will fit on the window, and you need to 
scroll the Graphical Display vertically to other alternatives. 

Show Options   The controls in this area allow you to show the Ideal 
Alternative. (The Show Uncertainty options are discussed in the next 
section, “Viewing Uncertainty Results.”) 

Sort Options  The option buttons here allow you to sort the 
Alternatives vertically by decision score or by the ratings of the 
alternatives against any single lowest criterion or unsort them (the 
default).  (The Sort by Uncertainty options are discussed in the next 
section, “Viewing Uncertainty Results.”) 

Value Options  The option buttons here allow you to display 
numerical values other than decision scores (the default) in the 
Graphical Display area.  You can choose to show the value of the 
ratings of the alternatives under any lowest criterion (attribute), and 
you can choose to have the values shown cumulatively. 

Show Failed Rule  If an alternative has violated a rule you defined in 
the Criterion Rating window (Chapter 10, Weight the Criteria), you 
can review that rule in the general control box. 

Arranging Windows 
Throughout CDP, you have the option of displaying more than one 
result window at a time. As you open each new window, it overlays 
previously opened windows. You can arrange several windows by 
using the Cascade or Tile command from the Window menu, and 
resize each window so you can see most of all windows. When you 
resize, the displays become smaller for better viewing, though features 
may degrade. You can minimize windows and you can close all 
windows except for the Hierarchy window. Closing the Hierarchy 
window closes the model.  
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How Decision Scores are Calculated 

Here we provide a number of algorithms that describe the basic 
calculations in DecisionPlus, and provide some details regarding the 
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updating of windows after information is edited. You may want to skip 
this section for now and return to it later, after having read the rest of 
Chapters 12 and Chapter 13. 

Decision Score of an Alternative 
As discussed in previous sections, the user rates each alternative 
against each lowest criterion (or attribute) as a score with respect to a 
user-defined scale associated with that lowest criterion. That score is 
then normalized (converted to a priority) and multiplied by the 
normalized weight of the criterion. Finally all such terms are 
aggregated (summed) over all lowest criteria to give the Decision (or 
aggregate) score for that Alternative. 

Normalization of scales to priorities - weights 

How the user's judgments are normalized to a standard internal scale 
depends on the type of Comparison (Direct or Pairwise) and, for the 
rating of Alternatives, the model methodology (AHP or SMART) 
chosen. 

1) Direct Comparison: Converting user's weighting scale to internal 
priority scale: 

 Let S be a subcriteria to criteria C.  Let rS
C  be the user's 

rating of subcriteria S under criteria C.  Then the priority 
of S under C, WS

C , is given by: 

  
WS

C rS
C r C

S

NC
rS

C r C= −
′=
∑ ′

−( ) / ( )0 1 0  

  where  r C
0  is the user defined scale minimum. 
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2) Direct Comparison: Converting user's score (for alternatives) scale 
to internal priority scale: 

Let A be an alternative to be measured against criteria C.  
Let rA

C  be the user's rating of alternative A under criteria 

C.  Then the priority of A under C, PA
C , is given by: 

  PA
C rA

C r C
A

NC
rA

C r C= −
′=
∑ ′

−( ) / ( )0 1 0  

where  r A
0  is the user-defined scale minimum. 

3) Pairwise Comparison (Always available for weighting Criteria, 
available for rating Alternatives only when AHP methodology is 
chosen) 

Here the user compares a subcriterion C1 against another C2 in terms 
of a set scale that ranges from 1 to 9, where a score of 3, indicates that 
C1 is 3 times "more important" than C2 in terms of the parent 
criterion.   

For a parent criterion with N subcriteria, the relative weighing of the 
subcriteria will then result in an NxN comparison matrix whose 
elements Aij have the interpretation that Ci is Aij more important than 
Cj. 

Converting this matrix of comparisons to a normalized set of weights 
for the subcriteria is achieved (in standard AHP) by the use of a most 
interesting formula using principal eigen-values. The proof that this 
conversion is valid is essentially the success that the AHP has had in 
capturing qualitative judgments. See the reference Multicriteria 
Decision Making - The Analytical Hierarchy Process - Applications 
and Studies for a complete discussion. 
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Normalization of scales to priorities - ratings  

AHP The Analytic Hierarchy Process, for Direct Comparisons, 
reduces to the relative normalization in (iii). Essentially this has the 
form: 

 P = (r- r0)/(r-r0 + residue) 

where r is a given rating, r0 the minimum value of the scale, and 
residue is the sum over the terms from all other alternatives in the 
rating set. The 
equation maps the 
users scale non-
linearly to [0,1], as 
sketched opposite. 

SMART The user defines a mathematical function called a value 
function. The Value Function maps directly from the user’s scale range 
to [0,1]. 

The curve 
shown 
opposite 
would 
indicate a risk averse scale, and could have an exponential format. 

 

The curve 
shown 
opposite is 
linear. 

 

The curve shown 
opposite indicates a 
risk affinitive scale 
and again could be 
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               represented by an  
               exponential curve. 

Since the value function is defined on the scale itself, the priority of an 
alternative is now independent of the other alternatives: 

  
PA

C FC r C rM
C rA

C= ( , ; )0  

Aggregation of terms into the decision score 

For a model with a single layer of criteria, the decision score of an 
alternative is the weighted sum of scores on each alternative: 

   D W PA C
G

C

N G

A
C=

=
∑

1

 

where G is the Goal or decision and NG is the number of subcriteria of 
the Goal, WC

G  is the priority of the Criterion C, and PA
C  the priority 

of the score of alternative A with respect to criterion C.   

For hierarchies of M levels of criteria (including the Goal), the 
formula reads as: 

D W
N

W W
NN

P

A
N

P

A C
G

G

C
C

C
C

M

CC

A
CM

C

M

C

A
C

C CC

C

M

M

M

M

M

M
G

= ∑

= ∑

= ==

=

∑ ∑ −

1 2

1 1

1

1 21 11

1

....
 

Essentially the decision score for alternative A is given by the priority 
PA

CM , of the alternative against each lowest criterion (attribute), times 

AG
CM , the accumulated weight of that criteria, summed over all 

lowest criteria.   



Chapter 12 Review the Results 

256 Criterium DecisionPlus 

Accumulated weights  

The accumulated weight of any criterion is the product of normalized 
weights along each path from the Goal block to that Criterion, 
summed over all such paths. (In Criterium DecisionPlus, the 
accumulated weights for all criteria in a model may be seen in the 
Hierarchy window by using the Show Accum. Weights menu item in 
the Model menu.) 

The accumulated weight of a lowest criterion is also called the Model 
Weight of that criterion, as it represents the normalized weight of the 
lowest criterion in the decision model. The values of the Model 
Weights and normalized ratings of the alternatives may be seen 
directly in the Data View of the Decision Results window. The 
Decision Score of each alternative (the number at the bottom of each 
column) is the sum, over all lowest criteria (attribute) of each 
normalized rating times the model weight.   

Updating Results (Updating) 
In DecisionPlus, actual calculation of your model’s decision score 
results occurs automatically when you open any results or analysis 
window. If any results or analysis windows are open, and you change 
ratings in the model using the Criterion Ratings window, all such 
screens will be updated automatically (unless you have chosen 
otherwise - see Chapter 10 and Options). 

Calculating the decision scores of the alternatives does not take much 
time. However, when you want to view sensitivity or uncertainty in 
your model, calculations of these results can take a long time 
depending on the size of your model. We let you choose when you 
want to start that update process by letting you select an update button. 
A message appears on each results or analysis window to remind you, 
if an update is necessary, allowing you the opportunity to make any 
last minute changes to include in the update. 



Chapter 12 Review the Results 

Criterium DecisionPlus 257 

Fully Connected Models 

If a criterion in your model is not at least indirectly connected both to 
the Goal and to at least one alternative, the decision scores of the 
alternatives would be difficult to interpret. DecisionPlus only 
calculates results for “"fully connected” models, such as models in 
which every criterion is both connected to the Goal and to at least one 
alternative. If you attempt to open a Result or Analysis screen when 
the model is not fully connected, DecisionPlus will identify the 
unconnected blocks in the hierarchy so that you can proceed to 
connect them. 

How Unrated Criteria are Prioritized 

If you have not fully rated your criteria (i.e., all the items in the rating 
set), DecisionPlus assigns all items an equal priority score according to 
the number of items in the rating set. 

For example, with a  criterion with four unrated subcriteria, each 
subcriterion would receive a priority of 1/4 =0.25. Subcriteria of a 
criterion with six unrated children would have a ranking of 1/6 each, 
etc. These priorities are then used in calculating the overall decision 
scores for each alternative.  

Rank Reversal Phenomenon when Using AHP 
An important consequence of the relative normalization of the scores 
of alternatives used in AHP normalization, whether direct or pairwise 
rating methods is used, is that relative order in rank of the alternative 
preferences can change when adding new alternatives. This is called 
rank reversal and is caused by the normalization of the scores on the 
lowest criteria. If an alternative is added to the model whose over all 
decision score is low, but scores well on criteria where the highest 
ranked preferred alternative has had the highest scores, then this new 
alternative receives a large share of those priorities. This can 
sometimes affect the weight of the preferred alternative in a way that 
results in the preferred alternative losing its position, causing a 
reversal of rank. 
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For example, imagine you were choosing which car to buy, you 
created and rated a decision model, and a BMW was leading slightly 
over a Porsche.  At that point your spouse insists you consider a Neon.   
Though the Neon scores poorly overall, you might discover that after 
its addition, the Porsche now has edged the BMW as your best choice.   

Rank Reversal emphasizes that in AHP, the outcome of the decision 
model depends on the specific set of alternatives you are considering.  
Since the value functions in SMART are defined on the scales of the 
criteria, they are independent of the alternatives, and the decision score 
provides an independent metric of how well alternatives fit your 
criteria.  

Enhanced Views of Decision Score Results 

Display the Ideal Alternative 
The ideal solution to your decision problem is the “perfect alternative” 
that rates the highest possible value for each criterion in your model. 
In the Decision Scores window, you can compare the alternatives 
under consideration to the perfect solution. In the light of this 
comparison, you might find that none of those alternatives comes close 
to the ideal, and you might decide to search for new alternatives. 

1. In the Decision Scores window, select Show Ideal. The ideal 
alternative displays. 

2. To remove the ideal alternative, select Show Ideal again. 

Note: Under SMART, the ideal alternative always scores 1.0, 
so there is no mystery.   Under AHP, the ideal alternative may 
have a score considerably less than 1.0. 

Show Uncertainties 
The options for showing uncertainties will be described in the section 
“Uncertainty Results in the Decision Scores window” later in this 
chapter. 
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Review a Failed Rule 
If you entered rules for your lowest criteria, and any of those rules are 
violated by an alternative, you can view them in this window. When 
an alternative violates at least one rule, its decision score bar appears 
in red, and the Show Failed Rule button is enabled. The following 
steps allow you to view the failed rules: 

 

1. In the Decision Scores window, select Show Failed Rule in the 
General box. Violated rules and alternatives violating them display 
in the Failed Rules dialog box. 

 Any alternative that failed a rule is listed in the upper list box, and 
the rule(s) they failed are listed in the lower list box. The text of 
the chosen rule for the chosen alternative is displayed in the text 
area at the bottom of the window, followed by the actual situation.  

2. To close the dialog box, select the close button. 
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Sorting Decision Scores Results 

Sort the Decision Score Graph by Preference 
You can order the results so they appear in the window from best 
(highest decision score) to least. This feature allows you to view the 
best rated alternatives first.  

1. In the Decision Scores window, in the Sort area, select Decision 
Scores. The graphical box displays the results rearranged in order 
of decreasing decision score. 

Sort Decision Scores by Uncertainty 
The definition of the 5% mean and 95% uncertainty intervals will be 

given in the following section. To sort the alternatives according 
to decreasing values of any one of those parameters: 

 1. In the Decision Scores window, in the Sort area, click the option 
button corresponding to your desired parameter. The graphical box 
displays the results rearranged in order. 

Sort Decision Scores by any Criterion 
1. In the Decision Scores window, in the Sort area, Click the option 

button labeled criteria, then choose the criterion of interest from 
the drop-down list box. The graphical box displays the results 
rearranged in order. 

Close the Failed Rules window. 
2. To remove the sort, select Sort Results again. The results return to 

the original order. 

Hide Options button 
The various option setting devices above allow you to quickly set the 
result options the way you want them. However the buttons, option 
boxes and list boxes take up a lot of screen space.   
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Clicking the Hide Options button will hide the various controls that set 
options for the Decision Scores window. This will significantly 
increase the available space for graphics, which is particularly useful 
when you have large numbers of Alternatives. 

Resource Tracking 

When the decision task is to select more than a single alternative, you 
may wish to choose as many of the highest scoring alternatives as your 
resources allow. For instance, if each alternative has a cost, and you 
have a budget, you may only be able to afford the first 5 items in your 
prioritized list. 

The Decision Scores window in DecisionPlus is a powerful tool for 
determining which are the best alternatives your limited resource can 
afford. By sorting the results by their desirability, then showing the 
cumulative amount of your resource required to afford all alternatives, 
starting with the most desirable, you can clearly determine where your 
budget would be exhausted. 

1. In the Decision Scores window, select the Score option in the 
Sort options. Each alternative's decision score provides the 
overall measure of its worth having taken all criteria into 
account. Sorting the alternatives by decreasing decision scores 
therefore places the most desirable alternatives at the top of 
the decision scores graph, the least desirable at the bottom. 

Note: If you are using uncertainty distributions, you should 
sort by the Mean decision score, not by decision scores (see 
To Sort Decision Scores By Uncertainty Results later in this 
chapter). 

2. In the Values area click the Attribute Ratings option. The 
adjoining listbox will be enabled. 

3.    From the listbox, select the Lowest Criterion corresponding to 
your limiting resource. The rating of each alternative appears 
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to the left of the corresponding graphical bar, replacing the 
decision score value. 

4. If the Cumulative checkbox is clear, click it to check it. The 
rating of each alternative for the selected criterion is added to 
a cumulative total running from the top (most desirable) 
alternative to the least. 

5. By checking the cumulative value against your resource limit, 
it should be clear which is the last alternative that, together 
with its higher scoring companions, you can afford. 

Viewing Uncertainty Results 

This section shows you how to access results of assigned uncertainty 
distributions in your decision models. Without uncertainty, each 
alternative has as its result a single decision score. Once uncertainties 
are assigned to any of the weights/ratings of an alternative with respect 
to the lowest criterion, that alternative could have a number of 
different decision scores in the model. For each alternative, 
DecisionPlus considers each possible decision score in turn and 
calculates, given the uncertainties in the information about that 
alternative, the probability that the alternative could have that score. 
The probability for all the decision scores are compiled into a 
histogram, or uncertainty distribution. 

Displaying the Uncertainty Results Window 

 In the Hierarchy window, select Uncertainty in Decision Scores 
from the Results menu. 

 When you first enter the window, it will not display any of your 
model’s information until you update results.  
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To Update the Uncertainty Results 
1. In the Uncertainty window, select Update Results. The program 
calculates the results, which may take a few minutes depending on the 
size of your decision model, and displays them as overlapping 
distributions for each of the five top alternatives. 

  

Uncertainty in Decision Scores Window Description 
There are two primary areas in the Uncertainty in Decision Scores 
window: the Graphical Display box below and the General Control 
box.  

Graphical Display  You can use this box to update the results in your 
decision model through the Update Results button below. This box 
displays your results as (usually) overlapping distributions for the five 
top scoring alternatives in your model. You can compare the 
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alternatives’ uncertainty distributions with a best and worst case 
analysis using the Best/Worst button, or return to the Decision Score 
window and view the alternatives in a bar graph. 

General Control   This part of the window provides the window 
Close, Information and Help buttons standard to the results and 
analysis windows. The Information button displays a list of your 
model’s goal, criteria, and alternatives, and any attached notes. 

Your model’s distributions may not look like the ones you assigned 
because the results reflect the total aggregation of uncertainties in the 
model. Distributions with small variances generally result in more 
spiked, localized distributions, whereas distributions with large 
variances produce more spread-out results. Below is a very symbolic 
representation of uncertainty aggregation. 

  
Representation of Uncertainty Aggregation 

To Edit the Uncertainty Inputs 
1. In the Uncertainty Results window, select Edit Uncertainties to 

open the Uncertainty Input window.  

2. Edit the uncertainty inputs as described in Chapter 11. 

3. Close the Uncertainty Input window. 
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To View the Uncertainty Results in Spreadsheet Format 
The data underlying the Uncertainty in Decision Scores window 
distributions may be seen directly by changing to the data sheet 
format.  Data can also be copied from this view to any other Windows 
application, which might facilitate custom graphing and analysis. 

1. In the Uncertainty in Decision Scores window, select Results 
Data from the View menu. 

 The names of the 5 (or fewer) Alternatives with the highest 
mean decision scores are listed across the top of the 
spreadsheet.   

 In the first twelve lines, relevant statistical parameters for the 
distribution curves are recorded: Mean, Lower Bound, Upper 
Bound, Std. Deviation, Mode, Median, Skewness, Kurtosis, 
Min. Y (Probability), Max.Y. 

 The actual distributions' data points are listed below that. The 
Right hand column lists the decision scores from 0 to 1 in 
increments of 0.005, successive columns providing the 
likelihood that each alternative would achieve that decision 
score (in Uncertainty Densities view). 

1. To return the graphical representation of the Uncertainties in 
Decision Scores window, choose Uncertainty Graph from 
View menu. 

To Compare Uncertainty Results to Decision Scores 

Naturally, you would expect the likeliest decision score according to 
the uncertainty distribution of an alternative to be close to the decision 
score of that alternative without uncertainty. Often they can differ by a 
wide margin, and understanding these differences can vastly improve 
your understanding of the uncertainties and risk inherent in the model. 

1. To compare directly the uncertainty results to the decision 
score results without uncertainty, redisplay the Decision 
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Scores window (follow the instructions for “Displaying the 
Decision Score Window” at the beginning of this chapter).  

2.  Click the Uncertainty check box in the Show area of the 
Decision Score window. Gray rectangles are superimposed on 
the decision score bars of each alternative. The lengths of the 
blue decision score bars themselves are still calculated based 
on the weights (and ratings) you entered, without regard to 
uncertainty, so they are unchanged.  

  

The left edge of the gray rectangle shows that decision score value 
corresponding to the lower 5 percentile of the uncertainty distribution. 
That is, with 95% probability, that particular alternative has a decision 
score with higher value than that. The right hand side is given by the 
95 percentile, and the vertical line within the gray rectangle shows the 
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mean (expected) decision score for the alternative when uncertainty is 
taken into account. 

To Select Each vs. Best Alternative % or Absolute % Option 
1. In the Decision Scores window, select the option you want. 

 Each vs. Best Alt%   This option displays a percentage at the 
end of each bar. This shows what percent of the time each 
alternative in turn is better than the “best” alternative, that with 
the highest mean decision score. For example, another 
alternative might be better than this best alternative 30% of the 
time. (By default, the best alternative is better than itself 50% of 
the time.) 

 When a decision must be made from the available alternatives, 
these comparisons clarify, based on the known uncertainties in 
the model, which alternative is statistically the better choice.  

 Absolute %  The Absolute % option also displays a percentage 
at the end of each bar. In this case the number represents what 
percent of the time the alternative would be a better choice than 
all of the other alternatives taken together. 

 If you have the option of adding alternatives to the decision, 
these numbers indicate whether any of the present alternatives 
truly stands out from the rest, in which case the decision process 
may be terminated. If not, you might search for additional, better 
alternatives. 

2. To remove the uncertainty results, click the Uncertainty check box 
again to uncheck it. 

To View the Decision Scores in Spreadsheet Format  

The data underlying the Decision Scores window may be seen directly 
by changing to the data sheet format. Data can also be copied from this 
view to any other Windows application. 
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1. In the Decision Scores window, select Results Data from the 
View menu. 

The names of the Alternatives are listed across the top of the 
spreadsheet, and those of the Lowest Criteria along the left-hand side.  
The priority value of each Alternative with respect to each lowest 
criterion is shown in the corresponding cell. The model weight of each 
lowest criterion is shown in the last column on the left. The Decision 
Score for each Alternative is shown at the bottom of each column, and 
is the sum of the priorities with respect to each lowest criterion 
multiplied by the model weight of that criterion. 

If the Show Uncertainties box is clicked, relevant information 
pertaining to the uncertainty distributions is also listed. 

Return to Graphical View 

1. To return the graphical representation of the Decision Scores 
window, choose Results Graph from View menu. 

Exporting Results from Decision Scores Window 

One way to create custom reports is to use a wordprocessor and copy 
and paste graphics and data from DecisionPlus to that application.  
DecisionPlus allows you to copy Graphs, Tables and create DDE links 
to other applications.   

"Hot" Link to other applications 

DecisionPlus presently supports "hot" DDE link only of the Decision 
Scores data to another windows application.  The Decision Scores data 
sheet may be linked in its entirety from CDP to another spreadsheet.  
Note that the decision scores spreadsheet contains both decision scores 
and uncertainty in decision scores data. 

To create a DDE link of Decision Scores data to another application: 

1. In the Data view of the Decision Scores window, choose Select 
All from the Edit menu,  



Chapter 12 Review the Results 

Criterium DecisionPlus 269 

2. Select Copy from the same menu.   

3. In the target application (e.g. Excel), choose any appropriate range 
of cells and choose Paste Link or its equivalent (see that application's 
documentation).   

Any change in the DecisionPlus model that changes the numerical 
values of the decision scores or uncertainty results, will then 
automatically cause the target application's data to be updated. 

Note: Only one "live" link is supported at a time. Creating a 
new link will destroy the existing link. If a model is closed, 
the link must be recreated by hand when the model is next 
loaded.  Data pertaining to the link is stored in the note of the 
Goal Block. The time and date when the link was established, 
and the file with which it was established is recorded. 

Decision Scores Menu Commands 

File    

Close  Closes the Decision Scores window. 

Print Preview  Allows you to view on screen the results of your 
document. 

Print  Prints the contents of the active file. Opens the print dialog 
box to set printing options for your item or report.   

Export Decision Scores to Excel  Exports the results of the active 
window’s spreadsheet to Excel. This option is only available 
from Decision Scores, Uncertainty in Decision Scores, and 
Hierarchy spreadsheets.  

Export to Text File  Exports the results of the active file to a text file. 

Exit  Exits DecisionPlus. 

Edit 
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The following Edit menu sub-item is only available when viewing the 
decision scores graph. 

Copy Graph  Copies Decision Scores graph to the Windows 
Clipboard for Pasting to other applications. 

The following Edit menu sub-items are only available when viewing 
the data spreadsheet format. 

Copy  Click this menu item to copy data in the Decision Scores 
spreadsheet to the Windows Clipboard. 

Select All  Selects all data in the Decision Scores spreadsheet. 

View    

Results Data  Click this menu item to display the active model 
results in data spreadsheet format.   

Results Graph  Click this menu item to display the active model 
results in bar graph format. 

Show Toolbar  Checking this menu item displays the command 
toolbar, un-checking it hides the toolbar. 

Show Toolbar Detail  If the toolbar is visible, determines whether 
the button icons have short text descriptions beneath them.  
Turning on the text descriptions of toolbar items significantly 
increases the screen size of the toolbar. 

Analysis 

Group Tag Level  Selects the level to be used as to tag criteria. 

Tag By First Letter Only  Tags criteria only with the first letter of 
criteria from the tagged branch. Tagging is explained in full in 
Chapter 13. 

Uncertainty in Decision Scores Menu Commands 

This window has the same File menu options as the Decision Scores 
menu commands above.  
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Edit 

The following Edit menu sub-item is only available when viewing the 
uncertainty in decision scores graph. 

Copy Graph  Copies Uncertainty in Decision Scores graph to the 
Windows Clipboard for Pasting to other applications. 

The following Edit menu sub-items are only available when viewing 
the data spreadsheet format. 

Copy  Click this menu item to copy data in the Uncertainty in 
Decision Scores spreadsheet to the Windows Clipboard. 

Select All  Selects all data in the Uncertainty in Decision Scores 
spreadsheet. 

View    

Uncertainty Data/Graph  Shows your scores in data or graph format. 

Density Distribution  Shows the probability of getting a score falling 
within a unit interval. 

Cumulative Distribution  Shows the probability of the alternatives 
being less than a given value on the decision score axis. 

Reverse Distribution  Shows the cumulative distribution in reverse, 
such as the probability of the alternatives’ decision score 
being greater than the value on the decision score axis. 

Curve Options  Allows you to set the appearance of the distribution 
curves on the screen. 

 Line Curves  Shows the outlines of your curves. 

 Solid Curves  Fills in your curves in solid colors. 

Show Toolbar  Displays toolbar of select commands in layout at top 
of screen.  

Show Toolbar Detail  If the toolbar is visible, provides brief written 
descriptions of toolbar items.  
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The Analysis Windows Toolbar 

When you are in any of the results or analysis windows, and the 
toolbar is visible, you will notice that it is different than when you 
were in the Hierarchy window. 

The icons, left to right, are: 

24. The Print Icon. Brings up the Print Dialog window. 

25. The Print Preview icon. Brings up the Print Preview of whatever 
window you are in. 

26. The Hierarchy Icon. Brings the Hierarchy Window to the fore. 

27. The Results window. Opens the Decision Scores window 

28. The Uncertainty Results window. Opens it. 

29. The Sensitivity Analysis window. Opens it. 

30. The Contributions window. Opens it. 

31. The Alternatives Scatter window. Opens it. 

32. The Tradeoffs of Lowest Criteria window. Opens it. 

33. The Contributions to Uncertainty window. Opens it. 

Hiding Toolbar icons and/or text 
As usual, checking the menu item Show Toolbar on the View menu determines 
whether the toolbar is visible or not. If the toolbar is visible, checking the Show 
Toolbar Detail determines whether the text label appears under each toolbar icon. 
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What’s Next? 

You can turn to Chapter 13, Check Reasonableness and Analyze, to 
understand and validate your initial decision results, or you can turn to 
Chapter 13, Document the Results, to print specific results of your 
decision model. 
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Analyze the Results as Part of the Decision Process 

Where are you? You are in the shaded part of the Process Diagram 
below: 

   
 

Brainstorm
 the Problem

Select Uncertainty

Analyze the Results

Review the Results

Rate the Hierarchy

Build the 
Hierarchy

Document 
the Results

Process Diagram
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Analyzing Your Results 

Once you review the results, if you’re like most decision-makers, you 
probably ask yourself, “Is my decision a reasonable one?” “Does the 
model I created really capture my thinking?” or “How dependable is 
this outcome?” DecisionPlus helps you answer these concerns by 
providing four tools you can use to analyze your results: Contribution 
by Criteria, Sensitivity by Weights, Tradeoff of Lowest Criteria and 
Contribution by Uncertainty. 

Viewing Contribution by Criteria Window 

Having weighted the criteria, you expect those with the highest 
accumulated weight to contribute more toward the results than others.  
However, if all the alternatives score low on those criteria, those 
criteria’s contribution to the total decision score of each alternative 
may be less than you imagined. Through DecisionPlus’s contribution 
by criteria analysis, you can easily see which criteria actually made the 
largest contribution in your decision and which made the least. This 
discovery may indicate whether your decision is or is not a reasonable 
one: are your weights sensible? Do your scales have the proper 
orientation? 

Display the Contribution by Criteria Window 
1. In the Hierarchy window, select Analysis from the menu bar.  

2. Select Contribution by Criteria to display the Contribution by 
Criteria window. 
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Contribution by Criteria Window Description 
The Contribution by Criteria window has three primary areas: a 
graphical presentation area, an area allowing you to select both the 
target criterion and the contributing criterion level, and an area 
allowing you to select a tag level. 

Graphical Area This portion of the window shows, in the Stacked 
Bar default graph style, stacked histograms of the Accumulated Values  
of the alternatives at a target criterion (usually the Goal), broken-down 
by the contribution (shown as a color coded strip) from each of the 
criterion in a selected level.  



Chapter 13 Check Reasonableness and Analyze 

280 Criterium DecisionPlus 

Accumulated Values are a generalization of decision scores. The 
decision score for an alternative in the model is the sum of all the 
ratings of that alternative against each lowest criterion, weighted by 
the importance of that criterion to the decision. If you imagine the 
hierarchy as a network of waterways flowing from the alternative to 
the Goal, the decision scores are the accumulation of the flows along 
all pathways from that alternative to the Goal. The Accumulated Value 
for any criterion (not just the Goal), and for a given alternative, is the 
accumulation of the flows along all pathways from that alternative to 
that criterion. Here in the graphical area, the height of each 
alternative’s histogram bar is the Accumulated Value for that 
alternative at the target criterion. 

Criterion Name  In this box, you can select the target criterion at 
which you wish to analyze the decision scores of the alternatives. 

Level Name  In this box, you can select the level by whose criteria’s 
contributions you wish to breakdown the Accumulated Values of the 
target criterion. 

Tag Level  This area allows you to select a level (if any), the names of 
whose criteria will prefix the names of all criteria in levels below that 
tag level.  The First Letter Only checkbox allows you to choose to use 
only the first letter of the criteria names in the tag level as prefixes for 
lower criteria names.  

View Menu 

Graph Style  Allows you to choose one of four graph styles – stacked 
bar, radar, pie and trend. 

Legend  Choose if you want a legend, and place it to the left, top, right 
or bottom of graph. 

Alt Labels  Lets you choose if you want the names of the alternatives 
as labels, and orient them horizontally or vertically, or let the 
program orient them automatically. 
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Options Menu 

Dimensions – All Alternatives  Information on all alternatives will be 
shown in the graphs. 

Dimensions – All Criteria Information from all criteria in the target 
level will be shown in the graphs. 

Dimensions - Defaults  If there are more than seven criteria in a level, 
it shows the contributions from the first six, and lumps all the 
rest under “others.” If there are more than seven alternatives, it 
shows seven at a time, and you must scroll to see a different 
seven. 

To Close the Contribution by Criteria Window 
• Select the Close button. This closes the window and returns to the 

previous window. 

Selecting the Target Criterion and Level 
When you first open the Contributions by Criteria window, the default 
settings are the Goal for the target criterion and the level immediately 
below the Goal for the contributing level. You can select both the 
target criterion and the contributing level in the Contribution by 
Criteria window in the following manner: 

• In the Contribution by Criteria window, select the target criterion 
you want to analyze from the Criterion Name list box in the lower 
left of the window. 

• In the Contribution by Criteria window, select the level of detail 
you want in the analysis from the Level Name list box in the lower 
left of the window. 

The histogram displays the contributions from each criterion in the 
contributing level to the Accumulated Weights of each alternative at 
the target criterion. The Contribution by Criteria plot shows the 
alternatives five at a time, starting with those with the highest decision 
score. Use the horizontal scroll bars to access additional alternatives. 
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Note: You can not choose a target criterion/contributing level 
combination where the target criterion would lie below the 
contributing level (i.e., further from the Goal). 

To Copy the Contributions Graph and Data 
To copy the actual contributions graph or its underlying data to the 
Windows Clipboard, for insertion in other applications, do the 
following. 

1. From the Edit menu in the Contributions by Criteria window, 
choose Copy Graph. A bitmap copy of the graph area is copied to 
the Windows’ clipboard. 

or 

From the Edit menu in the Contributions by Criteria window, choose 
Copy Data. A tab-delimited copy of the underlying data is copied 
to the Windows’ clipboard. 

2. In your target application, paste (see that application’s relevant 
documentation) the bitmap or data table.   

Contribution by Criteria Radar Graph 

To see the Contributions by Criteria window in radar style, click the 
item Graph Style under the View menu and click Radar. 

The radar graph style is very useful for identifying unique alternatives.  
Very often the majority of alternatives are essentially slight variations 
of a few distinctive alternative primitives. 
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It is clear from the above radar graph, that the Toyota and BMW 
models are radically different primitives, taking their strengths from 
almost complimentary attributes. The Ford model is a hybrid solution 
scoring well across all attributes. 

Knowing whether the top scoring alternatives are of a common 
primitive is very important in winner take all decisions. If they are so 
similar, there is no great risk in choosing one over the other. If the top 
two scoring alternatives are from radically different primitives, which 
just happen to have near equal aggregate decision scores, then the 
choice between them is a radical one, with high potential risk if any 
underlying assumptions prove erroneous. 

Contribution by Criteria Pie Graph 

To see the Contributions by Criteria window in pie graph style, click 
the item Graph Style under the View menu and click Pie. 
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Your eye is nature’s most effective pattern matching device.  The 
alternatives, in all of the Graph styles are ordered by decreasing 
Accumulated Values. In problems where there are many alternatives, 
the Pie Graph style allows your eye free rein to discern visual 
correlations between distinct primitives and high decision scores. 

Tagging Criteria by Tag Level Names 

As discussed in the chapter 10 section regarding Group Decision-
Making, there is a need to be able tag the names of lower criteria by 
the names of higher criteria. This can be achieved using the Tag Level 
functionality. 

Selecting the Tag Level 
The criteria contributing to a score may now be tagged by related 
criteria at a higher level. This is very useful when various criteria have 
the same name, e.g., cost, but refer to costs of different types. 

The tag level is chosen from a listbox of levels, and the name of a 
criterion at that level will appear before the names of criteria in that 
criterion's branch.  
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1. In the Contribution by Criteria window, select the level you want 
to analyze in the Group Tag Level list box in the lower right of the 
window. 

2. If the Tag Level is between the Criteria Level and the Goal, the 
tagging will appear in the Legend. 

Note: When a new model is loaded, the Tag Level is reset to a default 
of none. 

First Letter Only checkbox 

If the names of the tagging criteria are too long, this tagging becomes 
unwieldy, as the prefix:name combination becomes too long to fit in 
most analysis windows. By checking the First Letter Only option, only 
the first letters of the tagging criteria are used - naturally you have to 
choose tagging criteria with differing first letters for this to be useful. 

Note: If no Tag Level is selected this checkbox is disabled. 

Note: The Tag level and First Letter Only option may be set 
through menu items also. See Setting the Tag Level and First 
Letter Only options. 

Setting the Tag Level and First Letter Only Options 
 Through Analysis menu items 

The Tag level and First Letter only option may be set through menu 
items as well as through the Tag Level listbox and First Letter Only 
checkbox on the Contributions by Criteria Window. 

Clicking the Group Tag Level item in the Analysis menu on any of the 
results or analysis windows creates a set of submenus corresponding to 
each of the model levels, or "(None)." If you choose a Tag Level, then 
the Tag By First Letter Only item is enabled in the Analysis menus.  
Choosing no Tag Level i.e., "(None) ," will disable the Tag By First 
Letter Only item.  

Other ways to Set the Tag Level and First Letter Only Options  

• the Criterion Rating window, 
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• the Contributions by Criteria window, 

• the Print and Report Dialog options. 

Analyzing Sensitivity in Your Results 

When you weight a subcriterion with respect to a parent criterion, you 
are giving your decision model the power to discriminate between the 
alternatives under consideration. When you have finished rating the 
model, changing the value of the weight you assigned earlier may 
change the decision scores of the alternatives. This may result in the 
current preferred alternative being replaced by a different alternative. 
If the ordering of the leading alternatives changes at the smallest 
change in a particular weight, then your decision model is said to be 
“sensitive” to that weight. Since many of the weights you enter, 
especially in the more abstract levels of the model nearest the goal, are 
based on qualitative judgments on your part, it is important to 
understand if the model is overly sensitive to such weights.  

Performing Sensitivity Analysis 

Whether you are new to or familiar with decision analysis, it’s easy to 
test how sensitive your results are to changes in weights using 
DecisionPlus. In the Sensitivity Analysis function, you can determine 
the sensitivity of the preferred alternative to changes in the criterion 
weights, or ratings values. Critical changes in the weights or ratings 
are those that cause a change in the preferred alternative and are those 
with which you should be most concerned. The steps below detail how 
to perform sensitivity analysis on your results. 

Display the Sensitivity by Weights Window 
1. In the Hierarchy window, select the Analysis menu. 
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2. From the Analysis menu, select Sensitivity by Weights to display 
the Sensitivity by Weights window.  

  

Sensitivity by Weights Window Description 
The two primary parts of the window are the Sensitivity Plot and the 
Criticality areas.  

Sensitivity Plot   

Priorities  Each weight is identified by the subcriterion (in our 
example, this is Cost) whose weight it is, and the parent criterion (in 
our example, Buy a Car) with respect to which its value is assigned. 
The horizontal axis actually shows the priority of that weight, that is, 
the effective weight (from 0 to 1) the model uses in calculating 
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decision scores. The vertical axis shows the decision score for each 
alternative.  The plot shows how changing the priority value of the 
current weight would affect the decision scores if it is varied over all 
possible values (0 to 1) when all other weights are fixed. The decision 
scores change linearly, so that each alternative is represented by a 
color-coded straight line. 

Vertical Red Line  The vertical red line is at the Current Value, the 
priority corresponding to the value of the weight you entered earlier in 
the Criterion Rating window. The value of that weight, in its own 
units, is shown to the right of the graph in parenthesis. 

Decision Scores  The height of the intersection of the vertical red line 
and the alternatives’ lines gives the decision score that is current for 
each alternative (and as shown in the Decision Scores window). The 
plot shows only lines for five alternatives. If there are more than five 
alternatives in the model, it shows the current preference and the four 
alternatives that would supersede that preference for the smallest 
changes in the weight’s priority. 

Criticality Area  

One useful way to understand the importance of the sensitivity 
analysis is to calculate how much the current value of the priority can 
change before the model’s preferred alternative is superseded by a 
different alternative. At that value, the lines corresponding to the top 
alternative and the upstart alternative will intersect on the Sensitivity 
Plot.  We call this a crossover point, and there may be many or none in 
the Sensitivity plot for a given weight.  We calculate the change in 
priority values from the current value to the closest crossover point, 
then calculate that change as a percentage of the total priority scale. 
We refer to that percentage as the crossover percentage for a given 
weight, and it provides a useful measure of how critical that weight is 
to the outcome of the model. 

The Criticality List Box  The list box shows all weights in the 
decision model, as identified by that weight’s Criterion/Subcriterion 
pair. Beside each pair is the percentage crossover value. In the list box, 
the weights are shown in order of decreasing criticality of their 
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priorities, beginning with the lowest percentage (most critical) 
crossover point. This means that when you open the Sensitivity by 
Weights window, and click the Update button, the plot you see is for 
the weight with the most critical priority in the model. If your model is 
stable (meaning that the current preference does not change with small 

changes in the value of that priority) with respect to that most critical 
priority (such as when the percentage crossover is greater than 5%), 
then it is stable to changes in ALL other priorities in the entire model.  

The Priority Value Slider  Crossover points on the plot are the 
critical points in the decision, especially if they are near the current 
decision point (the red line). The percentage crossover number 
represents the nearness of the closest crossover point. Lower numbers 
indicate a close crossover. By dragging the slider at the bottom of the 
red priority line, you can see directly how changes in the chosen 
weight’s priority affect the decision scores of each of the alternatives. 
As you drag the slider, the temporary value is shown in red to the 
lower left of the graph, and the corresponding weight value is shown 
in parentheses. 
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OS - Off Scale  Because of the relative (AHP) normalization (see the 
discussion on Calculating Decision Scores earlier in this chapter), used 
in the model for criteria above the lowest criteria, the relationship 
between a weight and its corresponding priority is not linear. In 
particular, a priority value of 1 for a given weight can only be attained 
if  

• all other weights in the rating set take their minimum scale 
value or  

• the weight has an infinitely large value.   

Neither situation is common. All scales have an upper limit beyond 
which a weight is not supposed to take values. When such a large 
priority value is reached that only a weight value beyond the scale 
maximum could produce it, that off-scale value is still shown in 
parenthesis but followed by the notation “-OS”. 

Watch the Decision Scores window 

To watch changes to the decision scores directly, open the Decision 
Scores results window and position the sensitivity window so that both 
are visible on your screen. As you move the slider in the Sensitivity 
window, the Decision Scores window shows the updated (based on the 
temporary priority value) score values. (See the discussion at the end 
of the Sensitivity Plot item above). 

 
Note:  The value you give the priority using the slider is not 
saved. When you leave the Sensitivity window, or choose to look 
at a sensitivity plot for a different weight, the weight, and hence 
all, decision scores revert to their true values. Even while you are 
moving the slider, only the decision scores window reflects the 
results of the temporary weight change. 

Reviewing Most Critical to Least Critical in Order 
You can view all the criticalities in the model weights one at a time. 
For each criterion-subcriterion relationship, a plot in the Sensitivity by 
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Weights area of the window shows you the sensitivity of your decision 
to the weights. DecisionPlus lists these relationships in order from the 
most critical to the least critical. 

1. Click on the drop-down list box arrow in the Criticality area. 

2. Select the weight (criterion/subcriterion pair) you want to review. 
The plot in the Sensitivity by Weights area changes to show the 
sensitivity of your decision to this weight. 

Note:  You may also use the Next button to select the next most 
important weight in the decision. When you have reviewed all of 
them, a message tells you there are no more to review.  

Determining Values on the Plot 
You can display the x and y values of any point on the plot by simply 
clicking the Graphical area with your mouse. 

1. To see the values of the weight’s priority (x-axis) or of the 
decision score (y-axis) anywhere on the plot, move the cursor to 
the spot you want and click. 

To Copy the Sensitivity Graph  
To copy the actual sensitivity graph to the Windows Clipboard, for 
insertion in other applications, do the following. 

1. From the Edit menu in the Sensitivity by Weights window, choose 
Copy. A bitmap copy of the graph area is copied to the Windows 
clipboard. 

2. In your target application, paste the bitmap (see that application’s 
relevant documentation) 

To Close the Sensitivity by Weights Window 
1. Click the Close button. This closes the window and returns to the 

Hierarchy window. 
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Viewing Tradeoffs of Lowest Criteria Window 

In any difficult decision, many of the criteria conflict - you desire the 
highest quality at the lowest price. The essence of the multicriteria 
decision is the tradeoff between criteria. For the lowest criteria (or 
attributes), these tradeoffs can often be explicitly calculated in terms of 
the scale units of those criteria. In DecisionPlus, you can see these 
tradeoffs directly in the Tradeoff of Lowest Criteria window. 
Validating these tradeoffs is key to accepting the reasonableness of the 
decision model. 

Display the Contribution by Criteria Window 
1. In the Hierarchy window, select Analysis from the menu bar.  

2. Select Tradeoffs of Lowest Criteria to display the Tradeoffs of 
Lowest Criteria window. 
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Tradeoffs by Lowest Criteria Window Description 
The Contribution by Criteria window has two primary areas: an area 
allowing you to select the Reference Criterion, and a tradeoffs Table 
area. 

Reference Criteria  In this drop-down list box, you can select the 
lowest criterion (attribute) you wish to use as a Reference Criterion 
against whose scale units all other lowest criteria’s scale units will be 
traded off.  When a selection is made, the corresponding row in the 
Tradeoffs Table is highlighted.   

Tradeoffs Table  This display lets you see how you are trading-off the 
lowest criteria against each other. This can be a very good test of the 
reasonableness of your decision model. The Table is divided into five 
columns: 

• Tradeoff  This column gives the numerical value of the 
tradeoff - how many units of each criterion’s scale are 
equivalent to 1 unit of the Reference Criterion’s scale. A 
negative value indicates that this criterion’s scale is defined in 
a negative sense to that of the References Criterion - e.g., an 
increase in the score of the best alternative under the 
Reference Criterion is equivalent to a decrease in its score 
under the criterion of interest. 

• Scale Units  This column gives the name of the units for each 
lowest criterion’s scale, which you defined when rating the 
criterion (as described in Chapter 10). If the scale used was a 
verbal scale, the default numerical scale (0-100) would be 
used instead.  

• Worst  The value of the scale you defined as the worst 
possible. 

• Best  The value of the scale you defined as the best possible. 

• Relative Weight  The ratio of the Model Weights of the 
criterion over that of the Reference Criterion. This indicates 
the relative influence of each lowest criterion on the decision. 
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• Name  The name of the lowest criterion (attribute). 

• Info  Access names of your criteria and any attached notes 
you entered earlier in Brainstorm or Hierarchy. 

To Close the Tradeoffs of lowest Criteria Window 
• Select the Close button. This closes the window and returns to the 

previous window. 

Selecting the Reference Criterion 
You can select a Reference Criterion in the Tradeoffs of Lowest 
Criteria window in either of the following ways: 

• In the Reference Criterion list box above the tradeoffs table, select 
the lowest criterion against which you wish to analyze the 
tradeoffs of the other criteria. 

• In the Tradeoffs Table, to select a lowest criterion as the 
Reference Criterion, simply click any part of the 
corresponding row. 

 If you click the down arrow at the right of the listbox to see a list 
of the Lowest Criteria, you may notice that the name of some are 
followed by the notation (N/A), for Not Available. DecisionPlus 
does not perform a tradeoff analysis for lowest criterion that are 
not fully rated, or for lowest criteria that have been rated using 
pairwise comparisons. If you click on an entry that is listed as Not 
Available, a message will pop up to explain why this is so. 

Analyzing the Tradeoffs Numerically 
The numbers in the Trade-offs Table show the required increase in the 
weight/rating of the preferred alternative under a given lowest 
criterion/attribute to produce the same change as that produced by a 
change of one unit in the weight under the Reference Criterion.  

For example:  In a decision involving, among other criteria, the initial 
cost of a car in thousands of dollars, and the mileage of the car in 
miles per gallon, the decrease in the decision score of the leading 
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alternative incurred by decreasing the mileage performance by 1 mpg, 
might be equal to the decrease incurred were the price to be raised by 
$500.  If Mileage was chosen as the Reference Criterion, the tradeoff 
value in the row corresponding to Initial Price would be recorded as 
0.5 ($500 = 0.5 x $1000). 

The actual values of the tradeoffs depend on the Relative Weights of 
the lowest criteria, the scales limits (Best, Worst) and the chosen 
decision methodology (AHP or SMART). If SMART is chosen, and 
only Linear Value Functions are used, the tradeoffs are independent of 
the alternatives. In all other cases, the inherent non-linearity of how 
the user-defined scales are converted into the internal priority scale 
implies that the tradeoff values are specific to each alternative. In 
DecisionPlus, tradeoffs values are based on the preferred, or highest 
scoring alternative. 

Adjusting a Tradeoff 
If, on reflection, you decide that a tradeoff is unacceptable, there are a 
number of different ways by which you can adjust the value to be 
more acceptable. 

1. Changing the Relative Weights  - by returning to the Ratings 
window and adjusting the weights directly. 

2. Changing the Scale limits - by returning to the Edit Scale dialog 
and changing the Best/Worst values. Widening the scale will reduce 
the value of the individual unit 

3. Altering the Value Function (if using SMART) by returning to the 
Value Function window, you can adjust the slope of the curve around 
the value associated with the best alternative. Making the slope steeper 
around that value will make each scale unit of that criterion have a 
greater impact, increasing its tradeoff value for the preferred 
alternative. 

To Copy the Tradeoffs to Lowest Criteria Data 
To copy the actual numbers underlying the tradeoffs to the Windows 
Clipboard for insertion in other applications, do the following. 
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1. From the Edit menu in the Tradeoffs to Lowest Criteria window, 
choose Copy. A tab-delimited copy of the underlying data is 
copied to the Windows clipboard. 

2. In your target application, paste (see that application’s relevant 
documentation) the bitmap or data table.   

Relationship between Tradeoffs Analysis window and 
Direct Tradeoffs 

If you are using the Direct Tradeoffs Hierarchy Rating technique, you 
may be surprised to see that the Tradeoffs Analysis screen may seem 
to show tradeoffs with different values than those you directly entered 
in the Rating window. 

This can happen because the Tradeoff Analysis window allows you to 
select a Reference Criterion against which all other lowest criteria are 
traded off. However, you may be using a different reference criterion 
(see the section “Choosing a minimal set for Direct Tradeoffs 
technique” in Chapter 10) or even a manually chosen minimal set. If 
all priority vectors are linear, all methods should produce the same 
tradeoffs, but if not, you may well see discrepancies in the results from 
different methods. Two common sources of non-linear priority 
transformations are 1) using non-linear Value Functions in SMART or 
2) using AHP for your alternatives’ rating technique. 

Note: the Tradeoff Analysis window (which was also in 
Version 2.0) only updates itself when clicked. So if you 
change the tradeoffs in the Ratings screen with the Real-time 
Update option on, the decision score screen and Contribution 
by Criteria window will update with every change, but not the 
Tradeoff of Lowest Criteria Analysis screen. 
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Viewing Alternatives Data Scatter Plot 

Understanding the distribution of alternatives in your decision is very 
important if you are to be able predict how much impact a new 
alternative might have. To this end, CDP has the Alternatives Data 
Scatter plot. This plot helps you understand how your alternatives are 
distributed relative to their scores on the various lowest criteria. In 
addition, it also shows how the scatter of alternatives correlates with 
high decision scores. 

To open the Alternatives Data Scatter Window Window 
1. In the Hierarchy window, select Analysis from the menu bar. 

2. Select Alternatives Scatter to display the Alternatives Data Scatter 
Window. 
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Alternatives Data Scatter window Description 

Scatter Plot   To the right is the 2-D scatter plot itself.  It shows how 
the alternatives are distributed with respect to their values on the X 
and Y-axis. 

X,Y Axis   Here you choose what you want the X and Y-axes to show.  
You can choose any Lowest Criterion or the Decision Scores 
indepedently for each axis. You can choose to show the actual ratings 
of alternatives against that lowest criterion, or the priority that score 
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represents. (For an explanation of the important concept of priorities, 
see the section “How Decision Scores are Calculated” in Chapter 12.) 

Overlays  Initially each alternative is represented by a single cross on 
the scatter plot. You can choose to overlay the scatter plot with either 
bubbles representing accumulated values OR decision contour lines.   

Setting the axes to Lowest Criterion Ratings 
1. Select Miles Per Gallon from the Y-axis listbox.  Click Show 

Rating value so that the Y-axis uses the end user’s rating scale. 

2. Select Miles Per Gallon from the Y-axis listbox.  Click Show 
Rating value so that the Y-axis uses the end user’s rating scale. 

Showing Costs as a Bubble parameter 
A “bubble”, i.e., an opaque red disc, appears at each alternative 
position. You select an accumulated value (such as a decision score) 

that the bubble reflects.  The radius of the bubble is proportional to the 
value. This allows you to see clear correlations between alternative 
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ratings and model outcomes. To select which accumulated value you 
wish the bubbles to represent, simply click the appropriate node in the 
tree outline area. 

1. Click the Show Accumulated Values option under Overlays 

2. Click the node Cost in the tree outline. You get the graph above. 

Decision Contours 
Alternatively, you can see how the decision contours are driven by 
particular lowest criteria. If you look again at the section “How 
Decision Scores are Calculated” in Chapter 12, you will see that if you 
consider two Lowest Criteria, the Decision Score could be written as  

S = AW1 * PV1 + AW2 *PV2+ OC 

Here AW1 stands for the accumulated weight of Lowest Criterion 1, 

PV1 the priority of Lowest Criterion 1, and similar for AW2, PV2 
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being those of Lowest Criterion 2. OC stands for the contribution from 
other lowest criteria.  So if you graph only the sum  

C12 = AW1 * PV1 + AW2 *PV2 

This would be linear in terms of PV1 and PV2, which means contours 
of C12 would be parallel, straight lines (as they appear in the graph 
above).   

Non-linear Priority Vectors = Curved Contours 

If PV2(S2) is not a linear function of the end user’s rating S2, or 
PV2(S1) is not a linear function of the end user’s rating S1, then C12 
will have a non-linear relation ship with S1 and S2. 

In the example above, Initial has an exponential value function, so that 
its priority vector is non-linear. 

A quick comparison of the curved contour graph to the original, no-
overlay scatter plot, shows that the Toyota is contours ahead of the 
Ford when looking at MPG and Initial price. As the number of 
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Alternatives increase, this information can be very revealing as to what 
type of alternative tend to push the decision boundaries. 

View Options for Alternatives’ Rating Window 
When you are dealing with many alternatives, the names of the 
Alternatives quickly overlap and become unreadable. You can hide the 
names of the alternatives by  

1. Choose the Hide Alternatives Names item in the View menu. 

Viewing Contributions to Uncertainty Window 

When you include uncertainty in your decision, you can analyze how 
each uncertainty distribution you assigned contributes to the overall 
uncertainty in the decision scores. This provides you with a better 
understanding of how the decision scores are affected by uncertainty. 

To Select the Contributions to Uncertainty Window 
1. In the Hierarchy window, select Analysis from the menu bar. 

2. Select Contributions to Uncertainty to display the Contributions to 
Uncertainty Analysis window. 

Note:  You must have already calculated the uncertainty in 
decision scores or this window will not open or update if 
already open. 

 

Contributions to Uncertainty Window Description 
This window shows the contribution of the individual uncertainties 
you entered for a single alternative. Initially, the preferred alternative 
and its uncertainty are presented.  

Criteria   Your lowest criteria are listed in this column. 
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Contrb (Contributions)  This column shows the percentage of the 
uncertainty contribution for the adjacent criterion.  

Positive/Negative Correlations  The graphical bars show the 
contribution either positively correlated (for weights/ratings which, 
when increased, produces an increase in that alternative’s decision 
score) or negatively correlated (where an increase in the weight/rating 
produces a decrease). 

Alternatives  You can select other alternatives to review by using the 
drop-down list at the lower left of the window.  

Note: In order to view the contributions, you first must update the 
results by selecting the Update Results button. The colors of the 
contribution bars for an alternative are the same as the first five 
alternatives in the uncertainty results window. 
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To Select Another Alternative to Review Contribution to 
Uncertainty 

1. Click the drop-down arrow in the Options part of the window. 

2. Select the alternative you want to view. 

To Copy the Contributions to Uncertainty Graph  
To copy the Contributions to Uncertainty graph to the Windows 
Clipboard, for insertion in other applications, do the following. 

1. From the Edit menu in the Sensitivity by Weights window, chose 
Copy Graph. A bitmap copy of the graph area is copied to the 
Windows clipboard. 

2. In your target application, paste the bitmap (see that application’s 
relevant documentation) 

The Analysis Windows Toolbar 

When you are in any of the results or analysis windows, and the 
toolbar is visible, you will notice that it is different than when you 
were in the Hierarchy window. 

The icons, left to right, are: 

34. The Print Icon. Brings up the Print Dialog window. 

35. The Print Preview icon. Brings up the Print Preview of whatever 
window you are in. 

36. The Hierarchy Icon. Brings the Hierarchy Window to the fore. 

37. The Results window. Opens the Decision Scores window 

38. The Uncertainty Results window. Opens it. 
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39. The Sensitivity Analysis window. Opens it. 

40. The Contributions window. Opens it. 

41. The Alternatives Scatter window. Opens it. 

42. The Tradeoffs of Lowest Criteria window. Opens it. 

43. The Contributions to Uncertainty window. Opens it. 

Hiding Toolbar icons and/or text 
As usual, checking the menu item Show Toolbar on the View menu determines 
whether the toolbar is visible or not. If the toolbar is visible, checking the Show 
Toolbar Detail determines whether the text label appears under each toolbar icon. 

What’s Next? 

Once you have checked the reasonableness and robustness of your 
decision, if you decide your decision is acceptable as structured, you 
can go to Chapter 14, Document the Results, and print your results. If, 
on the other hand, you decide the results are not reasonable, or you 
feel your model needs a little fine-tuning, you can adjust the structure 
of your model in Chapter 9, Build the Hierarchy, or adjust your ratings 
in Chapter 10, Rate the Hierarchy. 
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Documenting the Results as Part of the Decision 
Process 

Where are you?  You are in the shaded part of the Process Diagram 
below: 

   

Brainstorm
 the Problem

Select Uncertainty

Analyze the Results

Review the Results

Rate the Hierarchy

Build the 
Hierarchy

Document 
the Results

Process Diagram
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Printing Support in DecisionPlus 

DecisionPlus provides a full range of printing support. You can print 
your Brainstorm, Hierarchy, all results and analysis window contents, 
graphics or data.  All underlying information, such as notes, weights, 
scores, scales etc., can also be printed. You can print such information 
as single items or as part of custom reports. You can preview your 
print work, add file names, page numbers, and model names to your 
page setup, and assign different printers. This Chapter will show you 
how. 

Displaying the Print Dialog Window 

Whether you are in Brainstorm or Hierarchy, or one of the Results or 
Analysis windows of Hierarchy, you can access the Print Dialog 
window wherever you see the Print command on the File menu.  

In Brainstorm, you can print your results in one of three ways: Graph, 
Outline, and a List of criterion names and notes. 

In Hierarchy, you can print your results many different ways, 
including the Hierarchy graph, a spreadsheet view of that graph, 
criterion names and notes, as well as all the results and analysis graphs 
and data that are generated from a Hierarchy model. 

1. Select Print from the File menu. The dialog below displays. 
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General Print Options 
Some of the options on the Print Dialog window are the same for all 
Brainstorm and Hierarchy items. Those options are listed below: 

 Single Item:  Select this option to make one selection at a time to 
print. In Hierarchy, you either select this option or the Report 
option. 

 Report:  This option is available only in Hierarchy. It allows you 
to select and save a combination of the reports you might use 
often. If you select this option, the Single Item is deselected. 
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Orientation   This option allows you to select the orientation of your 
printout. 

 Portrait     Landscape   

Zoom   Allows you to reduce or increase the size of your printout 
proportionately. You might want to use this to get larger printouts onto 
a single page or to enlarge printouts for illustrative purposes. (Not 
available for all items.) 

Print Range   Allows you to select to print all the pages in your file, 
or specific pages. 

Print Setup   Allows you to select a printer and printer-specific 
options. 

Page Setup   Allows you to set page headings, footers, and margins. 
See the section on “Page Setup” later in this chapter. 

Print Preview   Allows you to see a screen view of your printout 
before it prints. See the section on “Page Setup” later in this chapter. 

Color Usage   The printer will automatically (Auto) attempt to 
identify if your printer can handle color, and if so, will utilize color. 
You can override its assessment by choosing the Black and White or 
Color option. 

Options configurable using the check boxes depend on the item being 
printed, and will be described below. 
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Displaying the Print Preview Window 

If you are looking at an analysis, results, Brainstorm or hierarchy 
window, the simplest way to see the corresponding print item is to 
look at the print preview window. To display the Print Preview 
window: 

1. Choose Print Preview from the File menu 

or 

1. Click the Print Preview button on the Print Dialog window. 

What the Print Preview shows is exactly what you will get when you 
print. 
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Next/Previous   Clicking these buttons will take you to the next or 
previous page in your item or report. The Page number is shown to the 
upper right.  The buttons are disabled when there are no further pages. 

Zoom In/Zoom Out   Zoom In magnifies the display by a factor of 
two, allowing better inspection. Zoom Out restores to the full page 
magnification. 

Print  The Print button opens (or returns you to) the Print Dialog 
described above. From there you can proceed to print your work. The 
Print Preview does not close. If you want to change any options (e.g., 
paper orientation), use this button to access the Print Dialog, change 
your option settings, then click the Print Preview button on that 
window to see the changes. 

Close   Clicking the Close button closes print preview and returns you 
to the usual DecisionPlus windows. A recalculation may occur. 

Clipboard   Clicking this button will copy the print preview image 
(the part on the white background). 

Note: Print Preview places a heavy demand on your memory 
resources. You may get an error message warning of 
insufficient memory. Follow the suggestions of the message to 
free up memory. 

Display the Page Setup Window 

To insert specific headers and footers in your print items and reports:  

1. Select the Page Setup button in the Print Dialog window to display 
the Page Setup window. The Page Setup window, shown below, is the 
same for Brainstorm and Hierarchy and effects all printed items. Your 
settings are lost when a session is ended. 
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Margins:  Enter the margins in inches from top to bottom, left to right. 
The default is 1 inch for all margins. 

Distance From Edge:  Indicate how far from the edge of the paper 
you want your header and footer to print.  

Page Numbers:  If you want your page numbers to begin at a point 
other than 1, enter that number here. 

Header and Footer:  Select the one you want to work with from the 
Select Header/Footer drop-down list box. Then enter the appropriate 
information in the three scroll boxes at the bottom of the window for 
Left, Center, and Right.  

Left, Center, Right: These refer to the areas of your printed page. 
Here you can enter information you want printed in either the header 
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or footer. Or, you can click in one of these boxes, then select one of 
the buttons described below to insert model information automatically. 

Insert Filename, Insert Model Name, Insert Page Number:  If you 
want DecisionPlus automatically to insert your model’s Filename, 
Model name, or page numbers, click in the appropriate text box (Left, 
Center, Right) and select one of these buttons at the bottom of the 
window. Model Name is only available when printing from Hierarchy. 

  

Displaying the Print Window  

Through the Printer dialog, DecisionPlus allows you to change printers 
and adjust your printer settings on the fly. The window caption of the 



Chapter 14  Document the Results 

Criterium DecisionPlus 317 

Print Dialog tells you to which printer you are sending your print 
tasks.   To display the Print dialog:  

1. From the File menu, choose Print.  

or 

1. From the toolbar, click the Print icon.  

Report  For Hierarchies, allows you to create reports from single 
items. 

Single Item Selection drop down   Allows you to select a single item 
to print, and choose how you want it printed. 
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Printer  Allows you select and alter the options (e.g., Paper source, 
Paper size, etc.) of any available (local or networked) printer. The 
exact options vary with the printer. 

Print Range  Do you want all pages printed or a particular range? 

Color Usage  Let CDP to print in color if your printer supports color 
printing or make your own choice. 

Printing Brainstorm Models  

Having dealt with the general printer support that DecisionPlus 
provides, we now present a description of each available print item, 
and the options available to each item, starting with Brainstorm 
models. 

Brainstorm Print Dialog Window Description 
Brainstorm Graph   Prints a duplicate of your Brainstorm canvas, 
excluding the alternatives. Specific options are as follows. 

 Print Boxes Around Nodes   Adds frames around your 
criteria 

 Fit To One Page  Sizes your model so it all fits on one page. 

 Print Goal Tree Only  Prints only criteria connected to the 
Goal. 

 Print Crop Marks   On very large models, prints on several 
pages, crop marks (corners) help you line up each page when 
you assemble the pages. 
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Brainstorm Outline   Prints the contents of your Brainstorm model in 
the form of an outline beginning with the goal as in the following 
illustration. 

The goal
The first criteria

The subcriteria
The second criteria

The subcriteria
The third criteria

The subcriteria, and so on  
 Print Goal Tree Only   Prints only criteria connected to the 

Goal.  

 Print Crop Marks   On very large models, which print over 
several pages, crop marks (corners) help you line up each page 
when you assemble the pages.  

Brainstorm Notes    Prints the goal and each criterion with any notes 
attached. 

 Print Alternatives’ Notes   Prints Notes for alternatives as 
well as those for criteria.  

 Print Goal Tree Only   Prints only notes of criteria connected 
to the Goal.  

 Print Pasted Data  Prints the scores of Alternatives pasted 
directly into Brainstorm (if any).  

Report:  This option is available only in Hierarchy. See the section 
“Hierarchy Reports” in this Chapter.  
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Printing Decision Models  

As in the case of Brainstorm models, all printing is effected through 
the Print Dialog window. 

1. From the Hierarchy window, or one of the results or analysis 
windows such as Decision Scores, select Print from the File menu.  

 Or, from the toolbar, click the Print icon.  
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2. The Print options window below appears. 

  

In the Hierarchy, you have fourteen more choices to select from the 
Single Item drop-down menu in Hierarchy than in Brainstorm. The 
default is the item corresponding to the window you were viewing 
before you opened the Print Dialog. 

When you select an item from the Single Item list, a corresponding set 
of options appears below the list box. In addition to the general 
options (orientation, color, etc.) discussed earlier options specific to 
each item are described below. 
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Hierarchy - Graph  

 Fit To One Page   Sizes your model so it all fits on one page.  
Use Print Preview to see if Landscape or Portrait is the better 
choice. 

 Show Accumulated Weights  - Adds the accumulated weight 
of each block as a prefix to its name. 

 Print Crop Marks   On very large models, prints on several 
pages, crop marks (corners) help you line up each page when 
you assemble the pages. 

 Hide Lowest Connections  - Lines connecting lowest criteria 
to alternatives may become too dense for some printers - this 
option suppresses those lines. 

Hierarchy-Data   Prints a spreadsheet view of the Hierarchy. 

 Weights and Ratings Only  Spreadsheet of criteria and their 
ratings, alternatives and their scores. 

 Weights, Ratings, Priorities  Same as above, but also shows 
priorities. Takes up a lot of space. 

 
Hierarchy Pairwise Data  Prints tables of pairwise comparisons. 
Exact format depends on primary view used. 

Hierarchy-Notes & Rules   Prints a list of each block's name, its 
associated notes, scale information (if not an alternative), Rules (if 
block is a lowest criterion and if defined) and value functions (if 
SMART is used, and the block is an attribute). 

 Print Notes Only - Prints only name and text notes in 
hierarchy order and indented format.  
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 Print All - Prints extensive information about a block; Notes, 
Scales, Rules.  

Decision Scores Graph   Prints a bar graph of your decision scores 
similar to the Decision Scores results window. 

 Sort Results By - List includes None (default), Decision 
Scores, 5% score, mean score, 95% score and accumulated 
values at any criteria. 

 Uncertainty Vs All - Shows how often each alternative would 
be the top scorer in light of the given uncertainties. 

 Uncertainty Vs Best - Shows how often each alternative would 
have a higher scorer than the leading alternative. 

 Show Values List - Determines what numerical values will be 
shown.  List includes Decision Scores (default) and all lowest 
criteria. 
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 Cumulative - Cumulatively sum (and display) the values 
starting from the top of the screen. 

Decision Scores Data  Prints a spreadsheet view of the Decision 
Scores and Uncertainty (if available) results. 

 
Sensitivity by Weights Graph   Prints a copy of your Sensitivity to 
Weights analysis window. 

 criterion-subcriterion - From the list you can choose the 
weight for which you wish to run the sensitivity analysis. 

Uncertainty Inputs   Prints all the Uncertainty distributions (curves) 
you specified for all lowest criterion. 
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 Sorted by Criteria - The uncertainty distributions are ordered 
by lowest criteria, then by alternatives, both taken in 
Hierarchy Order. 

 Sorted by Alternatives - The uncertainty distributions are 
ordered first by alternatives, then by lowest criteria, both taken 
in Hierarchy Order. 

Uncertainty Results Graph  Prints a copy of the Uncertainty in 
Decision Scores results window. 
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 Density Curves - All the distributions are shown as 
probability density distributions. 

 Cumulative Curves - All the distributions are shown as 
cumulative probability distributions. 

 Reverse Cumulative Curves - All the distributions are shown 
as reverse cumulative probability distributions.  

Uncertainty Results Data Graph  Prints the statistical data and 
curve points of the Uncertainty in Decision Scores Results 
window. The options for this page are as for the Uncertainty 
Results Graph (above). 

Contributions by Criteria Graph   Prints a copy of the Contribution 
by Criteria Analysis results graph. 

 Criterion - The listbox allows you to select the target criterion 
you wish to analyze.  

 Level - The listbox allows you to select the level whose 
criteria's contribution (to the accumulated values of the 
alternatives at the target criterion) you wish to analyze.  

 Tag Level - The listbox allows you to select the level with 
whose criteria's names you wish to prefix the names of criteria 
in lower levels.  

 Tag By First Letter - In the interests of space tag with only 
first letter of Group Tag Level’s criteria names. 

 All Alternatives - The print functionality for Contributions by 
Criteria by default, only prints the stacked columns for the 
first five alternatives. If you have more than five alternatives, 
and need a graph showing all alternatives, check the All 
Alternatives box. The resultant graph may be too dense to be 
of use. 

 All Criteria - The print functionality for Contributions by 
Criteria by default, only prints the first 6 criteria as bands of a 
stacked column. If you have more than seven criteria in the 
contributing level, it lumps the contributions from the seventh 
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and above into a single band labeled others. If you desire a 
graph showing bands from all criteria, check the All Criteria 
box. The resultant graph may be too dense to be of use. 

 View – Graph Style - From the list you can select whether 
you want to set options for the Graph Style, Legend position 
or Alternatives labels’ orientation. In each case the options are 
shown in the area to the right of the listbox.   

 

Contributions to Uncertainty  Prints a copy of the Contributions to 
Uncertainty Analysis results window. 

 Alternative - From the list you can select the alternative 
whose uncertainty you wish to analyze. 

Data Scatter  

See Chapter 13 for a description of each option. 

Criteria Tradeoffs  Prints a copy of the tradeoffs between lowest 
criteria Table.   

 Reference Criterion - You can select the lowest criteria you 
wish to designate as the reference criterion. 

Rules Report  Prints a summary of all the rules and an account of the 
alternatives that failed them (if any).   
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 Print Failed Rules - Prints only an account of rules that were 
failed by alternatives. 

 Print All Rules - Prints all the rules (whether failed or not) 
and an account of rules that were failed by alternatives. 

Trade-off Ratings Prints all Direct Tradeoffs (if any) entered by user. 
No options other than Portrait or Landscape. 

Alternative Ratings  

Analysis results window. 

 Alternative - From the list you can select the alternative 
whose attribute values you wish to print. 

 Print All Alternatives - Prints attribute values for all 
alternatives. 

Printing Decision Model Reports 

Printing reports allows you to select, save, and print a combination of 
the print items you might use often. The report is saved with the data 
file (*.cdp). While the Report is printed directly from the Print dialog 
window, you choose the contents of the report in the Report Options 
window.  
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To Display the Report Options Dialog Window 
To open the Report Options dialog from the Hierarchy or any results 
or analysis windows: 

1. Choose Print from the File menu to open the Print Dialog. 

2. Select the Reports Option, located at the top of the dialog window. 
The Contents button is enabled. 

3. Click the Contents button, and the Report Options window 

appears. 

 
This allows you to select the combination of items you want in your 
report and enter the specific manner in which you want them to print. 
The dialog contains an Include in Report area and an Options area. 
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Include in Report 

The left-hand list contains all available print items for a decision model.  
By clicking the name of any item, the Options Area is populated with 
the appropriate formatting options. To add an item to the report, you 
must click the check box to the left of the item name. Un-checking an 
item removes it from the Report. 

Options Area 

The options here are exactly the same as those for the single items, as 
discussed above in the section “Printing the Decision Model.” Setting 
these options here does not effect options for the Single Items printing. 
The option settings for one item in the report do not affect settings of 
other items in the Report. 

Saving a Report 

Clicking the OK button saves the report unless you choose not to save 
the file when closing the entire model. 

To Print a Report 
1. From the File menu choose Print. 

2. In the Print Dialog window, click the Report button. 

3. Still in the Print Dialog window, click the Print button. 

To Preview a Report 
1. From the File menu choose Print. 

2. In the Print Dialog window, click the Report button. 

3. Still in the Print Dialog window, click the Preview button. Use the 
Next and Previous buttons to walk through the report. 
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What’s Next? 

You can return to any part of your decision model and update the 
information. At that point you can save it to the current file, or save it 
to a new file. 

If you want to learn some of the more advanced functions in decision 
analysis, we recommend turning to the References section for 
suggested literature on decision analysis techniques. 
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What Will You Get from this 
Tutorial? 

This section contains a series of steps in a five-part tutorial. The 
tutorial, Select a Vacation Book, is meant to get you started using 
DecisionPlus by having you use only a portion of the functions to 
enter, structure, weight, and document a very small decision model. 
We provide just enough detail to accomplish this task and to help you 
understand some important concepts. Below is an illustration of the 
model we help you build in this tutorial. 

 

 

  
 

 

You’ll need more detail to build a complex decision model than you’ll 
get using this tutorial alone. But, you might use the tutorial along with 
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the chapters in Part III, Designing Your Own Decision Model, and 
successfully build your own decision model. We recommend that you 
refer to the chapters in Part III any time you want more detail about 
what we discuss in this tutorial. 
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Chapter 15 – A Tutorial: 
 
 
 

Select a Vacation Book 
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In This Chapter 
  I  Brainstorming the Problem 
  II Building the Hierarchy 
  III Rate the Hierarchy 
  IV Selecting the Best Alternative 
  V Reviewing the Results 
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A Step By Step Tutorial 

Our tutorial acquaints you with DecisionPlus as we assist you through 
your first decision-making process using this program. This tutorial 
assumes you have little or no prior experience with decision making 
tools. For this reason, we selected a simple model that, although you 
may not need a decision analysis tool to solve, will build confidence in 
your decision making process and in using DecisionPlus. You’ll use 
many of the features in DecisionPlus to make a preferred decision.  

Tutorial Overview 

This tutorial has all the necessary parts to reach a preferred decision. 
The five parts of the tutorial are:  Brainstorming the Problem, Building 
the Hierarchy, Rate the Hierarchy, Selecting the Best Alternative, and 
Reviewing the Results.  

I - Brainstorming the Problem   
In the first part, you’ll use the brainstorming capability where you’ll 
type your ideas about the problem onto a canvas. On the canvas, we’ll 
show you how to associate similar ideas with each other. We call these 
ideas criteria. This is also where you’ll enter your alternatives (the 
choices you have available). 

II - Building the Hierarchy   
Next, you’ll build your hierarchy and make any necessary adjustments 
to criteria or alternatives. You’ll learn techniques such as how to add 
and delete criteria, expand and contract your model, and navigate 
through your model. 
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III - Rating the Hierarchy 
Then, you’ll rate your criteria and alternatives using various rating 
methods and rating scales. 

IV - Selecting the Best Alternative 
Here you’ll calculate the preferred alternative, and interpret and 
present the results. 

V - Reviewing the Results 
Finally, you’ll analyze how sensitive your results are, see how 
contribution affects the results, and determine if the decision is stable.  

Supporting Sample Files 
When you installed DecisionPlus, two sample tutorial files were 
copied to the DecisionPlus directory on your system (usually 
c:\criplus).  The file, bookttrl.bst, contains the brainstorm file for this 
tutorial as it should look after you have finished the first part of this 
tutorial, I - Brainstorming the Problem.  The file, bookttrl.cdp,  
contains your hierarchy file as it should be after you have finished part 
III - Rating the Hierarchy.  You can use these two files to skip parts of 
the tutorial if you wish. 
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Select a Vacation Book 

Imagine you are packing for a tropical vacation and you want to take 
along one of your new books. You have three great books in mind, but 
room for only one in your luggage. Will it be Jurassic Park, Fried 
Green Tomatoes, or 100 Years of Solitude? 

I - Brainstorming the Problem 

The first step in building your decision model is to display the 
brainstorming window so you can enter and organize your ideas on the 
“canvas.” This is also where you’ll list your book choices. 

 This part of the tutorial takes 20 to 40 minutes, depending on 
your learning style. 

Step One:  Display the Brainstorming Window 

• From Program Manager, double-click the DecisionPlus icon. The 
Brainstorm window displays with a blank canvas, except for the 
word “Goal” inside a centered circle. 
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  The goal circle in the middle of the canvas is 
where you’ll type your decision goal. If you move your cursor to 
the goal circle it turns gray. This feature tells you when you’ve 
made contact with items on the canvas. 

  The recycle bin in the lower right corner stores ideas you 
may not want to work on for the time being. You can drag words 
to the recycle bin and retrieve them at a later time during the same 
session.  
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 The gray area to the right of the canvas is where 
you’ll type your choices. In this case, the choices are the books 
from which you’ll choose. We call these alternatives. 

Step Two:  Enter Your Decision Goal 

    
1. Click once inside the circle to select it. A box surrounds the goal 

circle. 

2. Click once again inside the circle on the word “Goal” to highlight 
it. 

3. Type Select a Book. 

Note:  Type your text in Brainstorm the same way you would 
in any Windows application using the same procedures. 

 Because the circle was only large enough to accommodate the 
word “Goal,” only parts of your typing show as you type.  

   ct a  
4. Press ENTER or click outside the circle. Your whole name appears 

inside the circle. 

To move the goal circle anywhere on the canvas, click on the circle 
and drag it to another position. 

Step Three:  Save Your File 
1. From the File menu, select Save. 
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2. Select a drive and folder. 

3. Type book. 

4. Click OK, or press ENTER. 

You’ll find your files with the extension .bst. For example, this file is 
book.bst. 

Step Four:  Enter Your Alternatives 

  
Your alternatives are the three books from which you will choose.  

1. To the right of the window, under the word Alternative, click once 
in the first gray block. 

2. Type Jurassic Park. 

3. Press ENTER. When you press ENTER, the insertion point drops 
down to the next gray block and is ready for you to make an entry. 

4. Type Fried Green Tomatoes and repeat #3. 

5. Type 100 Years of Solitude and repeat #3. 

6. Click once anywhere on the canvas area to get out of Alternatives. 
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Step Five:  Enter Decision Criteria 

  
If you organize easily while you think, you might choose an organized 
way to enter information on the Brainstorm canvas. However, because 
the Brainstorm function can be used to help you form and organize 
ideas, we show you a less organized approach to entering your criteria.  

Let’s say you like books that are at least exciting, humorous, and 
educational, but you also like mysteries. These criteria can be entered 
anywhere on the canvas. The following steps are a quick way to make 
your entries: 

1. Double-click in the top left corner of the canvas away from the 
decision goal circle. An empty block appears with an insertion 
point inside.  

2. Type Exciting. 
3. Press ENTER to accept your criteria and to create another empty 

block. 
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4. Type Humorous and repeat #3. 
5. Type Educational and repeat #3. 

6. Type Mystery. This time, click outside the block to get out of the 
empty block creation mode. 

Note:  If you prefer, another way to create a new block is to click 
outside each block after entering your criteria, then double-click in 
any area of the canvas. 

Step Six:  Save Your File 
1. From the File menu, choose Save and name your (*.bst) file. 

Step Seven:  Create Canvas Space 
If you followed numbers 1-6, your decision criteria are all queued one 
below another.  
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To make room for related criteria, move one to each of the four 
corners of the decision goal. 

1. Click and hold down the left mouse button on Humorous. The 
criteria becomes surrounded by a gray shaded box. If you release 
the mouse button before we tell you, you’ll have a surrounding 
handled box instead. That’s okay. 

2. Drag Humorous to the top right side of the canvas and release the 
mouse button. A gray box outline follows your cursor to the new 
spot. When you release the mouse button, Humorous appears in the 
new area with a surrounding handled box. 

3. Click on Educational and repeat #2, dragging it to the lower right 
side of the canvas, below the goal. 

Step Eight:  Enter More Decision Criteria 
Now that you think of it, you have several more ideas about what 
criteria influence your decision to read certain books. Of course there 
are different types of humor, education, and excitement that influence 
your decisions.  

1. Double-click anywhere on the canvas to create an empty block. 
The area next to Exciting looks roomy, so let’s put it there. 

2. Type the following and press ENTER after each entry:  Subtle, 
Outrageous, and Symbolic. 
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3. Click once outside the last block. 

 

By now, you have all kinds of ideas you want to consider in your 
decision. To create even more space, turn off the Alternatives area of 
the window. 

• From the View menu, click Alternatives. The right side of your 
canvas fills again with the list of alternatives. 

Step Nine:  Enter the last of your criteria 

Note:  Because PCs vary, more or fewer words may fit on your 
Brainstorm canvas before the window begins to scroll. If you find 
yourself running out of room to type, you can always click in 
another clear spot on the canvas and make your entries there. You 
can click and drag your criteria to make your model look like our 
illustrations. 
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1. Double-click in the top right side of the window where 
Alternatives used to be to create an empty block. 

2. Type the following criteria and press ENTER after each entry: 
Scientific, Cultural, Humanistic, Inspirational (for some of you, your 
window will scroll up after this entry), Animated, Descriptive, Witty, 
Analytical. (For some of you, the goal has scrolled up off the 
window and you may be typing off the window. See “Tip” below.) 
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3. Click once outside the last block. 

 

Tip:  There are several ways you can handle the model if some 
of it has scrolled off the window:   

1) Select Fit to Screen (or one of the % options) from the Zoom 
command on the View menu.  

2) Use your scroll bars on the right and at the bottom of the 
window to recenter your goal on the canvas. However, your last 
entries might scroll off the bottom of the canvas.  
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3) Click and drag the last entries back up closer to the goal.  

4) Use the Find Block option under the Edit menu. This option 
finds and centers the specified block, which means other entries 
scroll off the canvas. 

Step Ten:  Enter Notes 
You could actually enter notes about your goal, criteria, or alternatives 
at the time you enter these items into your decision model. But you 
can also enter them at any time. If you want, follow the steps below to 
enter your notes, or go on to Step Eleven. 

To Select Your Goal 

• Click once on your goal to display a surrounding box. 

To Select a Criterion 

• Single click Humorous, or any criteria, to get a box around it. 

To Select an Alternative 

• Click once in the gray block that says Jurassic Park, or any 
alternative, to get an insertion point inside the block. 
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To Display the Notes Box and Type Your Notes 

  
1. With your item selected, press Ctrl+N to display the Notes box. 

The name of your goal, criteria, or alternative appears in the Name 
area and is highlighted. 

2. Tab to or click in the Notes area to get an insertion point. 

3. Type your message or notes. 

4. Press ENTER or click OK. Your goal, criteria, or alternative appears 
back in their blocks followed by three dots that indicate they have 
notes attached. See the following examples. 

  
Select a Book . . .

 

  Humorous . . .  
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Step Eleven:  Form Groups of Similar Decision Criteria 
At this point, you feel your entries represent most of the criteria you 
want to consider in selecting a book. You can start forming groups and 
relationships of similar criteria. Some will be main criteria (parents), 
some will be subcriteria (children of the parents). Now we show you 
how to group and connect these criteria. 

Witty, Outrageous, and Subtle are words you used to further describe 
Humorous. So, Humorous is a main criterion, or the parent, and the other 
three are subcriteria of Humorous. Let’s make that association on the 
canvas. 

1. Click and hold down the left mouse button on Witty, drag the word 
under Humorous, and release the mouse button. Do the same for 
Outrageous and Subtle. 

 
2. Now, click and hold down the left mouse button on Witty and drag 

it to Humorous. 

3. When the word Humorous lights up gray, release the mouse button. 
The word Witty resumes its original position, but now has a line 
connecting it to Humorous. (If it doesn’t have a  connecting line, 
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the connecting lines feature may be turned off. Select Connecting 
Lines from the View menu.) 

4. Repeat #2 and #3 for Outrageous and Subtle. If you need to make 
room, you can drag out of the way any blocks necessary. 

Step Twelve:  Save Your File 

Step Thirteen:  Group Subcriteria with Parent Criterion 
Some ideas, or criteria, on the canvas may seem closely related to each 
other, but don’t have a parent criterion to connect to them. They are 
orphans. Exciting, Inspirational, and Animated seem closely related to 
each other. Let’s give them the parent “Provocative.” 

The following steps show you how to move Exciting, Inspirational, and 
Animated to a clear area on the canvas under Select a Book. Then we 
show you how to select them and give them their parent. 

1. Click on Exciting, hold the left mouse button down, drag the word 
under Select a Book, and release the mouse button. Do the same for 
Inspirational and Animated, queuing them vertically. 

2. To select Exciting, Inspirational, and Animated, click once on Exciting 
to get a box around it. 

3. Move your cursor to Inspirational, press Ctrl and click once. 

4. Move your cursor to Animated, press Ctrl and click once. Each 
criterion should have a box around it. 

5. From the Edit menu, select Group. A Group Information box 
appears. 

6. In the Name area, type Provocative. 

7. Press ENTER or click OK.  
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 Exciting, Inspirational, and Animated are now connected to and are 
subcriteria of the parent Provocative, which appears just to the left.  

 

Step Fourteen:  Save Your File 

Step Fifteen:  Store Unneeded Criteria in the Recycle Bin 
At this point, you decide some of your criteria aren’t really needed in 
this part of your model. For the time being, let’s can store them in the 
Recycle Bin. You can drag them all at once, or one at a time. To drag 
them all at once: 

1. Click once on Descriptive to display a box around it. 

2. Hold down the Ctrl key and click once on Analytical. 

3. Repeat #2 for Symbolic and Mystery. 

4. When they are all enclosed in boxes, drag one to the Recycle Bin 
at the bottom of the canvas. The Recycle Bin displays paper in the 
top of the bin to indicate items are stored inside. 

5. To see your recycled information, double-click on the Recycle 
Bin, or select Recycle Bin from the View menu. 
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Step Sixteen:  Establish Remaining Relationships 
Now that you’ve seen a couple of ways to connect criteria and form 
criterion-subcriteria relationships, we’ll have you connect the 
remaining criteria to each other and to the Goal.  

Note: DecisionPlus remembers the order in which you drag one 
block onto another, and makes the criterion-subcriterion 
identification based on that order.  Always drag the block you 
wish to be the subcriterion onto that block you wish to be the 
parent criterion. 

1. Click and drag Educational closer to the goal circle. When you 
reach the position you want, release the mouse button. 

2. Click and drag Educational over the goal oval. When the goal turns 
gray, release the mouse button. Educational resumes its original 
position, becomes gray large letters, and has a line connecting it to 
the goal. It is now a main criterion of the goal, Select a Book. 

3. Click and drag Cultural to a spot above Educational and release the 
mouse button. 

4. Repeat #3 for Scientific and Humanistic. dragging them above 
Educational, near Cultural. 

5. Click and drag each subcriterion, one at a time, to Educational to 
connect them.  

 For the purposes of this tutorial, drag in this order:  Humanistic, 
Cultural, then Scientific. This determines the order in which they 
appear in the Hierarchy window, which we will talk about soon.  

 After each connection, the subcriteria turn to large green letters 
and are subcriteria of the parent criterion, Educational. 

6. Click and drag Provocative over the goal circle as in #2 above. Its 
entire family of subcriteria becomes connected to the goal. 
Provocative, being the highest level criterion, is in large gray 
letters. Exciting, Inspirational, and Animated, the subcriteria of 
Provocative, are in large green letters. 
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7. Click and drag Humorous over the goal circle as in #2 above. Its 
entire family also becomes connected to the goal. 

Step Seventeen:  Rearrange and Print Your Model 
Your canvas may not look quite like ours, but that’s okay. You can 
click and drag anything on the canvas area until your canvas looks 

similar to the illustration below. It isn’t necessary to rearrange your 
model before you can create a hierarchy, but you may want a readable 
copy if you print the Brainstorm results.  

 

1. To redisplay the Alternatives area, select Alternatives from the 
View menu. 
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2. To reduce the model to fit onto the canvas area, select Fit to 
Screen from the Zoom command on the View menu. 

If you want to print your Brainstorm model,  

1. Select Print from the File menu. 

2. Select the options Single Item, Hierarchy Graph, Fit to One Page, 
Portrait. 

3. Select Print. 

Congratulations! You have finished formulating your ideas into your 
own decision model. You are ready to build your hierarchy in section 
II. 

  Stopping Point 

If you want, you can stop here and start again another time. Save your 
Brainstorm file and close the Brainstorm window. 

• To save your document, select Save from the Brainstorm File 
menu. 

• To close Brainstorm, select Close from the File menu, or select 
Close from the Control Menu. 

• To close DecisionPlus, select Exit from the File menu. 

If you want to continue now, save your Brainstorm file, but do not 
close your file or the Brainstorm window, and proceed with II - 
Building the Hierarchy, below.  

II - Building the Hierarchy  

The second part in building your decision model is building your 
hierarchy. In DecisionPlus, you can do this in two ways:  you can 
generate it from a brainstorm file, or you can create it directly in the 
Hierarchy program.  
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In this tutorial, you “generate” the hierarchy from the brainstorm file 
you just created. Your Brainstorm file must be open. 

 This part of the tutorial takes 10 to 20 minutes, depending on 
your learning style. 

Step One:  Display the Hierarchy Window 
If you closed your Brainstorm file and are starting the tutorial again, 
open your Brainstorm file before proceeding. Select the .cdp file from 
the Open command in the File menu. 

1. From the Brainstorm window, select Generate Hierarchy from the 
View menu. This automatically closes your Brainstorm file. If you 
did not save your Brainstorm file, you are prompted to save it. 

 The first window you see is an optional “Model Name and Notes” 
dialog box where you can name your Hierarchy model. Although 
you can name your model later if you prefer, let’s name your 
model now. 
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2. In the Name area, type Vacation Book and press ENTER or select 
OK. (Enter notes if you like.) 

   

The following window displays with your model converted into a 
hierarchy according to your formulation in Brainstorm. The top of 
your window shows your model name, Vacation Book.  
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This hierarchy is not stored until you save it in Hierarchy and create a 
.cdp file. If you like, you can close this window without saving it, even 
if you already named your model, and reopen your Brainstorm file. 
Just select Close from the File menu (you’ll be prompted to save and 
you can say No).  

If you make changes in Brainstorm that you want reflected in the 
Hierarchy window, you’ll need to regenerate a hierarchy. Once you 
save this file in Hierarchy, you have two separate files. Updating one 
does not update the other. You can use the same .bst file to create as 
many new hierarchy files as you want. 

Note:  If you connected some of your criteria a little out of order, 
your window may not look exactly like ours. However, the 
remaining instructions refer to the illustration above. 
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Step Two:  Review Your Model 
This is the point at which you can review your model to see if you 
included everything, to see if relationships between blocks make 
sense, and to see if your connections are sufficient. You can edit your 
decision model easily in the Hierarchy window by moving, adding, 
deleting, and renaming criteria and alternatives, and by adding and 
deleting levels. 

The Hierarchy window lists your decision criteria in columns of levels. 
At the top of each column is a modifiable heading:  Goal Level, Level 
2, Level 3, and Alternatives. In columns from left to right is your goal 
Select a Book, followed to the right by the second level of your decision 
model, Educational, Provocative, and Humorous. Next is the third level of 
your decision model, the subcriterion of Educational, Provocative, and 
Humorous, followed by the last level, your alternatives. The lines 
between the blocks of criteria represent the connections you made in 
Brainstorm.  

Step Three:  Save Your New Hierarchy File 
We think your model looks pretty good. If we were going to fine-tune 
the basic structure, this is where we’d do it. But first, you should save 
your file. Your filename can be the same as the one you used for the 
brainstorm file because this one will be saved with the .cdp extension.  

Step Four:  Add Criteria to Your Decision Model 
As you look at your hierarchy, you begin to wonder how your decision 
would turn out if you considered the writing style of the book. You 
can add this criterion easily in Hierarchy, so let’s add it.  

Where will you put writing style?  First, consider what level of 
importance writing style might take on. Is it as important as Education, 
Provocative, and Humor, which are at Level 2, or is it perhaps a 
subcriteria of these criteria, which would have the same importance as 
criteria in Level 3. You decide it’s just as important as Education, 
Provocative, and Humor, so let’s enter it in Level 2. 
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1. Double-click just above Provocative in the Level 2 column. A 
yellow block appears with the word “Name” highlighted. 

2. Type Writing Style and press ENTER. 

3. Now double-click in the space between Scientific and Exciting in 
Level 3 (or, if your model is slightly different, between the third 
child of Educational and the first child of Provocative) to create 
another block. 

 Note:  To make more space between these two blocks, all the 
blocks above the space you clicked move up. If these blocks 
were below the center of your model, all the lower blocks would 
move down. 

4. Type Symbolic and press ENTER. 

Step Five:  Connect New Criteria 
1. To connect Writing Style to the goal, click and drag until Writing 

Style overlaps the goal, and release the mouse button (in 
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Hierarchy, blocks don’t turn gray when approached by the cursor 
or another block). A line appears, connecting the two blocks. 

2. To connect Symbolic to Writing Style, click and drag either block to 
the other.  

3. To connect Symbolic to the three alternatives, click once on the 
heading “Alternatives” to highlight all three alternatives, and drag 
one alternative block to Symbolic. Lines connecting Symbolic to all 
three alternatives appear.  

Note:  You can break these connections by repeating the same 
steps you used to connect the blocks. 

 

Step Six:  Rearrange Your Model 
Now, you’ll notice that parts of the model have moved just a little off 
center (such as Educational). We can take care of that by rearranging 
the model. 
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Note:  If at any time your model scrolls right off the window, to 
recenter your model, select Navigator from the View menu. Then 
follow the steps in “View the Navigator” in Step Eight later in this 
chapter. 
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1. From the View menu, select Arrange Blocks. 

 

Step Seven:  Delete the Writing Style Branch 
On second thought, you don’t really need to include Writing Style in 
your decision because you know that all three authors have a writing 
style you like. You can delete this branch easily. 

1. Click once on Writing Style to highlight it. 

2. Move your cursor to Symbolic, hold down the Ctrl key and click 
once to highlight it also. 

3. Release the mouse button. 

4. Press the Delete key, or use the Delete Selection Command on the 
Edit menu. This leaves gaps in your model. 
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5. Select the Arrange Blocks option from the View menu. Your 
model should now look like it did upon first opening Hierarchy. 
Normally, if you were making several permanent changes, you’d 
save your file often. 

Step Eight:  View the Navigator 
The Navigator is a small version of your model that you can display in 
the lower left corner of your Hierarchy window. This feature is useful 
for several reasons. You can see entire larger models that don’t fit in 
the Hierarchy window. You can click in any area of the Navigator and 
the corresponding area in Hierarchy becomes centered on your 
window. If you’ve scrolled your model off the screen, a quick way to 
recapture it is to bring up Navigator and click on an area. 

1. From the View menu, select Navigator. If you’ve highlighted any 
block in Hierarchy window, that block is also highlighted in the 
Navigator. You can size Navigator in the usual way by positioning 
the cursor on the edge of the window (the cursor will become a 
double-head arrow) and drag the window edge to the right size. 

2. To close Navigator, select Close from the Control-Menu box in its 
upper left corner. 
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   Stopping Point 

If you want, you can stop here and start again another time. Save your 
Hierarchy file and close the Hierarchy window. 

• To save your document, select Save from the File menu. 

• To close the Hierarchy, select Close from the File menu, or select 
Close from the Control Menu. 

• To close DecisionPlus, select Exit from the File menu. 

If you want to continue now, save your Hierarchy file, but do not close 
the Hierarchy window and proceed with III, Rating the Hierarchy, 
next.  
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III - Rate the Hierarchy 

Your decision model looks impressive so far. It’s time to start giving it 
some substance. We’ll help you do that in this part of the tutorial by 
assigning weights to your model so you can produce some results. We 
need to decide how important your criteria are and how much weight 
each should contribute to the decision model. Then we need to score 
each alternative against those criteria. 

We begin by rating the criteria directly connected to your goal, 
Educational, Provocative, and Humorous. This is called a rating set. Then 
we weight the subcriteria of Educational, then Provocative, and then 
Humorous. And finally, we score the alternatives. In this tutorial, there 
are a total of thirteen rating sets. 

Weighting criteria and scoring alternatives requires four main 
activities: 

• Choosing a rating method 

• Selecting rating scale views 

• Assigning rating scales 

• Entering weights or scores 

 This part of the tutorial takes 30 to 60 minutes, depending on 
your learning style. 

Step Zero:  Select AHP Rating technique 
This decision will be based on purely qualitative assessments of the 
merits of the books, and introducing new books might suggest great 
changes in the model. The Analytical Hierarchy Process is therefore 
likely to be the best technique to use in this case (see Chapter 10).  
Since DecisionPlus uses SMART as its default technique, let’s change 
techniques. 

1. In the Hierarchy window, click the Model menu to reveal its 
contents. 
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2. Click Technique and choose the AHP item. 

Step One:  Display the Criterion Rating Window 
The Criterion Rating window is where you perform the main activities 
in weighting your criteria. You should have your decision model 
active in the Hierarchy window. If your Hierarchy model is closed, 
open it (your .cdp file) from the Open command on the File menu. 

1. In the Hierarchy window, click once on your Goal block, Select a 
Book, to highlight it. 

2. From the Block menu, select Rate Subcriteria. You are entering 
weights for the subcriteria of the goal, Select a Book.  

Note:  A criterion block must be selected before you can 
display the Criterion Rating window. 



Chapter 15  A Tutorial: Select a Vacation Book 

Criterium DecisionPlus 371 

  

On the Title bar, the window name AHP Criterion Rating - Direct 
Method appears. (Direct Method is a rating method and is described in 
Step Two, “Select a Rating Method,” after this window description.) 
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The name of your goal appears in the Criterion box with the number 
1.000 preceding it. This represents the highest ranked of the unrated 
criteria and the most important of the decision model. 

 

Below the Criterion box is the Descriptive Sentence, describing the 
rating logic of the verbal rating scale you assign. The Importance scale 
is the default scale. In this example, no criteria are rated yet, which is 
reflected in the Descriptive Sentence on your screen. Our illustration 
below shows a rated example. If  you do not have Verbal Scale view 
selected, the Descriptive Sentence does not display. 

 

The next area shows the Scale Information of the scale for the 
primary view you have chosen (or in this case, the default numerical 
scale). You choose the scale you want to assign through the Assign 
Scale button. 

 

The major portion of the Criterion Rating window is the 
Subcriterion/Weight area where you enter weights and are able to 
view them in up to three different ways. You can view your weights in 
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Numerical, Verbal, or Graphical views, or in all three at once, as is 
shown when you first enter the window.  

 

Below is an illustration of all three views reflecting assigned weights. 
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• Choosing a Rating Method 
Three rating methods are available on the Method menu: Direct 
Comparison, Full Pairwise Comparison, and Abbreviated Pairwise 
Comparison. We describe and show you how to access each method, 
but for this tutorial we enter the weights using only one method. 

 

Direct Comparison is used to enter quantitative data about each 
criterion. Usually these values come from a previous analysis or from 
experience and detailed understanding of the decision problem. Direct 
Comparison is the default rating method for the Criterion Rating 
window, and is the name you see in the title bar. 

Full Pairwise Comparison means comparing in pairs and is useful if 
you lack quantitative data about each criterion, or if you feel strongly 
or similarly about most of your criteria. Each criterion in a rating set is 
compared to every other criterion in the same set. It’s easy to enter 
weights using this method because all criteria in the same set are 
verbally compared against each other, and because you can measure 
using a scale of 17 verbal weights ranging from Absolutely Better to 
Absolutely Worse. 

Abbreviated Pairwise Comparison is similar to Full Pairwise 
Comparison except that you work in smaller sets. It omits comparisons 
that are obvious. For example, if A is better than B, and B is better 
than C, then A is also better than C. The latter comparison is omitted. 

Step Two:  Select a Rating Method 
1. From the Criterion Rating window, select the Method menu. The 

method we want, Direct, is already selected and indicated with a 
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check mark in front of it. If we were to select one of the pairwise 
comparisons, we would select it here.  

2. To practice selecting a rating method, select Full Pairwise to see 
how your window changes to the following illustration. 
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 (Details about the Full Pairwise and Abbreviated Pairwise 
methods are in Chapter 10, Rate the Hierarchy.) 

3. Select the Direct method again from the Method menu before 
continuing in this tutorial. 

 

• Selecting Rating Scale Views 
DecisionPlus provides three scale views in which you can enter your 
weights: Numerical, Verbal, and Graphical. All three views appear in 
the Criterion Rating window when you first open the window. Below, 
we describe the scale views. 

  

The views show, in their own measurement, the weight you assign for 
each criterion. In addition to viewing these scales, this is where you 
actually enter the weights, which we will get to later in Entering 
Weights. If you change a value in one view, the other two views (if 
you have them displayed) reflect the equivalent value in its own 
measurement scale.  

Numerical shows your rating in numbers. The illustrated numerical 
scale above ranges from 0.00 to 100.00. 

Verbal shows your rating in words. The illustrated verbal scale above 
ranges from Trivial to Critical, and corresponds to the numerical scale 
0.00 to 100.00. 
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Graphical shows you a bar illustration of both the numerical and 
verbal values. You can’t assign a graphical scale, it is unique. 

Step Three:  Select a Rating Scale View 
1. Select the View menu. The views we want to use in this tutorial 

are already selected and are marked with a check mark. 

  

 Even though we use all three views in this tutorial, go ahead and 
click a couple of views to turn them on and off and observe the 
effect on the Subcriterion/Weight area. When you turn off Verbal, 
Descriptive Sentence automatically turns off. 

2. From the View menu, be sure all three scale views and the 
Descriptive Sentence are selected and appear in the 
Subcriterion/Weight area before continuing with this tutorial. 

• Assigning Rating Scales 
Numerical and Verbal have different scale measurements, called types, 
that you can assign. Now, we’ll show you how to assign a different 
scale type. (Details about selecting the appropriate scales for your own 
decision problems are in Chapter 10, Rate the Hierarchy.) 

 

Step Four:  Assign a Rating Scale 

Assigning a Numerical Scale 
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1. Select the Assign Scale button in the Scale Information area to 
display the Assign Scales window. 

  

 The following window displays. 

  

 In the Scale Type area, Numeric is selected as the default and in 
the Scale Information area, the name and the range for the default 
scale appears. (If the Numeric Scale Type is not available, select 
Numerical from the View menu.) 

2. In the Scale Information area, click once on the list box down 
arrow to see five system-designed numerical scales and their 
measurement ranges. 
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3. To practice selecting a scale, click once on Rank to select it. 

4. Select the Close button to return to the Criterion Rating window. 
Your Scale Information area on the Rating window now reflects 
the Rank scale information. 

5. Select the Assign Scale button again. 

6. Click the list box down arrow again. 

7. Select the Default scale. We are using this numerical scale to enter 
our weights. 

Assigning a Verbal Scale 

If you like, you can use these procedures also to practice selecting a 
different Verbal scale. When the Scale Type area first displays, it 
always defaults to Numerical.  

1. For Scale Type, select  Verbal. The Scale Information area 
changes to display the default Verbal scale, Importance. 

2. In the Scale Information area, click once on the list box down 
arrow to display six system-designed verbal scales and their 
measurement ranges, then follow the steps above to select a new 
system verbal scale. (Your verbal scale selection also is reflected 
in the Descriptive Sentence area.) 

3. If you practiced selecting a different Verbal scale, please return 
the display to the Importance scale before continuing with this 
tutorial. 

Note:  If you want to see how assigning scales affects existing 
weights, you can repeat Assigning a Numerical (or Verbal) 
Scale exercises after you enter some weights. 

Assigning a Graphical Scale 

The Graphical scale has only one view: the bar view. You can’t assign 
a different graphic scale. You can adjust the bar (thereby adjusting 
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your weight) by clicking in, or clicking and dragging to, a different 
area of the bar. 

Details for creating your own Numerical or Verbal scales are in 
Chapter 10, Rate the Hierarchy. 

• Entering Weights and scores 

Step Five:  Enter Weights for Your Criteria 
Although you can begin rating (entering weights to) any rating set you 
want, we begin with the set ranked as the most important in your 
decision model, your goal. When we finish rating all the children of 
this set, we display and rate the next set. 

Be sure all three rating views and the descriptive sentence are visible 
as shown in the following illustration. If they are not, select them from 
the View menu.  

Rating Carefully 

DecisionPlus doesn’t let you miss a rating, but it can’t tell if you’ve 
assigned the right value. If you enter a value other than the value we 
list, the next result may not be the same as illustrated. In this case, you 
can start over, or you can edit the previous rating sets. Instructions for 
starting over are in the next paragraph, and instructions for editing 
previous rating sets are described after Rating Set One. 
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Starting Over 

If at any time you want to start over, you can use the Cancel button at 
the bottom of the Rating window (a message appears, asking in 
essence if you want to erase what you just entered — select Yes). You 
can also close the Rating window and return to the Hierarchy window, 
close the file without saving it, then reopen the file. The Restore 
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Current Ratings button erases your entries to the ratings set currently 
showing in your window. 

  

 

Okay, let’s roll up our sleeves and get to work. You know that 
selecting a good book means having one or all of the three subcriteria 
listed in the Subcriteria/Weight area. However, as far as their 
contribution to the decision, you feel the strongest about Humorous, 
less strongly about Provocative, and least strongly about Educational. 
Let’s enter equivalent weights using the default Verbal Scale, 
Importance. 

Rating Set One    Select a Book 

 — Educational 

 — Provocative 

 — Humorous 

1. For each of the three subcriteria, we instruct you to click the list 
box down arrow, where “UNRATED” appears, to display the 
available verbal choices. If you prefer working with numbers, 
beginning with Rating Set Two below, we give you the equivalent 
numerical value to type into the Numerical scale. 

2. To rate Educational, select Important. Important replaces 
“UNRATED” in the Verbal view. The Numerical view also 
changes, reflecting 50, and the Graphical view is filled in about 
half way. 

3. To rate Provocative, select Very Important. Very Important replaces 
“UNRATED” in the Verbal view. The Numerical view also 
changes, reflecting 75, and the Graphical view is filled in about 
three quarters of the way. 

4. To rate Humorous, select Critical. Critical replaces “UNRATED” in 
the Verbal view. The Numerical view also changes, reflecting 100, 
and the Graphical view is filled completely. 
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 After you rate the last subcriterion of this rating set, Select a Book, 
listed in the Criterion box, gets a check mark. 

  

 

Rating Set Two     Humorous 

 — Subtle 
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 — Outrageous 

 — Witty 

1. Select the Next button at the top of the Rating window. Because 
you rated Humorous extremely high (Critical) in the first rating set, 
it becomes the next important criterion. Therefore, DecisionPlus 
assumes you want to rate its subcriteria next.  

2. To rate Subtle, select Important or click in the Numerical view and 
type 50. 

3. To rate Outrageous, select Important also, or click in the Numerical 
view and type 50. 

4. To rate Witty, select Critical, or click in the Numerical view and 
type 100. 



Chapter 15  A Tutorial: Select a Vacation Book 

Criterium DecisionPlus 385 

 

After you rate the last subcriterion of this rating set, Humorous gets a 
check mark beside it, indicating that it is fully rated. Click the Next 
button and you should find that Provocative is the next criterion to be 
rated. Go on to Rating Set Three, unless Provocative did not come up 
next.  
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Checking Previously Rated Rating Sets 

If Provocative didn’t come up next for you, check your previous 
rating set by redisplaying and editing the rating set in the Rating 
window. Use the following steps at any time to check previously 
rated rating sets. 

1. Click on the Criterion list box down arrow. 

2. Select the rating set you want (in this case, Provocative). The 
rating set redisplays in the Subcriteria/Weight area of the 
Rating widow. 

3. Compare your ratings against those suggested by us. 

4. To change the weight of a subcriterion, click the Verbal scale 
down arrow and select the correct weight. Or, click in the 
Numerical scale box and type the correct numerical weight. 

5. Select the Next button.  

The correct rating set should display in the Rating window. If this 
is not the case, if you want, you can start over following the 
Starting Over instructions at the beginning of this section. 

Rating Set Three    Provocative 

 — Exciting 

 — Inspirational 

 — Animated 

1. Select the Next button at the top of the Rating window. Provocative 
is the next criterion rating set, because in the first round you rated 
it as Very Important, second to Humorous, which was Critical. 

2. To rate Exciting, select Critical (100). 

3. To rate Inspirational, select Very Important (75). 

4. To rate Animated, select Important (50). 

Now Provocative gets a check mark. 
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Rating Set Four     Witty 

 — Jurassic Park 

 — Fried Green Tomatoes 

 — 100 Years of Solitude 

1. Select the Next button. Witty is the next criterion rating set.  
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 Notice some changes here. You might have expected to see 
Educational as the next rating set, but instead, you see Witty. Witty is 
not on the same level as Provocative and Humorous in your 
Hierarchy model. This change in order occurs because Witty 
received the highest rating, Critical, in Rating Set Two. 
DecisionPlus considers Witty now to have a greater contribution to 
the decision model than the remaining subcriteria and should be 
rated next. 

 The alternatives in the model are directly connected to Witty. We 
call criteria in this position lowest criteria. The rating set of lowest 
criteria are always alternatives. This brings us to our next point. 
When rating the lowest criteria in a decision model, the Rating 
window changes headings in the Subcriterion/Weight area. The 
word Subcriterion changes to Alternative, and Weight changes to 
Score. In AHP, when you rate alternatives, you are scoring how 
much of each criterion the alternatives have. In other words, we 
heard that 100 Years of Solitude has a fair amount of wit. Although 
we should choose another verbal scale here to rate this, we can 
convert “fair amount of wit” to a Very Important amount of wit. 

 So, what happened to Educational? DecisionPlus assumes that 
because you rated it in Rating Set One as the least important of the 
three subcriteria, and you rated Witty so high in Rating Set Two, 
Educational has the least contribution to the model and can be rated 
later. DecisionPlus assumes your time is best spent rating the most 
important criteria in your decision model first.  

2. To rate Jurassic Park, select Trivial (0). 

3. To rate Fried Green Tomatoes, select Important (50). 

4. To rate 100 Years of Solitude, select Very Important (75). 
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Rating Set Five  Educational 

 — Humanistic 

 — Cultural 

 — Scientific 

1. Select the Next button. Educational is the next criterion rating set. 

2. To rate Humanistic, select Important (50). 

3. To rate Cultural, select Unimportant (25). 

4. To rate Scientific, select Very Important (75) 

Rating Set Six  Exciting 

 — Jurassic Park 

 — Fried Green Tomatoes 

 — 100 Years of Solitude 

1. Select the Next button. Exciting is the next criterion rating set. 

2. To rate Jurassic Park, select Critical (100). 

3. To rate Fried Green Tomatoes, select Important (50). 

4. To rate 100 Years of Solitude, select Unimportant (25). 

Rating Set Seven  Inspirational 

 — Jurassic Park 

 — Fried Green Tomatoes 

 — 100 Years of Solitude 

1. Select the Next button. Inspirational is the next criterion rating set. 

2. To rate Jurassic Park, select Very Important (75). 

3. To rate Fried Green Tomatoes, select Important (50). 

4. To rate 100 Years of Solitude, select Critical (100). 
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Rating Set Eight  Subtle 

 — Jurassic Park 

 — Fried Green Tomatoes 

 — 100 Years of Solitude 

1. Select the Next button. Subtle is the next criterion rating set. 

2. To rate Jurassic Park, select Very Important (75). 

3. To rate Fried Green Tomatoes, select Important (50) 

4. To rate 100 Years of Solitude, select Trivial (0). 

Rating Set Nine  Outrageous 

 — Jurassic Park 

 — Fried Green Tomatoes 

 — 100 Years of Solitude 

1. Select the Next button. Outrageous is the next criterion rating set. 

2. To rate Jurassic Park, select Very Important (75). 

3. To rate Fried Green Tomatoes, select Critical (100). 

4. To rate 100 Years of Solitude, select Trivial (0). 

Rating Set Ten  Scientific 

 — Jurassic Park 

 — Fried Green Tomatoes 

 — 100 Years of Solitude 

1. Select the Next button. Scientific is the next criterion rating set. 

2. To rate Jurassic Park, select Critical (100). 

3. To rate Fried Green Tomatoes, select Unimportant (25). 

4. To rate 100 Years of Solitude, select Important (50). 

We’re almost finished! 
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Rating Set Eleven  Humanistic 

 — Jurassic Park 

 — Fried Green Tomatoes 

 — 100 Years of Solitude 

1. Select the Next button. Humanistic is the next criterion rating set. 

2. To rate Jurassic Park, select Important (50). 

3. To rate Fried Green Tomatoes, select Very Important (75). 

4. To rate 100 Years of Solitude, select Very Important (75). 

Rating Set Twelve  Animated 

 — Jurassic Park 

 — Fried Green Tomatoes 

 — 100 Years of Solitude 

1. Select the Next button. Animated is the next criterion rating set. 

2. To rate Jurassic Park, select Critical (100). 

3. To rate Fried Green Tomatoes, select Important (50). 

4. To rate 100 Years of Solitude, select Unimportant (25). 

Rating Set Thirteen  Cultural 

 — Jurassic Park 

 — Fried Green Tomatoes 

 — 100 Years of Solitude 

1. Select the Next button. Cultural is the next criterion rating set. 

2. To rate Jurassic Park, select Unimportant (25). 

3. To rate Fried Green Tomatoes, select Very Important (75). 

4. To rate 100 Years of Solitude, select Important (50). 
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Step Six:  Complete the Ratings 
When you select the rating for 100 Years of Solitude in this rating set, 
you have completed rating your decision model and when you select 
Next, you see the following message. 

  

1. Select OK or Press ENTER. The Rating window stays open. 

2. On the Rating window, select the OK button at the bottom of the 
window to store your ratings. The Hierarchy window displays. 
Your ratings are still stored, but not saved.  

Step Seven:  Save Your Ratings 
• Select Save from the Hierarchy File menu. 

What a task! But now you have something to show for your careful 
work. 

   Stopping Point 

If you want, you can stop here and start again another time. Save your 
Hierarchy file and close the Hierarchy window. 

• To save your document (if you have not already), select Save from 
the Hierarchy File menu. 

• To close Hierarchy, select Close from the File menu, or select 
Close from the Control Menu. 

• To close DecisionPlus, select Exit from the File menu. 
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If you want to continue now, save your Hierarchy file, but do not close 
your file or the Hierarchy window and proceed with IV, Selecting the 
Best Alternative, below.  

 

IV - Selecting the Best Alternative 

The results of your decision model should come out close to what you 
expected from the start. The book with the highest score should be the 
likely choice based on the criteria you weighted the highest. If you get 
completely unexpected results, you should check your model structure, 
weights and scores.  

In this section, you’ll have DecisionPlus calculate your results 
automatically when you select the Decision Scores window. 

 This part of the tutorial takes about 10 minutes. 

Step One:  Display the Decision Scores 
• From the Hierarchy menu, select Decision Scores from the Results 

menu. The following Decision Scores window below displays 
showing the results of your decision model. 
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This view shows your alternatives in the order they appear (vertically) 
in your Hierarchy  Jurassic Park is the winner, or the preferred 
alternative, although not by a large margin. We’ll show you what that 
can mean later in this chapter. 

Clicking the Scores option in the Sort option rearranges your graph 
results from highest decision score to lowest. In this small model, they 
just happen to be in that order, so your display won’t change if you 
select this option. 
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To Display the Results Data window 
If you prefer to see the decision scores in a spreadsheet, you can do 
that easily by selecting it from the View menu in the Decision Scores 
window. 

1. In the Decision Scores window, select Results Data from the View 
menu to display the results in a spreadsheet. 

  

Your results may be arranged differently in this display, and the 
numbers should be close. That’s okay. Major differences mean that 
you could have done something out of order or assigned a different 
value than we listed in a place that could sway the results dramatically. 

To Close the Decision Scores Window 
• Select the Close button in the General portion of the window. 
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   Stopping Point 

If you want, you can stop here and start again another time. Save your 
Hierarchy file and close the Hierarchy window. 

• To save your document, select Save from the Hierarchy File menu. 

• To close Hierarchy, select Close from the File menu, or select 
Close from the Control Menu. 

• To close DecisionPlus, select Exit from the File menu. 

If you want to continue now, save your Hierarchy file, but do not close 
your file or the Hierarchy window and proceed with IV- Reviewing 
the Results, below.  

V - Reviewing the Results 

DecisionPlus provides different ways in which you can view your 
results. We talk about two of them. You can view how sensitive the 
scores of your alternatives are to changes in weights, and you can view 
how, and to what extent, the highest rated criteria contributed to those 
scores. 

 This part of the tutorial takes about 15 minutes. 

Step One:  Display the Sensitivity by Weights Window 
1. In the Hierarchy window, select Sensitivity by Weights from the 

Analysis menu to display the Sensitivity by Weights window 
below. 

2. Click the Update button to calculate all sensitivities. 
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You are looking at the sensitivity of the models to the weight of 
Provocative with respect to the goal, Select a Book. The identity of the 
weight can be seen both by the highlighted item in the Criticality list 
box and in the graph title. The sloping lines on the graph represent 
scores of the alternatives and correspond to the colors of the 
alternatives that are listed to the right of the graph. The vertical red 
line, with a red bullet-shaped pointer (we call it a slider) at its base, 
indicates the current priority value for this weight. That is to say, 
although the weights you entered in the Criterion Rating window 
might have been entered in a scale using units of dollars or miles, 
DecisionPlus calculates a value on a universal priority scale from 0 to 
1 for each of those weights. 



Chapter 15 A Tutorial: Select a Vacation Book 

398 Criterium DecisionPlus 

The point where the red line intersects an alternative line is that 
alternative’s score (as can be verified in the Decision Scores window). 

The Criticality list box lists all the criteria weights in the model, from 
those to which the results are most sensitive to, at the bottom of the 
list, those to which the model is least sensitive. Those at the top are the 
most critical because small changes in their value can change the 
outcome of the model. The percentage on each line is the amount of 
change in the priority of that weight required to change the outcome of 
the model. If the percentage was 5% or less, indicating that a change 
of less than 5% would change the preferred alternative, we would 
recommend reassessing your model structure, weights and scores. 

When you first display the window, the Current Value is the same as 
the priority value for the red line. The Current Value is the value for 
the weight, 50, you assigned to the subcriteria, Educational, with respect 
to the criteria, Select a Book. If you select another weight in the 
Criticality list box, the value changes to reflect the priority of that 
weight. 

The Temp Value reflects the changes you might make in this window 
to check results. Once you leave the Sensitivity by Weights window, 
your scores return to their original, or Current, value.  

Step Two:  Check the Sensitivity of the Scores 
Judging from the results in this graph, we have a somewhat sensitive 
result. We mentioned earlier that we would show you what the close 
results meant. Notice in your graph that Jurassic Park remains the 
preferred alternative until you move the slider to the left about 8%. 
Try it. Hold the mouse button down and drag the slider to the left to a 
Temp Value of about .22.  

At that point, the lines for Jurassic Park and Fried Green Tomatoes 
cross over, and Fried Green Tomatoes becomes the preferred 
alternative. You didn’t have to move the slider very far before you 
produced a crossover. This means, that your model results are 
sensitive to somewhat small changes in the priority value. Because the 
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required change here is more than 5%, we would recommend that the 
model needs no reassessment. 

Step Three:  Select Another weight Combination 
In the Criticality box, select the combination Select a Book-Humorous to 
produce the following display. 

 

There is a crossover point between Jurassic Park and Fried Green 
Tomatoes. You would have to slide your priority value from .44 to 
somewhere around .57 to cause Fried Green Tomatoes to rate higher 
than Jurassic Park for the Select a Book-Humorous pair. 

For details about sensitivity in your model, see Chapter 13, Analyze 
the Results. 
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Step Four:  Viewing Contribution by Criteria 
Another way to check your results is to investigate why Jurassic Park 
is preferred over Fried Green Tomatoes.  

1. Close the Sensitivity by Weights window. The Hierarchy window 
redisplays. 

2. In the Hierarchy window, select Contribution by Criteria from the 
Analysis menu to display the Contribution by Criteria window. 

 

The colors in the bars correspond to the criteria listed to the right of 
the graph. (The colors on your monitor are a better example than the 
shades of gray and black in our illustration above.) These colors 
represent the amount of contribution each criterion made to that 
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alternative’s decision score. You can immediately see that while Fried 
Green Tomatoes would be more humorous than Jurassic Park, 
Jurassic Park’s superiority in terms of Provocative and Educational 
aspects more than outweigh its lack of humor. 

For details about this window, see “Viewing Contribution by Criteria” 
in Chapter 13, Analyze the Results. 

This concludes the tutorial. According to the results you presented, 
you should have confidence in taking Jurassic Park along on your 
vacation. 

Close the Contribution by Criteria Window 
• Select the close button in the lower right corner of the window. 

Saving Your Results 

If you didn’t save your work before viewing the results, you can do so 
now. 

• In the Hierarchy window, select Save from the File menu. 

Closing the Hierarchy window 

• In the Hierarchy window, select Close from the File menu. 

What’s Next? 

Many printing options are available in which you can print your 
results. If you want to print your results, turn to Chapter 14, Document 
the Results, for a list of reports available and instructions for 
producing those reports.  
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If you are ready to begin entering your own decision problem, turn to 
Part III, Designing Your Own Model. We suggest that you read the 
Building Your Own Decision Model checklist first in preparation for 
building your own model. 
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Added Information  
The next three sections provide information to give you a better 
understanding of concepts and functions, and to help you find what 
you need. In addition, we provide information about algorithms that 
we use in DecisionPlus. 
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Glossary 

Abbreviated Graphic Pairwise Comparisons  A rating type that 
compares each item graphically to one other item in its rating 
set. Enter these ratings in the Criterion Rating Window by 
sliding the bar end on a bar graph toward the item that rates 
higher with respect to the parent block (see Abbreviated 
Pairwise Comparisons in this glossary).  

Abbreviated Numeric Pairwise Comparisons   A rating type that 
compares each item numerically to one other item in its rating 
set. In the Criterion Rating Window, enter these ratings in 
numbers ranging from 1 to 9 on a matrix to reflect how much 
one item is superior to another with respect to a common 
criterion 

Abbreviated Pairwise Comparison Method  Compares each block 
in a rating set to another block in the same set. Abbreviated 
Pairwise comparisons are quicker but not as thorough as full 
sets of pairwise comparisons. Use this format for a quick draft 
of a decision, to narrow down a large field of alternatives, or 
when absolute precision is not paramount (see Direct Ratings, 
Full Pairwise Comparisons, Pairwise Comparisons in this 
glossary). 

Abbreviated Verbal Pairwise Comparisons  This rating type 
compares each criterion verbally to another criterion in the 
same rating set. Enter these ratings by selecting a word from a 
supplied list that best represents the relationship between two 
criteria. For example, you would choose a word to accurately 
complete the sentence “With respect to Criterion 1, item A 
rates Absolutely better than item B." 

Accumulated Values  The decision score for an alternative in the 
model is the sum of all the ratings of that alternative against 
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each lowest criterion (or attribute), weighted by the 
importance of  that criterion to the decision.  If you imagine 
the hierarchy as a network of waterways flowing from the 
alternative to the Goal, the decision scores are the 
accumulation of all the flows from that alternative to the Goal.  
The Accumulated Value for any criterion (not just the Goal), 
and for a given alternative, is the accumulation of the flows 
along all pathways from that alternative to that criterion.  The 
Accumulated Values for a criterion may be seen directly as the 
height of the alternatives’ histogram bars in the Contributions 
by Criterion screen (where that criterion is chosen as the target 
criterion). 

Accumulated Weights  The accumulated or effective weight of any 
criterion in the model is the product of all the priorities along 
each path from the Goal to that criterion, summed over all 
such paths.  For many models, each subcriterion only has a 
single parent criterion, so there is only one path to the Goal, 
and the accumulated weight for that criterion is just the 
product of the priorities of each connection from the Goal to 
that criterion.  In the case of the Goal, the accumulated weight 
is always 1.  The Accumulated Weight for a lowest criterion 
or attribute is exactly its Model Weight (see Glossary below). 

Aggregation  The mathematical process of calculating the results in 
the decision model.  The basic paradigm is that of a weighted 
sum. 

AHP  The Analytical Hierarchy Method is a decision analysis 
technique invented by Professor T. L. Saaty (see the 
References section). In its original form the technique was 
based on the Full Pairwise Comparison Method and relative 
Normalization. 

Alternatives Rating Technique  A technique that allows the user to 
rate an alternative against every lowest criterion in terms of 
the scales of that criterion, and then normalize those ratings.  
Examples are AHP and SMART. 
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Ancestor  The parents and grandparents of a particular block or 
criterion in the model. 

Alternatives A set of options which you either wish to prioritize 
and/or from which you wish to choose a “best” alternative 
with respect to a specified set of criteria. Alternatives are 
always the lowest level of a decision hierarchy and are always 
compared with respect to the lowest criteria on every branch 
(see Criteria in this glossary). 

Attribute  The term in the SMART methodology for the Lowest 
Criterion in a model. The ratings of on Alternative are with 
respect to attributes. 

Best/Worst(Scale)  When defining a Numerical Scale, you are asked 
to decide whether the scale limit with the higher numerical 
value corresponds to the Best or Worst end of the scale.  By 
assigning the higher numerical limit to Best you are indicating 
that higher numerical ratings on this scale correspond to a 
higher overall decision score for the alternative. By assigning 
the higher numerical limit to Worst you are indicating that a 
higher numerical value will result in a lower overall decision 
score.   

Best/Worst(Uncertainties)  The Best/Worst uncertainty 
approximation to an actual uncertainty distribution is simply a 
triangular distribution whose extreme horizontal points 
correspond to those of the actual distribution, and whose 
Mode corresponds to the mean of that distribution.  Its area, 
since it is a probability distribution, is always unity.  It is the 
simplest 3 point approximation to an arbitrary uncertainty 
distribution - but is often a very poor approximate, as it allows 
too much probability at the end limits.  

Block  A graphical representation of the most basic elements, such as 
a Criterion, Subcriterion, Attribute (SMART) and Alternative, 
of a decision hierarchy. The first block is always the goal (See 
Goal in this glossary). 
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Brainstorm  A DecisionPlus mode allowing ideas to quickly be put 
into consideration when building a model.  Brainstorm results 
can be saved and recalled when needed.  Though a stand alone 
capability, brainstorm graphs are most often used to prepare a 
decision hierarchy. 

Branch  Any parent block in the hierarchy and all its descendants, 
excluding Alternatives. Except for the alternatives, every 
block is the parent of at least one branch. Large branches often 
contain many smaller branches. 

Calculation  Determination of results in a decision model based on the 
most current ratings and rules. Results comprise both decision 
scores (and related analysis data) and Uncertainty Results (and 
related analysis data). Criterium DecisionPlus calculates 
decision scores every time you enter a set of ratings. 
Uncertainty results are calculated when the user chooses to 
update them. 

Children  Child blocks are always defined with respect to a common 
parent block. A child block is directly to the right of its parent 
block, but may actually skip a level or two. A child block may 
also be a parent block (see Block and Parent Block in this 
glossary). 

    

Compact Centered View  Where parents are centered, vertically, on 
the screen, but not necessarily centered before their 
descendants (see Family Centered View in this glossary). 

Consistency  The measure of how consistent each rating is in relation 
to all other comparisons in a particular pairwise rating set. 
Because of how the AHP works, perfect consistency is not 
necessary for Criterium DecisionPlus to compute valid results. 

Criteria  The factors on which you base your decision—what you 
think is important to consider to make an informed choice. 
They comprise the middle blocks of a decision hierarchy, 
between the goal and the alternatives. Criteria are rated to 
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determine which is most important to the decision goal. (See 
Lowest Criteria.) 

Criticality  A metric that measures the sensitivity in a decision model. 
If one criterion weight is varied and causes a crossover 
(reversal of preferences in alternatives), then this is critical to 
the decision. Criticality measures the nearness of a crossover 
when varying a particular criterion weight. The lower the 
number, the closer the crossover and the more critical that 
particular weight is. 

Crossover A reversal of preferences in alternatives.  See Criticality. 

Current  The block, branch, or level of hierarchy where a particular 
function is being performed. The current block is usually 
highlighted. Current is also used to describe the window in 
which you are working. 

Data  Information in your decision model. Data includes block names, 
and your evaluations in terms of weights/ratings, rules, and 
notes. 

DDE (Direct Data Exchange)  DDE is a mechanism that allows one 
application running under Microsoft Windows to share 
information with another.  DDE is effected via the Windows 
Clipboard, not by any sharing of data files. To what extent 
each application supports DDE should be determined by 
examining that application's documentation.  (For more 
information on DDE and on the Windows Clipboard, see your 
Windows or Windows95 documentation.) 

Decision Hierarchy  The visible structure of a decision. Elements of a 
decision are organized to form a framework from left to right. 
At the far left of a hierarchy, the goal of the decision stands 
alone. Branching to the right from the goal block are criteria 
and subcriteria from the most general to the most specific. 
Branching from the last (farthest right) level of subcriteria are 
the alternatives under consideration (see Decision Model in 
this glossary). 
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Decision Model  Model refers to the entire decision. A decision model 
includes the hierarchy, ratings, rules, notes, and everything 
that comprises the decision (see Decision Hierarchy in this 
glossary) 

Decision Process  A logical sequence of activities that facilitates the 
making (or not making) of a decision may be called a decision 
may be called a decision process.  Many different processes 
have been suggested for facilitating the structuring, analysis 
and execution of decisions.  The generic process whose 
implementation Criterium DecisionPlus supports, is outlined 
in the section Making Decisions. 

Decision Scores The decision scores of an alternative is the overall 
score of that alternative within your decision model.  Its value 
measures the preference of that alternative, i.e., how well that 
alternative meets your decision goal.  Alternatives are ranked 
by the relative values of their decision scores.  Conceptually, 
the decision score of an alternative is the sum of its rating 
against each lowest criterion, weighted by the relative 
importance of those criteria.  

Defaults  The initial or original setting, which Criterium DecisionPlus 
uses unless you specify a different one. 

Descendant  The child of a parent or the children of the child in the 
hierarchy model. All blocks or criteria at lower levels in the 
hierarchy connected to a particular block or criterion. 

Device  File or printer. The place where print reports are sent when 
Print is selected. 

Direct Graphic Ratings  A rating type in which each item is scored 
individually on a bar graph. The length of the graph bar is 
adjusted to reflect the ratings of the item with respect to its 
parent block. 

Direct Numeric Ratings  A rating type in which each item is scored 
individually on a numeric scale of your choice. Numbers 
representing the item’s score with respect to its parent block 
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are entered in each item’s entry field. The direct numeric 
rating type works best when entering hard data, like the cost of 
an item, the number of miles per gallon, number of years of 
experience, and so on 

Direct Rating Method  One of Criterium DecisonPlus’s three rating 
methods.  In direct ratings, data is entered about each element 
of a rating set individually, instead of in comparison to one or 
more other elements (see Abbreviated Pairwise Comparisons 
and Full Pairwise Comparisons). 

Direct Tradeoffs Hierarchy Technique  The user directly fixes the 
tradeoffs between two lowest criteria and their scales.  This 
approach provides a Hierarchy Rating Technique to 
establishing the relative importance of all lowest criteria in a 
decision hierarchy.  An other Hierarchy Rating Technique is 
to use Weights. 

Direct Verbal Ratings  A rating type in which each item is scored 
individually on a verbal scale of your choice. Verbal scales 
can reflect opinion, such as the Quality scale, or hard data, 
such as A to F. 

Disconnected Blocks in Hierarchy  If a block in the Hierarchy 
structure has a link to the Goal block (directly or through a 
number of other parent criteria), and has a link to at least one 
alternative (directly or through a number of other parent 
criteria) that block is said to be fully connected.  Any block in 
the model that is not fully connected is said to be 
disconnected.  No results calculation can take place if there is 
a disconnected block in the Hierarchy. 

Distant Child  A child that skips one generation. 

Duplicate  Block  Any block that appears at more than one location 
on the hierarchy. The duplicated block has the same parents, 
children, scales as the original block. 

Enabled/Disabled  Certain features of the screen interface (buttons, 
menu items, list boxes,..) may be disabled if their function is 
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not compatible with the state of the application.  A disabled 
feature is usually dimmed or greyed and will not respond to 
mouse clicks or keyboard prompts.  The feature is said to be 
enabled when its normal functionality and appearance are 
restored. 

Entry Field  The portion of any window where you enter data. The 
current entry field is always highlighted. 

Error Message  A message that appears at the center of the screen 
when Criterium DecisionPlus detects an error or cannot 
perform a requested task. The user must select the OK button 
(or press Return) or choose other available options before 
proceeding. 

Exporting  The process of transferring a Criterium DecisionPlus  
spreadsheet, table or graph to another Windows application.  
Generally this can be effected using the Copy menu item 
under the Edit menu. 

Family Center View  Where parents are centered before their 
children. In family view, parents are more symmetrically 
distributed and usually take up more space than in Compact 
Centered View (see Compact Centered View in this glossary). 

Filename  The name you give the file of your decision model when 
you save or retrieve files on a disk. Criterium DecisionPlus 
filenames can be up to eight characters long with an optional 
period and a three letter extension, and can contain letters, 
numbers, and the underscore (_). Criterium Decision Plus 
Hierarchy files have the default extension (*.cdp) and 
Brainstorm files (*.bst).  [The Windows95 operating system 
supports longer filenames, and CDP will open such files.  
However the File Open, Save and Save As dialogs will display 
the names in a truncated format and this can lead to 
confusion.] 

Full Graphic Pairwise Comparisons  A rating type in which each 
item is compared graphically to every other item in the same 
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rating set. Weights are entered by sliding the graph bar toward 
the item that rates higher with respect to the parent block. 

Full Numeric Pairwise Comparisons  A rating type where each item 
is compared graphically to every other item in the same rating 
set. Ratings are entered in numbers (ranging from 1.0-9.0) to 
represent how much one item is superior to another with 
respect to their parent block. 

Full Pairwise Comparison Method  A full set of pairwise 
comparisons involves comparing every element of a rating set 
to every other element of that set. Full pairwise comparisons 
are the most extensive and precise of the rating ranges (see 
Abbreviated Pairwise Comparisons, Direct Rating, Pairwise 
Comparisons in this glossary). 

Full Verbal Pairwise Comparisons  A rating type in which each item 
is compared verbally to every other item in the same rating 
set. Ratings are entered by selecting the word that best 
represents the relationship of the two items. For example, you 
would choose a word that would accurately complete the 
sentence “With respect to Criterion 1, item A rates Absolutely 
better than item B.” 

Fully Connected  A criterion in the decision hierarchy is said to be 
fully Connected if it is connected (indirectly or not) to the 
Goal and (indirectly or not) to at least one alternative.  The 
entire Hierarchy model is said to be fully connected if every 
criterion in it is fully connected.  

Goal Block  The first block in any decision hierarchy to which all 
other blocks relate. The goal is always the only block in the 
first (Goal) level of a decision hierarchy. 

Goal (Decision)  The decision that the user wants to make and that is 
based on the included criteria. The purpose of the model is to 
identify the alternative that best satisfies the Goal as measured 
by the specified, weighted criteria.  
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Graphic Views  The most visually oriented of Decision Plus’s three 
rating, the graphic style allows you to express your judgment 
of elements with bar graphs. When using pairwise 
comparisons, you slide the end of a bar toward the alternative 
that rates highest. If you are rating alternatives directly, you 
slide the end of the bar along the bar graph scale for each 
individual alternative. 

Handles  Black squares at the corners of an object. 

Hard Data  Specific quantitative data (such as top speed of a car in 
miles per hour) on items in a rating set. When such data is 
available and should appear as part of the decision process, it 
can be entered in one of the Direct rating types. 

Hierarchy  See Decision Hierarchy in this Glossary.  

Hierarchy Order  is an ordering for blocks, criteria or alternatives 
according to the visual structure of the hierarchy - by levels 
starting at the Goal, then by block, from the top of each level. 

Hierarchy Rating Technique  A technique that allows the user to 
establish the relative importance of all lowest criteria in a 
decision hierarchy.  Examples are Direct Tradeoffs and 
Weights. 

Highlight  A reverse video area used on the window to indicate 
current blocks, commands, and entry fields. 

Ideal Solution  This represents the results of the perfect alternative 
that scores perfectly across all the criteria in the decision 
model. The ideal solution can be used as a reference point for 
evaluating how good the alternative really are. 

If/Then Rule  A conditional rule stating that if an alternative falls 
short under one criterion, it must meet a specified condition in 
another area to remain under consideration.  These rules are 
created using the Rules menu item in the Criterion Weighting 
Window. 
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Inconsistency Ratio  A condition that arises when the various 
pairwise comparisons are not entirely consistent. Although 
inconsistency does not necessarily mean that a model results 
in a bad decision, it is usually best to have consistent 
judgments. 

Level  The vertical groupings (columns) of blocks that help organize 
the hierarchy (branches are the horizontal groupings). Level 
names appear in the Level Bar at the top of the canvas. A level 
of the hierarchy includes all blocks in the column below that 
level title. Levels are often organized according to specificity, 
with the most general criteria branching off to the most 
particular. 

 The Goal block is always at the far left, in the level called 
Goal. Alternatives are always at the rightmost level of the 
hierarchy. Criteria, scenarios, and decision-makers fall in the 
levels between.  

Level Bar  Gray bar at the top of the Hierarchy canvas composed of 
cells containing Level titles. When a cell in the level bar is 
clicked, the name it contains may be edited. The width of 
levels may be adjusted by dragging the ends of the cell 

Link  A connection that allows the results of one file to be included in 
the calculations of another file’s results. A link can be created, 
updated, and removed using the Link item in the Block menu 
of the Hierarchy window. (See Master File in this glossary). 

Lowest Criteria  Any criterion that is connected directly to at least 
one alternative.  This could be a criterion in the level 
immediately preceding the alternatives, or a criterion in a 
higher level.  In the language of the SMART methodology, 
these are referred to as Attributes. 

Master File  The file to which another file is linked (see Link in this 
glossary). 

Method  See Rating Method. 

Model  See Decision Model. 
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Model Name and Note The Hierarchy model can have both a name 
and a note attached to it. When you create a new Hierarchy, 
either from Brainstorm or directly, you are presented with the 
Notes Dialog. This is a good opportunity to enter information 
as to why you are creating the model, who is involved, etc..  
You can choose to cancel from the Notes dialog, and enter the 
information later in the Hierarchy window, by choosing Notes 
from the Model menu.  The Name and Notes will be printed 
with the Hierarchy Notes and Rules print option. 

Model Weight  is the effective weight of a lowest criterion or attribute 
in a decision model.  No matter how many levels in a 
hierarchy, the entire model is equivalent to one containing the 
Goal connected directly to the lowest criteria with the Model 
Weights as weights.  You can see the values of the Model 
Weights directly in the Data View of the Decision Scores 
screen or by choosing the Show Accumulated Weights item 
under the View menu in the Hierarchy. 

Navigator  In hierarchy, this option displays a reduced view of the 
entire Decision Hierarchy model in a separate window.  
Clicking anywhere in that reduced view, will scroll the 
Hierarchy to the corresponding point in the model. 

Normalization  A mathematical method in that allows you to handle 
your differing weight scales on an equal footing. All scales are 
converted to a common scale that takes a value between 0 and 
1. Under the AHP methodology, a relative normalization 
approach is used where the weight of one subcriterion with 
respect to a given parent criterion is divided by the sum the 
weights of all that parent criterion’s subcriteria. In SMART, 
Ratings of Alternatives against Attributes are normalized 
using user defined Value Functions. (See Value Functions in 
this Glossary.) 

Notes  Information that you attach to a block. Notes can be any 
information about that block, such as why you rated it the way 
you did, why it is included at all, a message to someone 
looking at the hierarchy, or other background information. 
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Notes Dialog The dialog window that allows you to enter the name of 
a Block and pertinent notes about that block.  In both 
Brainstorm and Hierarchy, this dialog can be accessed by 
selecting a block, and using the key chord Ctrl-N.   Model and 
Level Notes may be entered by selecting the Notes item in the 
Model and Level menus in the Hierarchy Window.  Notes can 
be up to 64KB, and the Notes window supports cutting and 
pasting 

Numeric Scale  A numerical rating view to express your distinctions. 
Values for each evaluation are entered on a numerical scale. 
You define these by specifying the units and the values 
corresponding to worst and best cases. Direct Numeric rating 
can be the most concise rating type, if you have hard data to 
enter. Some comparisons lend themselves best to numeric 
ratings, such as cost. You might feel most comfortable 
expressing a distinction numerically, rather than with a word 
or a graph (see Graphic, Verbal in this glossary). 

Numerical Scale View  Text boxes in the Criterion Rating Window, 
representing the Numerical Scale you assign, in which 
numbers may be directly entered. 

Orientation (Scale)  When defining a Numerical Scale, you are asked 
to decide whether the limit with the higher numerical value 
corresponds to the Best (i.e. higher numerical values 
correspond to a higher over all decision score) or Worst (i.e. 
higher numerical values correspond to a lower over all 
decision score).  In the former case, the scale is said to have a 
positive orientation, in the latter, a negative orientation.  A 
numerical scale with a negative orientation may be referred to 
as a "reverse" scale. 

Orphan  A Block or criterion that is not connected or associated with 
any Parent Block.  Not uncommon while Brainstorming.   

Pairwise Comparisons  Pairs of elements you choose to compare 
with respect to a parent criterion. Depending on how extensive 
a process is you wish to apply, you can select a full or an 
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abbreviated set of pairwise comparisons (see Abbreviated 
Pairwise Comparisons, Full Pairwise Comparisons in this 
glossary). 

Parent Block  In a graphical display, any block with children . The 
parent block of any branch of the hierarchy is the block which 
is at the far left of that branch (see Branch Parent and Child 
Block in this glossary). 

Parent Criterion  Any criteria with subcriteria or Alternatives. A 
parent can have only seven subcriteria but up to 50 
Alternatives (see Criterion in this glossary). 

Phantom Block  When a block on one level is connected to a block 
two levels lower in the hierarchy, the missing block in the first 
lower level is called a phantom block. Double-clicking on the 
line at the missing block level produces a broad red line at that 
level indicating a phantom block. 

Preference  The ranking of the alternatives after calculating the 
results. The most preferred alternative is the one with the 
highest decision score. Criterium DecisionPlus calculates the 
decision scores of the alternatives based on the criteria and 
weights assigned to them in the model. 

Priority Value  The value of weights after Normalization. This is the 
effective weight the model uses in calculating decision scores. 
It takes a value from 0 to 1 (see Normalization in this 
Glossary). 

Primary View  The rating set of a criterion may have multiple views.  
However, a graph, such as that of a Value Function, must be 
drawn with respect to a single scale.. Therefore, in the event 
that there are multiple views assigned, the Primary View is 
used.   

 If the criterion has only one View, then the Primary View is 
that view.  If multiple views are employed, the Primary View 
is determined in the following manner.  If a Numerical View is 
used, then it is always the Primary View.  In the absence of a 
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Numerical view, the Graphical View is the Primary view.  In 
the absence of Numerical and Graphical views, the Verbal 
View is, by default, the Primary View. 

Probability Distributions  A probability distribution is a simple way 
to quantify uncertainties in values. In DecisionPlus, 
distributions are histograms defined on a scale of your choice. 
The height of the histogram bar tells you the probability that 
the value on that scale would fall in that bin. If the scale on 
which you estimate project lengths is in weeks, and if the 
histogram is highest at seven weeks, then that is the most 
likely length of the project. The area (the sum of all the bin 
heights times the bin width) under the histogram between 
seven and eight weeks gives you the probability that the 
project can be finished anywhere between seven and eight 
weeks. DecisionPlus uses 200 bins in each screen plot, so the 
histogram may appear to be a curve. 

Process Diagram  A diagram showing the steps and their sequencing 
that are involved in decision making.  The balloons indicate 
specific activities supported by DecisionPlus, and the flow 
lines show where you might go next on completion of a given 
activity.  The Process Diagram can be accessed in the on-line 
Help by using the key chord Shift F1. 

Rank Reversal  In AHP, when a new alternative is added to a model 
that is close to the preferred alternative in goodness it can 
cause a change of position in alternatives when the results are 
calculated (a reversal of rank). 

Rating  In SMART, a rating is a value you assign an alternative with 
respect to an Attribute. You can assign ratings through the 
Criterion Rating window, using any combination of three 
rating views, Numeric, Verbal, or Graphic, and using one of 
three rating methods, Direct, Pairwise, or Abbreviated 
Pairwise Comparison. 

Rating Method  A method to assign a weight to a subcriterion with 
respect to a parent criterion. Criterium DecisionPlus provides 
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for Direct, Full Pairwise and Abbreviated Pairwise Rating 
methods. 

Rating Set  All children of the same parent, including distant children 
(no parents in between). Elements of a rating set may be 
criteria, subcriteria, attributes (SMART), or alternatives. The 
elements of a set are rated with respect to their parent block.  

Rating Type  One of the ways in which you can enter evaluations. 
Different rating types are particularly suited to different kinds 
of data, decisions, and personal tastes. In the Criterion Rating 
window, a Rating Type is chosen by specifying both a Method 
and a set of Views. 

Rating View  A representation of the value of the weight of a 
subcriteria with respect to a criterion. Criterium Decision Plus 
supports Verbal, Graphic and Numerical Views. Any 
combination of the Views may be chosen when assigning 
weights to subcriteria. 

Rating Window  Where blocks are evaluated with respect to a parent 
criterion. After structuring the hierarchy in build mode, the 
next step toward a complete decision is entering ratings in a 
rating window. Rating sets are rated one at a time. Criterium 
DecisionPlus has nine different decision-making formats 
which are selected by choosing items for the Method and 
View menus. 

Recycle Bin  Temporarily stores ideas you would prefer to deal with 
at a later time.  Available only on the Brainstorm Canvas. 

Relative Weights  tell you how important one lowest criterion (or 
attribute) is compared to another.  Their value are the ratio of 
the respective Model Weights (see Glossary) and may be seen 
directly in the Tradeoffs of Lowest Criteria window. 

Resource Tracking  Often a decision is about prioritizing a number of 
alternatives, and choosing as many alternatives as allowed by 
constraints in terms of resources.  A common example might 
be deciding which sets of projects can be afforded within a 
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given budget.  Once the alternatives have been ordered in 
terms of preference, it is very useful to be able track the 
cumulative usage of the constrained resource(s), so that it is 
apparent how many of the alternatives may be afforded.  This 
may be done in the Decision Scores window. 

Right Click  To Right Click a menu item, say, you would depress the 
Right-most button on your mouse (pointing device).  This is 
true whether your mouse has two or three buttons.  But many 
mouse devices do let you reprogram the buttons, so beware.  
In the Hierarchy window, Right Clicking a block provides fast 
access to relevant menu items such as Edit Notes. 

Risk Analysis  When analyzing a decision in terms of risk, you need 
to know both the likelihood of something going wrong and 
how much it will cost you if it does go wrong, and how much 
you would gain if it is successful. For example, when 
choosing which proposed product your company should 
concentrate its resources on, you could use a forecasting tool 
to model your expected revenue—a 20% chance of realizing a 
profit of over $100,000, 50% of profits up to $100,000, and a 
30% chance of losing your development costs of $60,000.  

 Such a risk analysis for each product is a key criterion in your 
decision, but there are invariably many other factors to be 
included. DecisionPlus lets you feed the results of that 
analysis directly into the model, and include those 
uncertainties with others more qualitative factors to determine 
which product is the best risk for your company. 

Rule  Allows you to set standards that your alternatives must meet in 
order to be considered. Alternatives that fail rules are not 
eliminated from calculations, but the failure is noted in the 
Results Window and in printed reports (see If-Then Rule, and 
Simple Rule in this glossary). 

Save  Saves or updates your Brainstorm or Hierarchy model. 

Scale  A scale provides an abstract measure of how much you prefer a 
Criterion or Alternative.  Scales may be quantitative (dollars, 
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miles per hour) or qualitative (importance, preference) in 
nature (see Verbal, Numerical Scales).  They have both extent, 
defined by Best and Worst Values, and units.  It is important 
to choose a scale that best fits how you compare the items in 
question. 

Scale View  A portion of the Criterion Rating Window that allow the 
user to select the scale to be applied when entering criterion 
ratings. 

Score  The value given to an alternative with respect to a lowest 
criteria (see Rating). 

Sensitivity Analysis  A method used to test how sensitive your 
preferred alternative is to changes in weights of your criteria.  

Sibling  Blocks on the same level that are connected to the same 
parent block. Children that have the same parent. 

Simple Rule  A regulation stating that each alternative must meet, for 
instance, an absolute minimum score with respect to a 
specified criterion in order to be considered (see If-Then Rule, 
and Rule in this glossary). 

SMART  Simple Multiattribute Rating Technique. An effective  
implementation of the Multiattribute Utility Theory of 
decision analysis invented by Professor Ward Edwards (see 
the References section). 

Stakeholders  Stakeholders are individuals and groups who may not 
have direct control over the decision, but will be affected by 
the decision outcome. 

Subcriteria  Specific refinements of general criteria. For example, 
subcriteria of the criterion Cost might be Initial Cost and 
Maintenance Cost. On the hierarchy, subcriteria occupy the 
blocks to the right of their parent criterion. 

 

Subcriterion/Weights Box  Area on the Criterion Ratings window 
where you can input your weights and ratings.  The 



Glossary 

428 Criterium DecisionPlus 

appearance of this area varies according to the Rating Method 
and Rating View chosen.   

Tab Delimited Strings  A Tab delimited string is a way of passing 
information to the Windows Clipboard that can be usefully 
imported to Windows spreadsheet and word processing 
applications.  When pasted into most spreadsheets, the 
information will automatically arrange itself correctly across 
the rows and columns of the spreadsheet (though you will 
probably want to adjust the formatting yourself).  When pasted 
to a word processor, the information will appear with Tabs 
between data points, and this can usually be immediately 
turned into a data table using that application's Table 
commands. 

Tagging  Because of the Branch Duplicate option added to the 
Hierarchy, it is now easy to create group models, with a 
different branch duplicated for each group member.  In order 
to facilitate analysis, you can assign the criteria at a given 
level in the model, to "tag" all criteria in their respective 
branches.  The name of that tagging block will precede the 
name of the actual branch criterion in all results and analysis 
windows.  Names of Alternatives are unaffected. 

 From any results or analysis window, or within the Ratings 
dialog, a level may be chosen as the Tag level by choosing the 
Group Tag Level menu item under the Analysis menu item. 

Tradeoffs  A tradeoff tells you how many units of one criteria produce 
the same change in the leading alternative as an increase of 
one scale unit of a reference criterion. 

 For example, if you are evaluating a construction bid and you 
were to weight a criterion such as Schedule as more important 
than another, such as Costs, you are essentially trading off 
dollars against months (or years).  A bid with a lower cost is 
attractive, but if construction takes longer it is less attractive.  
Knowing how much you are willing to pay in increased Costs 
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for a one month improvement in Schedule is key to 
understanding your decision. 

Tradeoffs of Lowest Criteria  The Tradeoffs of Lowest Criteria 
Window depicts a table of the number of units of criteria it 
takes to produce the same change in the leading alternative.  
This tradeoff is shown in relation to an increase of one scale 
unit of a specified reference criterion. 

Tradeoffs Set, Minimal Tradeoffs Set  A collection of lowest criteria 
pairs that are assigned tradedoff values.  Specifying all 
possible lowest criteria pairs is redundant, and will lead to 
inconsistencies.  If the collection is such that is has N-1 pairs, 
where N is the number of lowest criteria, and any tradeoff 
pair's value can be derived from the collection's pairs values, 
that tradeoff set is called a minimal tradeoff set. 

Uncertainty  The numbers you assign to weights or ratings in 
DecisionPlus are rarely known exactly. Often, you can 
estimate how they might vary. For example, estimates such as 
that the cost would never be more than $100 or less than $50, 
or that it will take nine months, give or take a month. You 
need only one more small step to formulate this type of 
information into a format DecisionPlus can use directly—to 
estimate the likelihood, or probability, of different values 
occurring. 

Unrated  The condition of any item’s weight/rating before the item 
has been rated.  You can see which criteria in a model are not 
weighted by selecting the Show Unrated Blocks item in the 
View menu of the Hierarchy window. 

Value Function  The mathematical function used in assigning ratings 
for the attributes when using the SMART technique. Criterium 
DecisionPlus provides a linear, exponential, and custom value 
functions, which can be either increasing or decreasing with 
repect to the scale. 

Verbal Scale  In verbal mode, words express distinctions between 
elements of a rating set. For pairwise comparisons, a list of 
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nine standard words are provided. When rating directly, you 
may choose from one of the lists supplied or make up one of 
your own. 

Verbal Scale View  In the Criterion Rating window, the verbal view 
representing the Verbal Scale you assign. Provides drop-down 
list boxes containing words you can select within the assigned 
Verbal Scale. 

View (ratings)  In the Criterion Rating window, various means are 
provided for you to enter your preferences: a numerical 
textbox, a graphical sliding bar, and a verbal listbox.  The 
numerical, graphical and verbal expressions, together with 
their individual scales, are all Views of your ratings.  All 
express the same value of your rating, and at least one, but as 
many as all, views may be utilized at the same time.  Choosing 
an appropriate set of views for your decision helps you attain a 
more accurate assessment of your preferences. 

View (window)  The View menu item in a window, if present, 
provides a different way of viewing the information associated 
with that window.  For instance, the Data View of the 
Hierarchy provides a spreadsheet view emphasizing the rating 
information in the Hierarchy window, whilst the Graphical 
View provides a visual representation of the relationships 
between criteria in the Hierarchy window.  

Voice  When individuals or factions within a group are explicitly 
given a branch of the decision hierarchy to weight.  The 
contributions from each of these branches are then combined 
(usually by equal weighting) to provide a voted decision.  See 
the section on Group Decision Making in Chapter 9. 

Weight  The value you assign to a given criterion with respect to a 
parent criterion. The value lies within range of the scale of the 
parent criterion. 

Zoom  In Brainstorm and the Recycle Bin, Zoom allows you to see the 
screen at different magnifications. 
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Index 

A 
Abbreviated Pairwise Comparisons 

Graphic - glossary, 410 
Method - glossary, 410 
Numeric - glossary, 410 
Verbal - glossary, 410 

Accumulated values 
alternatives' scatter plot, 299 

Accumulated Values 
defined, 279 
glossary, 410 

Accumulated weights 
define, 411 

Accumulated Weights 
decision contours, 300 
glossary, 411 
Next button, 187 
show, 147 
visualize, 256 

Add Rules 
window, 215 

Aggregation 
glossary, 411 

AHP 
choosing, 165 
defined, 42 
differences from SMART, 167 
glossary, 411 
introduction, 42 
normalization, 206 
rating alternatives, 202 

tradeoffs, 295 
AHP or SMART 

selecting, 104 
Alternatives 

change title, 76 
defined, 42 
glossary, 412 
primitives, 282 
rating, 203 

Alternatives' Data Scatter Window 
defined, 297 
open, 297 

Alternatives in Brainstorm 
defined, 72 
deleting, 76 
editing, 76 
entering, 75 
entering notes, 75 
entry limitations, 75 

Alternatives in Hierarchy 
defined, 108 
deleting, 118 
disconnecting, 115 
editing, 117 
entering, 117 
entering notes, 117 
limitations, 108 
rating, 202 
scatter plot analysis, 34 

Alternatives Rating Technique 
choose, 165 
glossary, 411 
selecting AHP or SMART, 149 

Alternatives' Rating Window 
opening, 212 

Alternatives RatingTechnique 
choice guidelines, 166 
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Alternatives Technique 
AHP, menus, 221 
SMART, menus, 221 

Analytical Hierarchy Process, 42 
Analyzing sensitivity, 286 
Assign Scales window, 176 

verbal scale, 178 
Assigning ratings 

pairwise comparison, 182 
Assigning scales 

graphical, 179 
numerical, 175 
pairwise comparison, 185 
verbal, 178 

Attribute 
glossary, 412 

B 
Best/Worst(Scale) 

glossary, 412 
Best/Worst(Uncertainties) 

glossary, 412 
Block 

glossary, 412 
Blocks in Brainstorm 

finding, 91 
Blocks in Brainstorm 

collapsing & expanding, 87 
connecting, 83, 85 
disconnecting, 86 
grouping, 82 
selecting multiple, 81 

Blocks in Hierarchy 
adding, 113 
arranging, 120 
deleting, 111, 114, 118 
duplicating, 120 

finding, 119 
moving, 118 
rating, 180 
selecting multiple, 118 
sizing, 106 
working with, 118 

Brainstorm 
glossary, 413 
menu commands, 93 
print options, 318 
printing graph, 318 
printing notes, 319 
printing outline, 319 
printing pasted data, 319 
profile, 92 
Recycle Bin, 89 
undo action, 99 
window, 70 

Brainstorming, 56, 70 
Branch 

glossary, 413 

C 
Calculation 

decision scores, 256 
glossary, 413 
hierarchy priority view, 146 
sensitivity criticality, 256 
uncertainty in decision scores, 
256 

Children 
defined in Brainstorm, 83 
defined in Hierarchy, 108 
glossary, 413 

Clipboard 
print preview, 314 

Compact Centered View 
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glossary, 413 
Connect blocks 

off-screen, 85, 115 
Connect Blocks 

brainstorm, 83 
hierarchy, 114 
hierarchy vs. brainstorm, 114 

Connected. See Fully Connected 
Connections 

show missing, 146 
Consistency 

glossary, 413 
Contributions by Criteria 

graph style, 280 
graph types, 35 
legend, 280 
ordering of alternatives, 284 
pie graph style, 283 
printing, 326 
radar style, 282 
stacked bar graph, 279 
window, 278 

Contributions to Uncertainty 
defined, 302 
printing, 327 
window, 302 

Conventions – Windows, 22 
Criteria 

defined, 42 
glossary, 413 

Criteria in Brainstorm 
connecting, 83 
connecting to goal, 85 
defined, 76 
deleting, 79 
disconnecting, 86 
editing, 79 

entering, 76, 77 
entering notes, 79 
entry limitations, 77 
grouping, 82 
limitations, 83 
orphans, 84 
selecting multiple, 81 
sizing blocks, 78 
ungrouped, 84 

Criteria in Hierarchy 
connecting, 114 
defined, 108 
deleting, 111, 114 
disconnecting, 115 
editing, 111, 113 
entering, 113 
entering notes, 114 
lowest, 115 
multiple select, Ctrl, 366 
multiple select, level, 364 
priority of unrated, 257 
rating lowest, 203 

Criterion Rating 
menu commands, 221 
window in SMART, 170 
window in tutorial, 370 

Criticality, 288 
glossary, 414 

Crossover 
glossary, 414 

Current 
glossary, 414 

Custom Distribution, 242 

D 
DDE 

export results, 268 
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glossary, 414 
paste link menu item, 146 
to hierarchy, 133 

Decision analysis 
background, 41 
overview, 41 

Decision Contours 
alternatives scatter plot, 300 

Decision Hierarchy 
glossary, 414 

Decision Management, 2 
Decision model, 43 
Decision Model 

glossary, 415 
Decision Process 

analyze the results, 277 
build hierarchy, 103 
defined, 55 
diagram, 55 
document the results, 309 
glossary, 415 
methodologies, 41 
on-line Help, 56 
reviewing the results, 247 
select uncertainty, 233 
weight the criteria, 157 

Decision Results 
Reasonableness, 277 

decision scores, 59 
Decision scores 

comparing in uncertainty, 265 
defined, 248 
updating, 256 

Decision Scores 
calculation, 251 
enhanced, 258 
glossary, 415 

menu commands, 269 
printing graph, 323 
printing values, 324 
spreadsheet, 267 
window, 34, 248 

Decision Scores Window 
hide options, 260 

DecisionPlus 
capabilities, 21 
in decision-making, 55 
starting, 16 

Defaults 
glossary, 415 

Device 
glossary, 415 

Direct comparison, 173 
assigning scales, 175 

Direct Comparison 
entering, 180 

Direct Graphic Ratings 
glossary, 415 

Direct Numeric Ratings 
glossary, 415 

Direct Rating Method 
glossary, 416 

Direct Tradeoff 
minimal tradeoffs set, 195 
rating window, 191 
selecting, 164 
unrated, 192 

Direct Tradeoff Hierarchy Technique 
equalize all tradeoffs, 149 
glossary, 416 
selecting, 150 
unrate all tradeoffs, 149 

Direct Tradeoffs 
add Lowest Criterion, 220 
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choosing, 162 
equalize all, 201 
hide indirectly rated, 224 
rating method, 190 
tradeoff set, 220 
tradeoffs analysis window, 296 
unrate, 202 

Direct verbal rating 
defined, 178 

Direct Verbal Ratings 
glossary, 416 

Disconnected Blocks in Hierarchy 
glossary, 416 

Duplicate Block 
glossary, 416 

E 
Enabled/Disabled 

glossary, 416 
Entry Field 

glossary, 417 
Error Message 

glossary, 417 
Excel 

copying to, 269 
Export 

print preview, 314 
results, 268 
to Excel, 269 
to text file, 269 

Exporting 
glossary, 417 

F 
Families 

collapsing and expanding, 87 
Family Center View 

glossary, 417 
File 

open in Brainstorm, 71 
open in Hierarchy, 106 
save, 76 
types, 71, 106 

Filename 
glossary, 417 

Full Graphic Pairwise Comparisons 
glossary, 417 

Full Numeric Pairwise Comparisons 
glossary, 418 

Full Pairwise Comparison Method 
glossary, 418 

Full Verbal Pairwise Comparisons 
glossary, 418 

Fully Connected 
definition, 257 
glossary, 418 
prerequisite for  calculation, 257 

G 
Goal (Decision) 

glossary, 418 
Goal Block 

glossary, 418 
Goal in Brainstorm 

connecting, 85 
defined, 72 
editing, 73 
entering, 73 
entering notes, 73 

Goal in Hierarchy 
defined, 107 
disconnecting, 115 
editing, 109 

Graphic Views 
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glossary, 419 
Graphical ratings 

entering, 181 
Group 

subcriteria, 354 
Group Decision Making 

consensus, 134 
distributed, 135 
how to, 134 
voices, 135 

H 
Handles 

glossary, 419 
Hard Data 

glossary, 419 
Hierarchy 

alternatives ratings, 31 
brainstorm toolbar, 98 
creating directly in Hierarchy, 
106 
defined, 104 
enhanced views, 30, 31 
entry limitations, 107 
generating from Brainstorm, 105 
glossary, 419 
menu commands, 144 
Model Name and Note, 421 
modifying, 108 
Navigator, 123 
print options, 322 
undo action, 151 
window, 105 

Hierarchy Order 
glossary, 419 
next rating set, 187 

Hierarchy Rating Technique 

selecting, 164 
weights, 220 

Hierarchy Technique 
weights, 221 

Highlight 
glossary, 419 

I 
Ideal alternative, 258 
Ideal Solution 

glossary, 419 
If/then rule, 214, 217 
If/Then Rule 

glossary, 419 
Import 

DDE to hierarchy, 133 
Imported Data 

print in brainstorm, 319 
Inconsistency Ratio 

glossary, 420 
Information window 

criterion ratings window, 172 
viewing, 127 

Install 
Uninstall, 17 

Installation 
Windows 95, 16 

L 
Level Bar 

glossary, 420 
Levels 

adjusting widths, 107, 112 
defined, 104, 108 
deleting, 113 
editing names, 112 
entering notes, 112 
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glossary, 420 
goal, 107 
inserting, 112 
limitations, 108 
selecting, 107 
working with, 107 

Link 
glossary, 420 

Linked models 
creating, 138 
deleting, 144 
editing, 144 
updating, 142 

Linked Models 
groups, 135 

Log-Normal Distribution, 241 
Lowest Criteria 

glossary, 420 
rating alternatives against, 202 
tutorial, 388 

Lowest Criterion 
excluded from tradeoffs, 220 
tradeoff reference, 164 

M 
Maintain Rules 

window, 215 
Making Decisions – the Process, 49 
Master File 

glossary, 420 
MAUT 

defined, 44 
Method 

glossary, 420 
Methodology, 41 
Minimal Tradeoffs Set 

by manual select, 198 

definition, 195 
glossary, 429 
selecting, 196 

Minimal Tradeoffs Set 
by reference criterion, 197 

Model Options, 27 
environmental options, 27 
new model options, 28 

Model Rating Technique 
choosing a, 162 
overview, 159 

Model Specifications 
capacities, 27 

Model Weights 
glossary, 421 
printing, 324 

Models 
linking, 138 

Multiattribute Utility Theory, 44 
Multi-voice Decision 

creating, 135 
Multi-voice Decisions 

define, 135 
how to, 136 

N 
Name 

search for, 119 
Navigator, 123 

glossary, 421 
hierarchy toolbar, 152 

Next button 
Criterion Rating, 170, 188 

Next Button 
options menu, 222, 224 

Normal Distribution, 241 
Normalization 
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AHP, 206 
explanation, 165 
glossary, 421 
SMART, 206 

Notes 
glossary, 421 
print in brainstorm, 319 
printing, 322 

Notes Dialog 
glossary, 422 

Notes in Brainstorm 
defined, 74 
entering in alternatives, 74 
entering in criteria, 74 
entering in goal, 74 

Notes in Hierarchy 
defined, 107 
entering in criteria, 111 
entering in goal, 110 
right click, 426 

Numeric Scale 
glossary, 422 

Numerical ratings 
entering, 180 

Numerical Scale View 
glossary, 422 

Numerical Scales 
assign, 177 
create custom, 177 

O 
Operating Systems 

compatibility, 27 
Options 

brainstorm toolbar, 99, 152 
Options Dialog 

brainstorm, 96 

decimal places (weights), 227 
Hide Indirectly Calculated 
Tradeoffs, 227 
hierarchy menu, 149 
new block, 227 
rating, 225 
scale defaults, 226 
warning, 228 

Orientation 
synchronization, 210 
value function, 207 

Orientation (Scale) 
glossary, 422 

Orphan, 84 
glossary, 422 

P 
Pairwise comparison 

assigning pairwise scale, 185 
printing, 322 

Pairwise Comparison 
calculating, 253 
restriction, 173 

Pairwise Comparisons 
glossary, 422 

Pairwise Rating 
alternatives' rating window, 212 

Parent 
defined in Brainstorm, 83 
defined in Hierarchy, 108 

Parent Block 
glossary, 423 

Perfect alternative, 258 
Phantom Block 

glossary, 423 
Preference 

glossary, 423 
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Preferred alternative, 286 
Primary Scale 

tutorial, 372 
Primary View 

alternatives's rating window, 212 
glossary, 423 

Print 
brainstorm, 357 

Print options 
Brainstorm, 318 
Decision Models, 320 
dialog window, 310 
general, 311 
header & footer, 315 
page setup, 314 

Print Preview 
window, 313 

Printer 
setup, 316 

Printing 
overview, 310 
reports, 35 

Priorities 
alternatives scatter plot, 298 
calculating, 252 

Priority 
glossary, 423 
sensitivity, 287 

Probability distributions 
assigning, 239 
types, 239 

Probability Distributions 
glossary, 424 

Process Diagram, 55 
glossary, 424 

Profile 
hierarchy, 125 

R 
Rank reversal, 257 
Rank Reversal 

choosing AHP, 167 
glossary, 424 

rated 
fully, 257 

Rating 
attribute, 203 
entering direct, 180 
glossary, 424 
sets, 169 
value functions, 203, 204 
window in AHP, 169, 191 
window in SMART, 170 

Rating Method 
direct tradeffs, 190 
weights hierarchy rating 
technique, 173 

Rating methods 
abbreviated pairwise 
comparison, 173 
direct comparison, 173 
full pairwise comparison, 173 

Rating Methods 
glossary, 424 

Rating Set 
choosing, 168 
glossary, 425 
selecting, 186 

Rating technique, 42 
Rating Technique 

differences, 167 
Rating Type 

glossary, 425 
Rating views 
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defined, 174 
graphical, 175 
numerical, 174 
verbal, 174 

Rating Views 
glossary, 425 

Rating Window 
glossary, 425 

Ratings 
alternatives, 34 
canceling, 188 
entering pairwise, 182 
printing, 322 

Ratings Sets 
define, 158 

Real Time Updates 
tradeoffs analysis, 296 

Real Time Updating 
direct tradeoffs, 224 
ratings window, 222 

Recycle Bin 
defined, 72 
displaying contents, 90 
glossary, 425 
moving criteria to/from, 89, 91 
storing criteria in, 89 

Relative Weights 
glossary, 425 

Report Options dialog 
displaying, 329 

Reports 
creating, 329 
decision model, 328 

Resource Tracking 
decision scores window, 261 
glossary, 425 
printing, 323 

Right Click 
definition, 426 

Risk Analysis 
glossary, 426 

Road Map, 7 
Rules 

adding, 215 
defined, 214 
editing, 218 
failed rules window, 259 
glossary, 426 
if/then, 214, 217 
printing, 323, 327 
rule only criterion, 164 
rules only criteria, 220 
show failed, 259 
simple, 214, 216 
specifying, 217 
window, 215 

S 
Save 

glossary, 426 
Scale View 

glossary, 427 
Scales 

adding, 175, 178 
defined, 171 
deleting, 179 
direct comparison, 175 
editing, 179 
glossary, 426 
graphical, 179 
numerical, 175 
printing, 323 
synchronization, 211 
verbal, 178 
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Scores 
glossary, 427 
unrate, 213 

Select a Minimal Set of Tradeoff 
Pairs 

abbreviated tradeoff menu item, 
223 

Select Minimal Set of Tradeoff Pairs 
Fill By Option, 199 
open window, 196 

Select Minimal Set Window 
launch, 192 

Sensitivity 
printing, 324 

Sensitivity analysis 
performing, 286 
sensitivity plot, 287 

Sensitivity Analysis 
glossary, 427 

Sensitivity by Weights 
tutorial, 396 
window, 286 

Setup 
System requirements, 15 
what is in the box?, 15 

Sibling 
glossary, 427 

Simple Multiattribute Rating 
Technique, 44 
Simple rule, 214, 216 
Simple Rule 

glossary, 427 
Slope 

define, 207 
synchronization, 210 

SMART 
choosing, 165 

defined, 44 
differences from AHP, 167 
glossary, 427 
introduction, 44 
normalization, 206 
rating alternatives, 202 
rating lowest criteria, 203 
rating with value functions, 204 
selecting, 167 
setting the slope, 207 
tradeoffs, 295 

Snap 
hierarchy toolbar, 151 

Specifications – model, 21 
Spreadsheet 

in Hierarchy, 146 
viewing your model in, 129 

Stakeholders 
glossary, 427 

Starting DecisionPlus, 16 
Subcriteria 

glossary, 427 
Subcriterion/Weights Box 

glossary, 427 
Synchronization 

on/off, 211 

T 
Tab Delimited Strings 

glossary, 428 
Tables 

pasting to Brainstorm, 80 
Tag Level 

criterion rating, 222, 224 
how to, 284 
voices, 136 

Tagging 



Index 

Criterium DecisionPlus 445 

Decision Scores window, 270 
glossary, 428 

Technical Support 
installation, 17 

Technique 
changing to AHP, 369 

Techniques 
AHP, 42 
SMART, 42 

Toolbars 
analysis, 304 
brainstorm, 98 
hierarchy, 151 
results, 272 
text detail, 99, 152, 272, 305 
turning on/off, 99, 152, 272, 305 

Tradeoff Set 
inconsistent, 195 
ratings window, 192 

Tradeoffs, 160 
equalize all weights, 34 
glossary, 428 
set. See Tradeoffs Set 

Trade-offs, 292 
Trade-offs, 294 
Tradeoffs of Lowest Criteria 

analysis, 33, 294 
glossary, 429 
printing, 327 
window, 292 

Tradeoffs Set 
glossary, 429 
inconsistent, 194 

Triangle Distribution, 241 

U 
Uncertainty 

aggregation, 264 
choosing probability 
distributions, 239 
comparing results, 265 
defined, 58, 234 
glossary, 429 
menu selection, 203 
probability distributions, 234 
selecting, 237 
specifying distribution inputs, 
240 

Uncertainty in Decision Scores 
menu commands, 270 
window, 262 

Uncertainty Inputs 
printing, 324 

Uncertainty Results 
printing data, 326 
printing graph, 325 
spreadsheet, 265 

Uncertainty Specify Distributions 
(Input) 

window, 237 
Unconnected Blocks 

search for, 119 
show, 147 

Uniform Distribution, 240 
Uninstall, 30 
Unrate 

weights, 149 
Unrated 

glossary, 429 
Unrated Blocks 

search for, 119 
show, 147 

Updating 
general, 256 
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V 
Value function 

custom, 209 
exponential, 207 
linear, 206 
tradeoffs, 295 

Value Function 
alternatives scatter plot, 301 
calculating with, 254 
Criterion Rating, 172 
defined, 166 
glossary, 429 
rule only criteria, 220 

Value functions 
assigning, 203 

Verbal ratings 
entering, 181 

Verbal Scale 
assign, 178 
glossary, 429 

Verbal Scale View 
glossary, 430 

View (ratings) 
glossary, 430 

View (window) 
glossary, 430 

Voice 
glossary, 430 
group decision, 135 

W 
Weight 

glossary, 430 
Weighting, 57 
weights 

unrate, 202 
Weights 

equalize all, 201 
printing, 322 

Weights and Tradeoffs 
conversions, 33 

Weights Hierarchy Technique 
equalize all weights, 149 
selecting, 150 
unrate all weights, 149 

Windows 
arranging results, 250 

Windows Meta File 
hierarchy graph, 145 
hierarchy toolbar, 151 

Windows Metafiles, 29 

Z 
Zoom 

glossary, 430 
print preview, 314 
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